Projects
should not be relied upon in making purchasing decisions. The development, release, and timing of any features or functionality described in this document remains at the sole discretion of Oracle.

This document in any form, software or printed matter, contains proprietary information that is the exclusive property of Oracle. Your access to and use of this confidential material is subject to the terms and conditions of your Oracle Master Agreement, Oracle License and Services Agreement, Oracle PartnerNetwork Agreement, Oracle distribution agreement, or other license agreement which has been executed by you and Oracle and with which you agree to comply. This document and information contained herein may not be disclosed, copied, reproduced, or distributed to anyone outside Oracle without prior written consent of Oracle. This document is not part of your license agreement nor can it be incorporated into any contractual agreement with Oracle or its subsidiaries or affiliates.

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Sample Code

Oracle may provide sample code in SuiteAnswers, the Help Center, User Guides, or elsewhere through help links. All such sample code is provided "as is" and "as available", for use only with an authorized NetSuite Service account, and is made available as a SuiteCloud Technology subject to the SuiteCloud Terms of Service at www.netsuite.com/tos.

Oracle may modify or remove sample code at any time without notice.

No Excessive Use of the Service

As the Service is a multi-tenant service offering on shared databases, Customer may not use the Service in excess of limits or thresholds that Oracle considers commercially reasonable for the Service. If Oracle reasonably concludes that a Customer's use is excessive and/or will cause immediate or ongoing performance issues for one or more of Oracle's other customers, Oracle may slow down or throttle Customer's excess use until such time that Customer's use stays within reasonable limits. If Customer's particular usage pattern requires a higher limit or threshold, then the Customer should procure a subscription to the Service that accommodates a higher limit and/or threshold that more effectively aligns with the Customer's actual usage pattern.

Beta Features

Oracle may make available to Customer certain features that are labeled “beta” that are not yet generally available. To use such features, Customer acknowledges and agrees that such beta features are subject to the terms and conditions accepted by Customer upon activation of the feature, or in the absence of such terms, subject to the limitations for the feature described in the User Guide and as follows: The beta feature is a prototype or beta version only and is not error or bug free and Customer agrees that it will use the beta feature carefully and will not use it in any way which might result in any loss, corruption or unauthorized access of or to its or any third party's property or information. Customer must promptly report to Oracle any defects, errors or other problems in beta features to support@netsuite.com or other designated contact for the specific beta feature. Oracle cannot guarantee the continued availability of such beta features and may substantially modify or cease providing such beta features without entitling Customer to any refund, credit, or other compensation. Oracle makes no representations or warranties regarding functionality or use of beta features and Oracle shall have no liability for any lost data, incomplete data, re-run time, inaccurate input, work delay, lost profits or adverse effect on the performance of the Service resulting from the use of beta features. Oracle's standard service levels, warranties and related commitments regarding the Service shall not apply to beta features and they may not be fully supported by Oracle's customer support. These limitations and exclusions shall apply until the date that Oracle at its sole option makes a beta feature generally available to its customers and partners as part of the Service without a “beta” label.
Send Us Your Feedback

We'd like to hear your feedback on this document.

Answering the following questions will help us improve our help content:

- Did you find the information you needed? If not, what was missing?
- Did you find any errors?
- Is the information clear?
- Are the examples correct?
- Do you need more examples?
- What did you like most about this document?

Click here to send us your comments. If possible, please provide a page number or section title to identify the content you're describing.

To report software issues, contact NetSuite Customer Support.
Using Project Resource Management ............................................................... 112
Managing Time and Expenses for Project Resources .............................................. 119
Classifying Time for Projects ................................................................................ 120
Entering Time Against Projects .............................................................................. 122
Restricting Time Entry on Project Tasks .................................................................. 124
Entering Project Expenses ...................................................................................... 125
Approving Time and Expenses for Projects .......................................................... 126
Tracking and Managing Projects ............................................................................ 129
  Project Dashboard ................................................................................................. 129
  The Project Center .................................................................................................. 131
  Viewing Project Schedules ...................................................................................... 133
  Working with the Project Schedule ....................................................................... 133
  Tracking Project Baselines and Variance ............................................................... 135
  Setting a Project Baseline ....................................................................................... 135
  Planned Work .......................................................................................................... 136
  Refreshing Project Items on Transactions ............................................................. 137
  Creating Sales Orders from Projects ...................................................................... 138
Project Billing ........................................................................................................... 139
  Billing and Project Consolidation ......................................................................... 141
  Project Billing Rates .............................................................................................. 143
  Forecasting Project Billings .................................................................................... 144
  Projects and Time and Materials Billing ............................................................... 144
  Projects and Interval Billing .................................................................................. 146
  Projects and Milestone Billing ............................................................................... 147
    Creating a Milestone Billing Schedule ................................................................. 148
    Billing Customers Using Milestone Billing .......................................................... 150
Charge-Based Project Billing .................................................................................... 152
  Setting Up Charge-Based Billing ........................................................................... 153
  Creating Charge-Based Projects ........................................................................... 153
  Understanding Charge Rules ................................................................................ 154
  Creating Charge Rules .......................................................................................... 155
  Using Billing Rate Cards ....................................................................................... 161
  Using Caps with Charge Rules .............................................................................. 163
  Generating Charges ............................................................................................... 163
  Approving Pending Charges .................................................................................. 165
  Billing Charge-Based Projects ............................................................................. 165
  Project Billings Report ............................................................................................ 166
  Project Revenue Recognition ................................................................................ 166
Job Costing and Project Budgeting .......................................................................... 173
Job Costing ............................................................................................................... 174
  Creating Project Expense Types ............................................................................ 175
  Posting Time Transactions ..................................................................................... 176
  Job Costing and OneWorld ..................................................................................... 178
Project Budgeting ..................................................................................................... 179
  Setting Up Project Budgeting ............................................................................... 180
  Creating Project Budgets ....................................................................................... 181
Advanced Project Budgeting .................................................................................... 183
  Activity Codes ....................................................................................................... 184
  Project Work Breakdown Structure (WBS) ............................................................ 185
Project Management Reports .................................................................................... 190
Earned Value by Project Report ............................................................................... 191
Utilization by Resource Reports ............................................................................... 192
  Allocated Utilization by Resource ......................................................................... 192
  Planned Utilization by Resource .......................................................................... 193
  Actual Utilization by Resource .............................................................................. 193
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated vs. Actual Hours by Resource Report</td>
<td>194</td>
</tr>
<tr>
<td>Utilization by Project Reports</td>
<td>195</td>
</tr>
<tr>
<td>Allocated Utilization by Project</td>
<td>195</td>
</tr>
<tr>
<td>Planned Utilization by Project</td>
<td>196</td>
</tr>
<tr>
<td>Actual Utilization by Project</td>
<td>197</td>
</tr>
<tr>
<td>Time Entry Exceptions Report</td>
<td>198</td>
</tr>
<tr>
<td>Time by Employee/Item/Customer Reports</td>
<td>198</td>
</tr>
<tr>
<td>Actual Time Workbook</td>
<td>201</td>
</tr>
<tr>
<td>Actual Time Dataset Template</td>
<td>201</td>
</tr>
<tr>
<td>Actual Time Workbook Template</td>
<td>202</td>
</tr>
<tr>
<td>Current Backlog By Resource Report</td>
<td>202</td>
</tr>
<tr>
<td>Estimated Profitability by Project Report</td>
<td>203</td>
</tr>
<tr>
<td>Unbilled Cost by Customer Reports</td>
<td>203</td>
</tr>
<tr>
<td>Unbilled Time by Customer Reports</td>
<td>204</td>
</tr>
<tr>
<td>Project Charges Forecast Report</td>
<td>205</td>
</tr>
<tr>
<td>Project Budget vs. Actual Reports</td>
<td>206</td>
</tr>
<tr>
<td>Project Cost Budget vs. Actual</td>
<td>206</td>
</tr>
<tr>
<td>Project Billing Budget vs. Actual</td>
<td>207</td>
</tr>
<tr>
<td>Project Task Budget vs. Actual Reports</td>
<td>208</td>
</tr>
<tr>
<td>Project Task Cost Budget vs. Actual</td>
<td>208</td>
</tr>
<tr>
<td>Project Task Billing Budget vs. Actual</td>
<td>209</td>
</tr>
<tr>
<td>Project Profitability Report</td>
<td>210</td>
</tr>
<tr>
<td>Project Profitability by Month Report</td>
<td>212</td>
</tr>
<tr>
<td>Advanced Project Profitability</td>
<td>213</td>
</tr>
<tr>
<td>SuiteAnalytics Connect Access to Project Tasks Data</td>
<td>217</td>
</tr>
<tr>
<td>Basic Projects</td>
<td>218</td>
</tr>
<tr>
<td>Basic Projects Overview</td>
<td>218</td>
</tr>
<tr>
<td>Creating a Basic Project Record</td>
<td>218</td>
</tr>
<tr>
<td>Additional Basic Project Fields</td>
<td>220</td>
</tr>
<tr>
<td>Attach Contacts to Basic Projects</td>
<td>220</td>
</tr>
<tr>
<td>Integrating NetSuite Project Data with OpenAir</td>
<td>222</td>
</tr>
</tbody>
</table>
Projects

Use project records to organize your resources and manage the time required to complete tasks for company projects.

- Use basic Projects to track projects for customers including activities, time tracking, and billing. For more information, read Basic Projects.
- Use Project Management to track projects during your sales process, define and manage project plans, assign resources, and integrate project activity into your order-to-cash process. With Project Management, projects can be created independently from customers. For more information, read Using Project Management.

The table below describes functions of both projects features.

### Summary of Projects and Project Management

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Projects</th>
<th>Project Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projects and customers are managed in separate lists of records</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Auto-generated numbering creates separate sequences for projects and customers</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Tag a service item record to create a project when sold</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Group tasks as work tasks or summary tasks</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Identify project tasks on project records</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Identify project tasks on service item records</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Assign project tasks to employees for completion</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Assign project tasks to vendors and other resources for completion</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Restrict time entry to assigned resources</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Identify tasks as milestones for billing</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Log time against projects</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatically track the percentage of completion on projects as time is logged against the project</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Enter a percent-complete override</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Track CRM information such as activities and communication for each project</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Track project expenditures, such as billable time and items</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Enter an estimated cost complete override</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

With Project Management, you can choose to add features to expand available functionality:

- Job Costing and Project Budgeting – Use this feature to calculate costs for project labor and account for those costs in your general ledger, and create project specific cost and billing budgets. Job Costing
and Project Budgeting offers additional reporting capabilities for projects. For more information, see Job Costing and Project Budgeting.

- Resource Allocations – Use this feature to allocated resources to projects, view and manage resource allocations, and monitor utilization rates. For more information, see Resource Allocations.

⚠️ **Important:** For information on the availability of Job Costing and Project Budgeting or Resource Allocations, please contact your account representative.
Enabling Project Features

**Note:** Depending on the product you subscribe to, some features may not be available for you to use. If you have questions about the availability of the features mentioned below, please contact your account representative.

To track projects with basic project records, you must enable the Projects feature. For more information on basic projects, read Basic Projects.

To track projects with more advanced project records, you must enable both the Projects feature and the Project Management feature. For more information, read Using Project Management.

**Important:** If you create or edit custom project forms when the Project Management feature is enabled, be aware that these forms may be altered if you later disable this feature. Immediately after you disable Project Management, you need to review custom project forms to see if they have been changed, and if necessary, edit them to fit your requirements. For details about customizing forms, see the help topic Custom Forms.

To use milestone billing with Project Management, you must enable Projects, Project Management and Advanced Billing. For more information, read Projects and Milestone Billing.

To use resource allocations with Project Management, you must enable Projects, Project Management, and Resource Allocations. For more information, read Resource Allocations.

**Important:** When Resource Allocations is initially enabled, NetSuite creates resource allocation records for all existing project assignments using a work queue. Project records are not available during this time. After this process is complete, project records will be available.

To use job costing and project budgeting, you must enable Projects, Project Management, Job Costing and Project Budgeting, and Time Tracking. For more information, see Job Costing and Project Budgeting.

**To enable features:**

1. Go to Setup > Company > Enable Features.
2. Check these boxes to enable features:
   - To use basic projects, check the box next to Projects.
   - To use Project Management:
     1. Check the box next to Projects and
     2. Check the box next to Project Management.
   - To use milestone billing:
     1. Check the box next to Projects and
     2. Check the box next to Project Management and
     3. Click the Transactions subtab and check the box next to Advanced Billing.
   - To use resource allocations:
     1. Check the box next to Projects and
     2. Check the box next to Project Management and
   - To use job costing and project budgeting:
1. Check the box next to Projects and
2. Check the box next to Project Management and
3. Check the box next to Job Costing and Project Budgeting and
4. Click the Employees subtab, check the box next to Time Tracking.

3. Click Save.
Creating New Records for Projects

Depending on the features you have enabled, you are able to create new records for projects:

- Read the help topic Customers for information on entering a new customer record.
- Read Creating a Basic Project Record for information if you have enabled the Projects feature but not enabled the Project Management feature.
- Read Creating a Project Record for information if you have enabled the Project Management feature.

With both Projects and Project Management, after you have created project records, you can access any related transactions from the Related Records subtab.

Depending on the features you have enabled, you may be able to create some of the following related transactions and records from your new project or customer record:

- Case
- Opportunity
- Event
- Resource Allocation
- Contact
- Time Entry
- Estimate
- Sales Order
- Subcustomer
- Phone Call
- Invoice
Using Project Management

When you use the Project Management feature, you can do everything that the basic Projects feature enables you to do, and more. To begin using Project Management, the details in this topic can help familiarize you with ways to use your account that optimize the feature.

Project management records are created and tracked as individual records separate from customer records. However, you can associate projects with customers by selecting the customer on the project record.

Project management records can be created manually or can be created automatically from service items. Read Creating a Project Record and Setting a Service Item to Create a Project.

Project Records as a Workspace

Project management records are intended to function as a workspace and help you with each step of the project management workflow, from the earliest planning stages though the final work on tasks and customer billing. By having all your data and transactions processed in a centralized place, the project information is always accurate and current.

When you create a project record, you create a place to organize data based on information supplied by your customer, ideally, from the opportunity record.

The Project Manager field is prominently displayed in the header area of the project record. This helps improve project transparency and clearly identifies who is in charge of the project.

As you enter project task records, a project schedule is created on the Schedule subtab of the project record. The project schedule is the heart of the project workspace, where you can assess and process many aspects of the project as it moves forward. From the Schedule subtab of project records, you can add new tasks, edit tasks and set up task hierarchies to organize project work phases. For more information, see Working with the Project Schedule.

When you are done Setting a Project Baseline, work can start and time is entered against project tasks. Then, you can view a Gantt Chart that compares actual progress against your original baseline goals.

Using the Gantt Chart you can view your projects critical path and if time or costs are running over for the project, you can make adjustments accordingly.

NetSuite calculates the actual work spent on the project and the remaining work. The Percent Time Complete field calculates the amount of the project that is done and the Estimated Labor Cost field calculates your labor investment for the project. Labor costs estimates are based on the time budget and labor rates for resources assigned on project tasks.

After you create a project record, you can link the project to the appropriate opportunity record. This enables you to keep items and records in sync during the course of the project. Read Refreshing Project Items on Transactions.

Asynchronous Project Plan Recalculation

You can enable a preference enabling your project plans to recalculate in the background when time is tracked against that project. This is especially useful for very large projects with many tasks, charge rules, or assignees. When project plans recalculate asynchronously, you maintain access to NetSuite and your project plans during recalculation.

Note: Because recalculations are asynchronous, project plan data may be out of date when accessed before the recalculations are complete.

When the recalculation is complete, the updated project plan is displayed the next time it is opened. If the recalculation fails for any reason, a warning appears at the top of the project the next time it is opened.
To enable the preference, go to Setup > Company > General Preferences. Check the Asynchronous Project Plan Recalculation box, and click Save.

Project Center

With Project Management, you can assign project resources a standard Consultant role with access to the Project Center. The Project Center allows access to NetSuite using a specialized interface that routes the most important functions of project work directly to the home page.

The Project Center has the following tabs: Home, Activities, Projects, Time & Expenses, Reports, Documents, and Support. Each tab offers access to links and information that deal directly with project management in NetSuite.

For information on giving access to employees, see the help topic Giving an Employee Access to NetSuite.

Project Dashboard

Similar to your main NetSuite Home dashboard, you can also access a project dashboard with information specific to an individual project.

The project dashboard offers portlets and quick links for creating project tasks, managing resources, viewing the Gantt chart, and entering time and expenses.

There are visual indicators to quickly give you an idea of the project's status. You can view a list of project tasks and resource allocations directly from the Project Dashboard. You can also view the Project Manager role.

You can customize the dashboard with additional standard and custom portlets and rearrange how they appear by clicking Personalize Dashboard at the top of the page.

To view the project dashboard for a project, click the Dashboard icon at the top of the project record or in the Projects list. For more information, see Project Dashboard.

Project Tasks and Task Hierarchies

Create a project task record to track each activity that must be completed for each project. Project tasks represent individual actions within a set of actions that must be completed to achieve a goal. For example, a project includes a Consultation task and an Installation task. The Installation task has a set of subtasks that define work required to complete the installation.

Creating a Project Task Record and setting up hierarchies helps you organize, plan, and work on the project. Project tasks record what work needs to be done, who needs to do it, and the order to perform the tasks.

For each project task, enter start dates using the Fixed Start or As Soon As Possible constraint. NetSuite automatically calculates the end date for each project task based on the estimated work, the work calendar, and the unit percentage availability for each assigned resource. A scheduling algorithm uses task duration combined with the predecessor relationships (Finish-to-Start, Start-to-Start, Start-to-Finish, or Finish-to-Finish) and constraints of other project tasks to calculate the project schedule.

Parent tasks organize the hierarchy of work tasks that are subordinate to other tasks required to complete a project. For example, to define an installation task that is composed of 3 individual tasks, you can set up task records as follows:

1. Create a task record for the installation. This task becomes the parent task after you identify it as the parent of other tasks.
Note: You do not have to assign resources or estimate work for a parent task. The estimated work for the parent task is the aggregate of its child tasks and any estimated work for the parent task. Without entering an assignee or any estimated work the parent task will initially be saved as a milestone. It will be converted to a parent task when subtasks are created.

2. Enter a work task for each of the three individual tasks. Identify each as a subordinate, or child, of the installation parent task.

Milestones

Project milestones are used to mark a point in your project, usually completion of a set of tasks or as a project health check to determine if you’re on schedule.

Project milestones cannot have estimated hours, assignees, or a Finish No Later Than (FNLT) constraint. When viewing a project Gantt chart or schedule, milestone tasks are differentiated from regular project tasks.

Project Templates

Project templates enable you to create project records in NetSuite for projects your business performs repeatedly. You can include as much or as little detail as you like in your templates. Templates offer your project managers a standardized starting point when planning projects. For more information, see Project Templates.

Resource Assignment

When you identify employees and vendors as project resources, you can select these personnel as resources to be assigned to project tasks. Assign resources to projects to designate who should do the work necessary to complete each task.

You can also select a project resource as the project manager on your project records. In the Primary information section of the default entry form there is a Project Manager field available. This field significantly helps to improve project transparency and ability to see who is in charge of the specific project.

A project resource must be designated as a project manager on the employee record before updating the project record. You can designate any project resource as a project manager by checking the Project Manager box on the Human Resource subtab of the employee’s record.

Assigning Project Resources can be done in one or two steps depending on whether you are:

- Assigning Resources Restricted to the Project
- Assigning Resources not Restricted to the Project

When you designate resource assignments on tasks, you can select service items to define the services to be provided during the course of the task. For time and materials projects, these service items eventually populate transactions such as estimates and sales orders, and as work is done, are billed on the invoice.

If you enter a labor rate for each resource, you can calculate resource profitability on projects. Project costs are sourced from the resource assignment rows. The work cost designated for the task defaults from each resource record. The price defaults from the service item and respects customer price levels as well as employee billing classes. The projected cost and revenue for all tasks combine to produce the total expected cost and revenue for the entire project.

You can also optionally choose to restrict time entry to only resources assigned to the project. Read Restricting Time Entry on Project Tasks.
You can use the NetSuite Project Task Manager to manage project resources and tasks. For more information, see Project Task Manager.

If you use Resource Allocations, you must first allocate resources to your project before they can be assigned to tasks. For more information, see Resource Allocations.

**Project Billing**

*Project Billing* for orders is based on *Project Billing Schedule Types*. The billing schedule type specified on the project determines the type of project:

- **Fixed Bid, Interval** projects bill customers for a currency amount that is determined and agreed to before the project begins. The amount billed does not change over time as the project progresses. Materials and expenses can be added to invoices for these projects.

- **Fixed Bid, Milestone** projects bill customers for projects in increments based on preset milestone goals. When a milestone is reached, the services associated with the milestone are eligible to be billed to the customer.

- **Time and Materials** projects are billed based on the materials and resources used to complete the project and the amount of time required to complete the project. The final amount billed may change over the course of time and is not determined before project work begins.

When you first define a project, depending on the type of project, you can create a project-specific billing schedule or select an existing billing schedule. The billing schedule selected on the project transfers to the project's associated transactions (estimates, sales orders), creates a billing forecast, and determines billing dates for the service items. When an order includes work that has been completed and is ready for billing, that order automatically shows in the bulk billing queue or shows the Next Bill button on the sales order form.

The project record also provides financial data for the project manager regarding the expected margin, based on the project plan. Having an understanding of the expected profitability at the beginning of the project, enables you to decide if the margin is sufficient when considering the risk for the project. If a project requires a minimum gross profit percentage, you can monitor the percentage during the life of the project to maintain that goal.

**Forecasting Project Billings**

When a project specifies a Time and Materials or Fixed Bid schedule, that billing schedule is applied to the associated estimate or sales order. Then you can use billing schedules for *Forecasting Project Billings*.

Billing forecasts are generated based on the effort planned to be expended across the planned project billing interval to determine when you expect currency to be billed.

Service items across the project tasks are sourced to provide a summary of quantity, cost, and revenue for the project. Then, this information is used to calculate the gross margin for the project.

Projected billings associated with a project are included in financial forecast reports. The forecast adjusts automatically based on actual work performed and any changes made to the schedule.

Billing forecast data can be examined using project billing schedules, sales order reports, the History subtab on sales order transactions and the *Estimated Profitability by Project Report*.

**Creating Estimates and Sales Orders from Projects**

After a project is set up, *Generating an Estimate from a Project* pulls the information you set up on the project record to create an estimate. You can generate multiple estimates over time to reflect changes and refinements based on customer feedback.
Check or clear the Available in Customer Center box on estimates to determine whether they show to customers in the Customer Center.

When the project detail is finalized, the next step is Creating Sales Orders from Projects. When you create a sales order directly from the project, the pricing and billing information carries over from the final estimate, which originates from the linked project record.

Creating Projects from Service Items

Alternately, your process can utilize Setting a Service Item to Create a Project. In this process, the service item is tagged to create a new project record automatically each time you sell it.

For example, set the item Deluxe Widget Installation to automatically generate a project by checking the Create Project box on its record. Then, each time you sell a Deluxe Widget Installation, a project record is created that lists the tasks that installers must complete for each sale of this item.

**Note:** Projects created from sales orders do not automatically leverage the functionality associated with billing types. You also cannot refresh items on the transactions with changes made on the project record.

Setting Up Project Management

The steps below can help you get started using Project Management:

**To set up Project Management:**

1. Enable the Project Management feature, and if necessary, the Advanced Billing feature.  
   Read Enabling Project Features.
2. Optionally set up Auto-Generated Numbering for projects.  
   Read the help topic Set Auto-Generated Numbers.
3. Optionally choose to restrict time entry by only resources assigned to the project.  
   Read Restricting Time Entry on Project Tasks.
4. Optionally set up items to automatically create projects.  
   Read Setting a Service Item to Create a Project.
5. Set up new project records to track projects.  
   Read Creating a Project Record.
6. Set up project task records to track tasks for each project.  
   Read Creating a Project Task Record.

Project Management Records

When you use the Project Management feature, you can use project records to track all the information about each of your projects from beginning to end.

By setting up data for each project in an organized manner, you can maintain and access information when you need it, as well as use the data to update schedules and generate transactions or reports that help you assess the progress of the project.

When you maintain accurate information for individual project records, you are better able to accomplish goals not only for the one project, but for all company projects. This is because within a company, often
Project planning requires a division of limited labor and materials resources across many projects. In order to best balance margins and risks for all projects, you need to be able to access accurate information about each project and make plans accordingly.

Project Scheduling Methods

When you first create a project record, even if you do not yet have all the project details, you can enter information such as the name of the project, current status, and perhaps the start and projected end dates. Then, as the project progresses, project records are a workspace where you can manage project details.

As you begin planning your project, you must decide the best method to use when creating your project schedule. NetSuite offers two methods for project scheduling, forward and backward.

**Important:** The Planned Work feature is required for backward project scheduling. For more information, see Planned Work.

Forward scheduling enables you to define a start date for your project and schedule tasks forward based on that start date. NetSuite uses the start date, task order, durations, and lag time to calculate an estimated end date for your project. Forward planning is best used when you know when your project must begin.

Backward scheduling enables you to define an end date for your project and schedule tasks backward based on that end date. NetSuite uses the end date, task order, durations, and lag time to calculate an estimated start date for your project. Backward planning is best used when you have a hard deadline for the completion of your project.

As data is available, you can also do the following on the project record to define and refine the project:

**Schedule subtab**

On the schedule subtab of project records, you can identify and schedule necessary work tasks. After tasks are created, you can see various basic or customizable views of the tasks, also known as a project plan. A Gantt Chart view is also available. The project plan is a tool to help you plan, manage, and execute your project schedule. For more information, see Working with the Project Schedule.

**Note:** The Schedule subtab appears only after you save a project record. The Schedule subtab displays project tasks in the order in which they would be listed on a project plan. You cannot sort or reorder the project tasks displayed on the Schedule subtab.

**Resources subtab**

On the Resources subtab, you can assign the resources needed to complete project tasks and designate their role on the project. You can select multiple roles for a single resource. In order to price and schedule resources, you need to select resources on specific task records. Read Assigning Project Resources.

If you use Resource Allocations, you must first allocate resources to your project before they can be assigned to tasks. For more information, see Resource Allocations.

**Financial subtab**

On the Financial subtab, you can define the project billing behavior by selecting a billing type and billing schedule, if you use Advanced Billing. The Financial subtab provides labor data for estimated, actual, and remaining work, as well as the percent of the project completed based on labor hours. Also, it displays estimated costs, revenue and profits.
Preferences subtab

On the Preferences subtab, choose settings for time and expense preferences related to the project. Choose to allow anyone to enter time for projects or limit time entries to assigned resources only. Classify project time entries as utilized, productive or exempt to customize utilization calculations. You can also choose to allow expense entries and to create planned time entries. If you use NetSuite OneWorld, you can select a subsidiary for the project. For more information, see Working with Project Management in OneWorld.

Related Records subtab

The Related Records subtab contains most of the same basic information found on Related Records subtabs on records throughout NetSuite, such as information about contacts and partners.

Communication subtab

The Communication subtab is where you can attach and send messages; schedule phone calls.

Best Practice: Incorporate the Project Record into your Sales Process

Projects can be linked with opportunities. This enables project items to be included in estimates and sales orders and billed along with other sales items.

Note: This specific workflow is possible only if you do not enable the Consolidate Projects on Sales Transactions preference. For more information, read Using the Project Consolidation Preference.

The following workflow is recommended for incorporating projects into the sales process:

1. Create an opportunity for a prospect.
   
   On the Items subtab of the opportunity form, all non-project items should be defined. This is any items except service items. Project items, or service items, must come from the project record.

   If you would rather, you can also wait to define non-project items on an estimate.

   For more information, see the help topic Opportunity Records.

   2. Set up the project by creating a project record.
From within the project record, add and manage service items related to the opportunity, create project tasks, and define the billing type.

For more information, read Creating a Project Record.

3. Link the project to the opportunity.

After you create a project record, you can link the opportunity record to the project by selecting the project on the opportunity.

When you source a project on an opportunity, the project items automatically source into the transaction rows of the opportunity record. These rows cannot be edited on the opportunity, however they can be removed. Any changes must be made first on the project record, and then reopen the opportunity to refresh the project items. Read Refreshing Project Items on Transactions.

For information, read Linking a Project to an Opportunity.

4. Generate one or more estimates from the opportunity.

An estimate created from a linked opportunity merges the non-inventory and other items with the service items for the project.

**Note:** Creating an estimate from the project record will only include service items from the project.

For more information, read Generating an Estimate from a Project.

5. Create a sales order from a project estimate.

---

**Working with Project Management in OneWorld**

When creating a project record, if the project is associated with a customer, then the project is automatically associated with the subsidiary of the customer and cannot be changed.

If you create a project record that is not associated with a customer, no subsidiary is associated by default, but you are required to select a subsidiary. After transactions are entered that are associated with the project, the project subsidiary cannot be changed unless the transactions are deleted.

Sub-projects are associated with the subsidiary of the parent project.

When assigning resources to projects, you can assign any employee to any project regardless of the subsidiary. For example, an engineer associated with Wolfe US can be assigned as a resource for a project associated with Wolfe UK.

Billable time and expenses can be entered against projects only by resources associated with the subsidiary of the project.

**Note:** The Intercompany Time and Expense feature must be enabled, and related preferences must be set, to allow resources to enter time and expenses for customers of subsidiaries other than their own. An automated adjustment process is available to transfer charges for intercompany expenses from the employee subsidiary to the customer subsidiary. See the help topic Enabling Intercompany Time and Expenses.

---

**Creating a Project Record**

Using Project Management, you can create project records to track projects and tasks you need to complete. Project records can capture basic information about your project, such as customer, start date,
and status. You can add more detailed information about your project to capture financial, resource, and budget information.

**To create a project record:**

   
   You can also click **New Project** in the New menu at the top of most pages to create a new project for the current Customer.

2. Under Primary Information:
   
   a. In the **Custom Form** field, select the form you want to use to enter this record. This field only appears when you have at least one custom form. You can customize this form by clicking Customize at the top of the page.
   
   b. The **Project ID** field displays either the ID that has been entered in the Project Name field or an auto-generated ID.
      
      ▪ In the **Auto** check box next to Project ID, clear the box to manually enter a name for this record in the Project Name field.
      
      ▪ If you leave this box checked, NetSuite assigns a name or number for this record based on your settings at Setup > Company > Auto-Generated Numbers.
   
   c. In the **Project Name** field, enter the name of the project.
      
      This name fills in the **Project ID** field unless you use auto-numbering. Enter a unique project name. If you use Auto-Generated Numbering, it is important that you enter the project name here because the Project ID does not include the project name.
   
   d. If this project is associated with a customer, select them in the **Customer** field.

   ![Note:](image)
   
   After a customer has been selected, it cannot be changed on the project record when there are transactions, actual time, actual charge, child project, contact (if Company field holds a project) or personalized Rate Card associated with the project. Mentioned actions remove the Change a customer button. If you create a new project from the Actions menu at the top of an existing project, the new project record is automatically linked to the current project’s customer. To change a project’s customer, in View mode, click the Change Customer button. You can only select a new customer that supports the same currency and subsidiary as the original customer.

   ![Note:](image)
   
   Projects that are not associated with a customer cannot be used on transactions.

   e. In the **Project Manager** field, select a project resource to serve as the project manager for this project. Only employees with both the Project Resource and Project Manager fields checked on the Human Resources subtab of their employee records appear in the Project Manager field.
      
      Project managers can approve and update time entries submitted for their assigned projects.
   
   f. In the **Status** field, select the status that indicates the progress of the project.
      
      You can create new statuses at Setup > Accounting > Accounting Lists > New > Project Status.
   
   g. If you use NetSuite OneWorld, in the **Subsidiary** field, select the subsidiary to associate with this project.
      
      For more information, see Working with Project Management in OneWorld.
Creating a Project Record

1. Go to Lists > Relationships > Projects. Click Edit next to the project you want to edit.

Note: After a transaction has posted for the project, you are not able to change the customer or subsidiary selected on the project record.

h. If you would like to apply a project template to this new project record, select the template in the Project Template field. For more information about project templates, see Project Templates.

3. Under Project Dates, if you also use the Planned Work feature, in the Scheduling Method field, select Forward or Backward.
   ■ If you know the date your project must begin, select Forward and enter the estimated date work will start on the project. You can change this date at any time during the life of the project. NetSuite schedules all project tasks without predecessors to start on this date.
   ■ If you know the date your project must end, select Backward and enter the estimated date work must be completed. You can change this date at any time during the life of the project. NetSuite schedules all project tasks without successors to end on this date.

   For more information on scheduling methods and planned work, see Project Scheduling Methods and Planned Work. The remaining fields under Project Dates are populated after the project is saved and tasks are created.

4. Click the Financial subtab to enter financial information about this project. For more information, see Project Billing Schedule Types.

5. If you use the Project Budgeting feature, click the Budget subtab and enter budget information for this project record. For more information, see Creating Project Budgets.

   Note: Projects with budgets displaying more than 20 categories will experience slower performance. It is recommended that you add only the most commonly used budget categories when creating project budgets. For more information on selecting categories for project budgets, see Setting Up Project Budgeting.

6. Click the Relationships subtab to enter contacts for this project.

7. Click the Communication subtab to enter phone calls, CRM tasks, events, attach files, and create user notes for this record. For more information, see Communication.

8. Click the Preferences subtab to select preferences to apply to this project. For more information, see Setting Up Project Record Preferences.

9. When you have finished, click Save.

After you save a project record, additional information can be entered on the Resources and Schedule subtabs when you view or edit the project record. For more information, see Assigning Project Resources and Working with Project Records.

Setting Up Project Record Preferences

When creating a project record, you can select which preferences you want to apply to each project. Preferences can determine how your resources are assigned and work with the project record, how time is tracked and classified, and how expenses are used with the project. When creating a new project, you must select preferences on each project record. There are no global preferences available for project records.

To select preferences for a project record:

1. Go to Lists > Relationships > Projects. Click Edit next to the project you want to edit.
2. Click the Preferences subtab on your project record.

3. Check the Allow Time Entry box to allow resources to enter time worked for this project on time transactions. This project is available in the Customer/Project dropdown on time transactions for resources assigned to this project.

This preference is enabled by default. Clear this box to restrict the entry of time transactions against this project.

4. Check the Display All Resources for Project Task Assignment box to allow any employee or vendor designated as a project resource to be assigned to tasks for this project. When you assign a resource that is not specified the Resources subtab, then NetSuite automatically adds the person to the Resource subtab for you. You cannot delete resources from the Resources subtab after they are assigned to project tasks.

**Important:** When you enable this preference, any resource that has been previously assigned to a project appears in the list of available resources. This allows for the possibility that an employee or vendor no longer designated as a project resource can still be assigned to a new project task.

Clear this box to allow only resources listed on the Resource subtab to be assigned to project tasks.

**Note:** If you also use Resource Allocations, generic resources are available for project task assignments regardless of being allocated to the project.

For more information, see Assigning Project Resources.

5. Check the Limit Time and Expenses to Resources box to only allow assigned resources to enter time and expenses against this project and its project tasks.

This preference is enabled by default. Clear this box to allow any project resource to enter time and expenses against this project and its individual project tasks.

6. Check the Classify Time as Utilized box to classify time entered on this project as Utilized time by default.

This preference is enabled by default.

7. Check the Classify Time as Productive box to classify time entered on this project as Productive time by default.

This preference is enabled by default.

8. Check the Classify Time as Exempt box to classify time entered on this project as Exempt time by default.

Any time that should not be included in the denominator of utilization calculations should be identified as exempt.

For more information on classifying time, read Classifying Time for Projects.

9. Check the Allow Expenses box to allow resources to enter expenses for this project on expense reports. This project is available in the Customer/Project dropdown on expense reports for resources assigned to this project.

This preference is enabled by default. Clear this box to restrict the entry of expense reports against this project.

10. Check the Create Planned Time Entries box to include planned time on resource time reports.

For information about planned time entry limits, see Creating Planned Time Entries.

This preference is enabled by default. Clear this box to exclude planned time from reports.

11. Check the Include CRM Tasks in Project Totals box to include CRM tasks in project costs, planned time and actual work for a project.
Important: When you enable the Include CRM Tasks in Project Totals preference on a project, be aware that task hierarchies can be set up only within each distinct set of task types. A CRM task can be defined as a parent or a child task of a CRM task only. A project task cannot have a CRM task set as a parent or child task. Likewise, a CRM task cannot have a project task set as a parent or child task.

For more details, read Including CRM Tasks in Project Totals.

12. If you use Charge-Based Billing, check Forecast Charge Run on Demand to limit the refreshing of forecasts when projects are updated. Forecast charges will only be updated with nightly charge runs or manually.

13. If you also use Resource Allocations, check Allow Allocated Resources to Enter Time to All Tasks to allow any resource allocated to this project to enter time against project tasks without being assigned to the task individually. When you enable this preference, any time tracked by an allocated resource is added to the total estimated work for the project task.

Note: When an allocated resource tracks time without being assigned to a specific task and includes a service item, that service item will automatically populate the Service Item field of subsequent time entries for the project. You can change the service item on each time entry.

14. If you use Resource Allocations and Charge-Based Billing, check Use Allocated Time for Forecast to use allocated time for calculating project charges on the Project Charges Forecast report. For more information, see Project Charges Forecast Report.

Note: This preference may not be available if a selection is not made for Service Item for Forecast Reports at Setup > Accounting Preferences > Time & Expenses.

15. If you also use Weekly Timesheets, you can select who has permission to approve time tracked for this project. In the Time Approval field, select one of the following options:

- Approve time automatically – Project time is approved automatically when submitting a weekly timesheet or entering time entries through the Employee Center.
- Default Time Approver – Project time can be approved only by each employee's supervisor or time approver defined on the employee record.
- Project Time Approver – Project time can be approved only by project resources with project time approval permission defined on the project resource role.
- Project Time Approver or Default Time Approver – Both project time approvers and default time approvers can approve project time. This option is selected by default.

Project time approval is dependent on project resource roles. For more information, see Approving Time and Expenses for Projects.

Important: This preference does not override roles with full time permissions. Any role that has full time permissions and unrestricted employee permissions will be able to approve and reject time entries for any employee regardless of the selection made in this field. For more information about permissions, see the help topics Customizing or Creating NetSuite Roles and Set Employee Restrictions.

16. You can now click Save to save your project record, or continue the steps below to enter additional information.
Working with Project Records

After you have saved a project record, you can begin building your project schedule. In addition, NetSuite updates fields on the project record as work is completed on your project.

Schedule subtab

After you save a project record, the Schedule subtab shows on the project record. The Schedule subtab is a workspace to enter and modify project tasks, as well as track task progress.

For more details about the Schedule subtab, read Working with the Project Schedule.

NetSuite updates the following fields as work is completed on your project:

Project Overview

- The Estimated Work field shows the total time for estimated work on all task records for this project.

  **Note:** If this project is set to include CRM tasks, this total includes the Current Time Budget of CRM tasks associated with this project. For details, read Including CRM Tasks in Project Totals.

- The Actual Work field shows all time entered against this project. This total includes open, pending approval, approved, unapproved, and rejected time entered against both project tasks and the project as a whole with no specific task selected.

  **Note:** If this project is set to include CRM tasks, this total includes time entered against CRM tasks associated with this project. For details, read Including CRM Tasks in Project Totals.

- The Remaining Work field shows the time for work yet to be done on all project tasks. This is calculated as:

  \[ \text{All project task Estimated Work minus All project task Actual Work} \]

  **Note:** For individual tasks, before work starts on a task, Remaining Work is the same as Estimated Work. When a task is marked Completed, this number is 0.

- The Percent Work Complete field shows the total percentage completion for all project tasks. Percent Work Complete is calculated as:

  \[ \frac{\text{Total Actual Work time for all project tasks}}{\text{Total Estimated Work time for all project tasks}} \]

  The percentage is 100% when the status of all tasks is Completed.

  **Note:** For individual tasks, calculations are affected by status as follows:

  - When the task status is In Progress, percentage is determined by dividing Actual Work by Estimated Work. When the task status is Completed, this number is 100%.
  - When task status is In Progress, this number represents the number of actual hours worked by the estimated time.

Project Dates

- If you have used the forward scheduling method for your project, the Calculated End Date shows the anticipated end date for the project based on calculations from data on project task records.
NetSuite determines which task has an end date farthest in the future and uses that date as the end date for the project. This may not be the last task on the schedule.

If the project schedule changes, the calculated project end date can change.

- If you have used the backward scheduling method for your project, the Calculated Start Date shows the anticipated start date for the project based on calculations from data on project task records.
  NetSuite determines which task has a start date farthest from the selected end date and uses that date as the start date for the project.

- The Last Baseline Date field shows the date when the last project baseline was set.

**Financial**

Under Estimates:

- The Estimated Labor Cost field shows the total amount expected to be spent on labor for this project based on labor costs for the tasks required. This amount is calculated as \([\text{Estimated Work} \times \text{Cost}]\) summed for all project tasks, as follows:
  - First, NetSuite calculates the estimated cost of each task:
    - Estimated labor cost of a task
      \(= [\text{Estimated Work of Task} \times \text{labour rate of resource assigned to task}]\)
  - Next, NetSuite combines the task costs.
    - Estimated Labor Cost of the project
      \(= \text{the sum of estimated labor costs for all tasks required on this project.}\)

For example, you sell a Deluxe Widget Installation and create a project record to identify the three tasks to complete for this project, as shown below:

<table>
<thead>
<tr>
<th>Deluxe Widget Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
</tr>
<tr>
<td>Task 1</td>
</tr>
<tr>
<td>Task 2</td>
</tr>
<tr>
<td>Task 3</td>
</tr>
</tbody>
</table>

**Estimated Labor Cost for Project**

\((100 + 90 + 60) = 225\)

- The Estimated Labor Revenue field shows the total expected profit from labor on all project tasks. This amount is calculated from expected labor costs and revenue on each project task record as \([\text{Estimated work} \times \text{Price}]\) summed for all project tasks.

- The Estimated Gross Profit field shows the gross profit expected, as calculated below:
  - For Time and Materials projects: \([\text{Estimated Labor Revenue} - \text{Estimated Labor Cost}]\)
  - For Fixed Bid projects: \([\text{Project Price} - \text{Estimated Labor Cost}]\)

- The Estimated Gross Profit Percent field shows the percentage profit expected, as calculated below:
  - For Time and Materials projects: \([\text{Estimated Gross Profit} / \text{Estimated Labor Revenue}]\)
  - For Fixed Bid projects: \([\text{Estimated Gross Profit} / \text{Project Price}]\)

The Financial subtab also shows a list of service items associated with this project, and shows the following amounts for each item:

- Resource
Creating a Project Record

- Unit Cost
- Unit Price
- Estimated Work
- Estimated Cost
- Estimated Revenue

**Profit & Loss Subtab**

If you use Job Costing and Project Budgeting, after you have saved the project record, a P&L subtab displays real-time information about the profitability of your project. The revenue, cost, profit, and margin are listed for project labor, expenses, and supplies. The categories listed are also used for defining budgets. For more information, see [Setting Up Project Budgeting](#).

**Budget**

If you use Job Costing and Project Budgeting, after you have saved the project record, a Budget subtab is available to enter cost and billing project budgets. For more information, see [Project Budgeting](#).

**Communication**

The Communication subtab enables you to track important communications about this project within NetSuite. Keeping all of this information in a single place gives you the ability to access any important project information right from the project record.

**To enter communications for a project record:**

1. Go to Lists > Relationships > Projects and click **Edit** next to the project record you want to enter communications for.
2. Click the **Communications** subtab.
3. On the **Phone Calls** subtab, enter or log phone calls related to this project.
4. Use the **Tasks** subtab to view and enter CRM tasks associated with this project.
   For more information on tasks, read the help topic [Working with CRM Tasks](#).
5. On the **Files** subtab, you can select and add files from the File Cabinet that are associated with this customer. For example, you can attach a contract as a file associated with this project.
   Select **-New-** to upload a new file to the File Cabinet.
6. On the **User Notes** subtab, add and track notations about this project.
7. When you have finished, click **Save**.

For more information, see the help topic [Attaching Events, Tasks, and Calls to Records and Transactions](#).

**Additional Project Record Fields**

You can customize the standard project entry form to include several additional fields on your project record. The fields listed below are organized by the default section they would appear in when customizing a project record entry form.

For information on how to customize forms, read the help topic [Creating Custom Entry and Transaction Forms](#).
Creating a Project Record

Primary Information

- **Project Type** – Project types are user-defined values to classify projects in a way meaningful to your company. You can define project types at Setup > Accounting > Accounting Lists > New > Project Type.
- **Category** – Select a customer category for the project. You can define customer categories at Setup > Accounting > Accounting Lists > New > Customer Category.
- **Comments** – Add additional information about the project.
- **Image** – Add an image for the project. You can select an image from the File Cabinet or upload a new image.

Project Overview

- **Estimated Work Baseline** – This field shows the estimated work at the time the project baseline was set.
- **Initial Time Budget** – This field shows the sum of the initial time budgeted for the CRM Tasks that are included for the project. This field is only relevant if you include CRM Tasks in project totals.

Project Dates

- **Estimated End Date** – If you use forward planning, you can enter the date you plan to complete all project tasks. This field can be updated at any time. With Project Management, NetSuite calculates the end date based on the project schedule and displays it in the Calculated End Date field.
- **Estimated End Date Baseline** – If you use forward planning, this field shows the estimated end date at the time the project baseline was set.
- **Calculated End Date Baseline** – If you use forward planning, this field shows the calculated end date at the time the project baseline was set.

Financial

- **Account** – If you assign account numbers to projects, you can enter it here.
- **Rev Rec Override Percent Complete** – You can enter an estimate of how much of the total project work is complete. This percentage is not calculated or updated by NetSuite.
- **Estimated Cost** – Enter the projected cost to complete the project.
- **Estimated Revenue** – Enter the projected revenue to be billed for work performed on this project.

Creating Projects from Sales Transactions

When you use Project Management and sell service items that are tagged to create projects automatically, use the Create Projects from Sales Transactions page to bulk create these projects.

**Important:** The Create Projects from Sales Transactions permission is required to create projects from sales transactions. Roles with this permission can create projects from sales transactions using templates without requiring the individual permissions for each project element. Add the Create Projects from Sales Transactions permission to any role you want to be able to create projects in bulk.

For more information on setting up items to create projects automatically, read [Setting a Service Item to Create a Project](#).
Creating Projects from Sales Transactions

To create projects from sales transactions:

1. Go to Transactions > Customers > Create Projects From Sales Orders.
   
   Sales orders, opportunities, and estimates appear in this list if they include items that are tagged to create projects but are not yet associated with a project and are not in one of the following statuses:
   
   - Canceled
   - Closed
   - Pending Approval

2. Check the Create Projects box next to each transaction you want to create a project for.

3. In the Project Name field, the name defaults from the Project ID on the project record. You can enter a different name.

4. In the Project Template field, if a project template is selected on the service item the default template is selected. You can select a different template.

5. Select a parent project, if applicable. The Parent Project dropdown appears only if other projects exist for the customer.

6. In the Project Manager field, you can select a manager for this project.

   Note: Only entities marked as project resources on the Human Resources subtab of employee and vendor records appear in the Project Manager dropdown. For more information, see Identifying an Employee as a Project Resource and Identifying a Vendor as a Project Resource.

7. Click Submit.

   When you submit this form, new project records are created for the service items on these transactions. These projects default to show the primary contact from the customer on the sales transaction. The start date of the project defaults to the start date of the sales transaction.

Copying an Existing Project

After you create a project record, you can make a copy of it using the Save As function. This lets you quickly duplicate projects that share common attributes and settings.

Copy an existing project to create a new project with the same tasks, task relationships, resources, assignments, billing schedule, and other details as the original project. All information entered on the Schedule, Resources, Financial, Info, General, and Custom subtabs copies to the new project including the customer, if assigned.
Copying an Existing Project

**Note:** Copying a project means you do not have to enter the same project details each time you need to create a similar project. You can change the name or ID of an existing project and click **Save As** to create a new project. You can change the customer on a project only if there are no transactions associated with the project. To change a customer, in View mode, click the Customer Change button.

**Note:** If you have enabled auto-generated numbers for project records, you will see a Make Copy button in the More Actions menu instead of the Save As dropdown option. After you click Make Copy, a new project number is generated.

To copy a project:

1. Open an existing project in Edit mode.
2. Change the **Project ID**, if not auto-generated, or **Project Name**.
3. You can opt to enter a new project start date. Note that changing this field alone does not enable you to copy a project.
4. Click **Save As** in the Save button dropdown.

**Important:** If you click **Save** instead of **Save As**, you update the existing project, not create a new one. If the existing project has an associated customer, you cannot change the customer on the new project.

For projects that you copy often, considering creating a project template to create new project records each time you need begin a new project. For more information, see Project Templates.

### Project Templates

Project Templates enable you to create project records in NetSuite for projects your business performs repeatedly.

Project templates can help project manager’s manage their work in a timely and efficient manner. Project templates are reusable and provide a standardized starting point for projects and project items. This gives project managers ready-made tools to initiate, execute and close projects.
With Job Costing and Project Budgeting you can include budget information in your project templates. Using Resource Allocations and Generic Resources you can also add project task assignments and allocations to your templates.

Project templates can include as much or as little detail as you choose as the basis for new project records. You can also create a project template from an existing project.

**Important:** Administrators can automatically create project templates. Any other roles must first be customized to add the project template permission before they can begin using project templates.

### To add permission for project templates:

1. Go to Setup > Users/Roles > Manage Roles.
2. Click Customize or Edit next to the role you want to add project templates permission to.
3. In the Name field, you can change the name for your new custom role.
4. On the Permissions subtab, click Setup.
5. In the Permission column, select Project/Project Template Conversion.
6. Click Add.
7. When you have finished, click Save.

You can now assign this custom role to any employees you want to have access to project templates. For information on assigning roles, see the help topic Giving an Employee Access to NetSuite.

To begin creating project templates, go to Lists > Relationships > Project Templates > New. For more information, see Creating Project Templates.

### Creating Project Templates

Project templates enable you to create standardized NetSuite project records for your most frequently used projects.

**To create a project template:**

2. In the Custom Project Form field, select a form for projects created from this template.
3. Enter a name for this template.
4. In the Project Manager field, select a project resource to serve as the project manager for projects created with this template. Only employees with both the Project Resource and Project Manager fields checked on the Human Resources subtab of their employee records appear in the Project Manager field.
5. If you use NetSuite OneWorld, select a subsidiary for this template.
6. In the Scheduling Method field, select Forward or Backward.
   - If you know the date your project must begin, select Forward and enter the estimated date work will start on the project. You can change this date at any time during the life of the project. NetSuite schedules all project tasks without predecessors to start on this date. You can change any dates selected when creating projects from this template.
   - If you know the date your project must end, select Backward and enter the estimated date work must be completed. You can change this date at any time during the life of the project. NetSuite schedules all project tasks without successors to end on this date. You can change this date at any time during the life of the project. NetSuite schedules all project tasks without
 predecessors to start on this date. You can change any dates selected when creating projects from this template.

For more information on scheduling methods, see Project Scheduling Methods.

7. On the Resources subtab, you can add generic resources for your project. If you use Resource Allocations, you can create new resource allocations for generic resources from the Resources subtab. Resource allocations for specific resources cannot be created for project templates.

   **Note:** Specific project resources and task assignments cannot be added to project templates. Generic resources can be used as placeholders in project templates. For more information, see Generic Resources.

8. On the Financial subtab, in the Billing Type field, select a billing type for this template and fill in any additional information.

9. If you use Job Costing and Project Budgeting, you must select a project expense type for this template on the Financial subtab. Check the Apply to all time entries box to apply the selected project expense type to all time tracked against projects created from this template. You can also enter budget information for both cost and billing budgets on the Budget subtab. For more information about entering budgets, see Creating Project Budgets.

   **Note:** Project templates with a duration longer than 10 years do not display project budgets. To enter a budget for your template, ensure that the duration is less than 10 years.

   **Note:** Project templates with budgets displaying more than 20 categories will experience slower performance when creating projects from templates. It is recommended that you add only the most commonly used budget categories when creating project budgets. For more information on selecting categories for project budgets, see Setting Up Project Budgeting.

10. On the Preferences subtab, select which preferences you want to apply to projects created from this template. For more information on how to use project-specific preferences, see Creating a Project Record.

11. Click Save.

12. On the Schedule subtab, click New Project Task to open the project task/milestone form in a new window.

13. Enter information for your project task and click Save.

   For more information on creating project tasks, see Creating a Project Task Record.

14. Continue adding project tasks, milestones, and summary tasks to build your project plan.

### Creating a Project from a Template

After you have saved your project template, you can create a new project record using the template. You can apply a template to a new project record or you can initiate the creation of a new record from the template record.

**To create a new project record from a project template record:**

1. Go to Lists > Relationships > Project Templates.
2. Click View next to the template you want to use.
3. Click **Create Project** at the top of the template record.

4. Enter a name for your new project record.

5. Optionally, select a customer for your new project.

6. **Note:** After a customer has been selected for a project record, you can only change the selected customer if there are no transactions associated with the project.

6. **Note:** When creating a project from a project template, editing of the project or template is not available until the conversion is complete. Each conversion is completed in the background, and you may continue to work in other areas of NetSuite. A message is displayed alerting you that some actions within the project or template are not available. When your project record is available, you can click Edit to add any other information specific to your new project.

A Project Template field is also available on the new project form enabling you to select a project template to populate fields when creating a new project. Selecting a template will automatically populate some fields in the Project Overview section. After saving, your new project will begin copying the remaining template information to your new project record.

Similar to creating a project record from a template record, not all information will be available immediately. Depending on the amount of information in your template, it could take several minutes for all of your information to be copied. Prior to saving the new project record, the Project Template field can be edited to change the selected template. Changing the selected template will rewrite any fields that have been edited with the new template information. After the new project record is saved, the Project Template field is no longer available.

In the event that template conversion fails and NetSuite is not able to create the new project record, you will see a specific error message alerting you to the problem and offering a solution that you can fix and initiate the project creation again. For example, a task on the template contains a Finish No Later Then date set in the past.

**Saving a Project as a Template**

You can also create a project template from an existing project. Go to Lists > Relationships > Projects and click View next to the project you want to use as a template. Click Create Template at the top of the project record. Enter a name for your template and click OK.

When creating a project template from a project, editing of the project or template is not available until the conversion is complete. Each conversion is completed in the background, and you may continue to work in other areas of NetSuite. A message is displayed alerting you that some actions within the project or template are not available. A project template cannot have any transactions, charges, actual time, resource allocations, project resources, or project task assignments.

**Note:** Projects with budgets displaying more than 20 categories will experience slower performance when creating templates from projects. It is recommended that you add only the most commonly used budget categories when creating project budgets. For more information on selecting categories for project budgets, see Setting Up Project Budgeting.

**Setting a Service Item to Create a Project**

Using Project Management, you can set up a service item to create a project each time you sell the item. This option is available for Service For Sale and Service for Resale items only. You designate a service item
Setting a Service Item to Create a Project

First, set up the item records for your service items.

**Setting a service item to create a project:**

1. Go to Lists > Accounting > Items. Click **Edit** next to the service item.
2. On the item record, click the **Related Records** subtab.
3. Click the **Projects** subtab.
4. Check the **Create Project** box.
5. If you want to use a defined project template for projects created from this service item, select a template in the **Project Template** field.
6. If you do not want to use a defined project template, you must define the tasks required to complete the project. For each task, complete the following steps:
   1. In the **Task Template Name** field, enter the task name. This is the task name that appears on project records created for this item.
   2. In the **Start Date Offset** field, specify the start date of the tasks relative to the project start date. For example, if the task starts two days after the project start date, enter 2.
   3. In the **Effort** (hours) field, specify the total number of hours typically required to complete this task. This number of hours is set as the initial time budget for this task on project records created for this item.

   **Note:** When you set up a task for a service for sale item, the task duration does not take weekends into account. For example, an 80 hour duration sets the end date 10 days after the start date.

7. Click **Add**.

8. Click **Save**.

Then, when you sell the item, create a project record from the Bulk Projects queue. The project includes the tasks from the template on the item record. To create project records from sales items, go to Transactions > Customers > Create Projects. For more information, read Creating Projects from Sales Transactions.

To view the list of projects, go to Lists > Relationships > Projects. Click **Edit** next to a project in the list to open the record and assign tasks to personnel.

**Using the Project Consolidation Preference**

The **Consolidate Projects on Sales Transactions** preference determines whether you track one project on sales transactions at the header level or multiple projects at the line level. It also determines how Creating Projects from Sales Transactions creates projects from items.

Project consolidation affects the creation of projects and the processing of transactions.

- **With Consolidate Projects Enabled:**
  
  You can associate one project with each line item on sales transactions, such as a billable item, expense, or time. The customer relationship displays at the header.

  If you use Project Management and create projects in bulk from items, one project is created for each project-tagged line item on sales transactions and each project is billed separately to the customer. The estimated revenue for each project is the net amount of the corresponding line item.
With Consolidate Projects Disabled:
Disable this preference to associate all items on a sales transaction with only one customer or project. The customer and project displays at the header level.

If you use Project Management and create projects in bulk from items, one project is created that contains all project-tagged line items on the order. In other words, project-generating items are consolidated and billed as one project. The estimated revenue for each project is the sum of the net amounts of all corresponding line items.

Note: When the consolidation preference is enabled, you are no longer able to issue sales transactions to a specific project. Instead, you issue the sales transactions to the customer with line items attributed to each project.

For details about creating projects from items, read Setting a Service Item to Create a Project and Creating Projects from Sales Transactions.

To set the Consolidate Projects on Sales Transactions preference:
1. Go to Setup > Accounting > Preferences > Accounting Preferences. Choose Items/Transactions.
2. In the Sales & Pricing section, set your preference for consolidating projects based on the information above.
   - Check the Consolidate Projects on Sales Transactions box to enable the preference.
   - Clear the Consolidate Projects on Sales Transactions box to disable the preference.
3. Click Save.

Using this preference can affect the following:
- Steps for Refreshing Project Items on Transactions.
- Billing and Project Consolidation

Generating an Estimate from a Project

Estimates can be generated from finalized projects. The service items and billing specified on the project record carries over to the estimate. If needed, the project can be modified and additional estimates generated. After an estimate is approved, it can be converted to a sales order.

To create an estimate from a project:
2. Click View next to the project you want to create an estimate from.
3. On the project record, click Estimate from the New menu.
   - A new estimate form opens. The customer from the project record autofills on the estimate.
4. Optionally enter a title for this estimate in the Title field. The estimate title text appears on lists, shows in search and reporting results, and shows on the Estimates subtab of records it is associated with.
5. Complete the estimate form as necessary. For details, read, Preparing an Estimate.
6. Click Save.

After the estimate is saved, it is linked to the originating project. When viewing a project record, you can see the related estimates by clicking the Transactions subtab under the General subtab.
Available in Customer Center Preference

You can share estimates with customers through the customer center, using the Available in Customer Center preference.

For an estimate that requires a large quantity of time to create, you can save the estimate, yet not have it available to customers until it is complete and ready for customer viewing. When it is ready, check the Available in Customer Center box on the Messages subtab on the estimate record. Only then, the estimate shows in the customer center.

Linking a Project to an Opportunity

Projects can be linked to opportunities as details for the plan are refined. Service items on the opportunity are sourced from the project record. Items not associated with the project can also be added to the opportunity.

You can link a project to an opportunity by creating the opportunity from the Opportunities subtab on the project record. When the Consolidate Projects preference is disabled, you can also link a project to an opportunity by selecting it in the Project field in the header of the opportunity form. When the Consolidate Projects preference is enabled, you can select the project when adding items to the opportunity.

To create an opportunity from a project record:

2. Click View next to the project you want to create an opportunity for.
3. Click the Related Records subtab.
   A new opportunity form opens.
   The project's customer or prospect is automatically selected in the Company field.
5. If you do not use the Consolidate Projects preference the project name is automatically selected in the Project field at the top of the page. If you use the Consolidate Projects preference, on the Items subtab, select the project in the Project field for each item you add to this opportunity.

   Note: The service items specified on the project record automatically populate the Items subtab below. These service items can be removed but cannot be modified. Additional items can also be added to this opportunity.

6. Complete the opportunity form as necessary. For details, read, Creating an Opportunity Record.
7. Click Save.

After the opportunity is saved, it is linked to the originating project and appears on the Opportunities subtab of the project record.
Project Tasks

When you use the Project Management feature, you can create project task records. Task records track activities that need to be completed. Project tasks represent individual actions within a set of actions that must be completed to achieve a goal. The goal is achieved when all the tasks for the project are completed.

When you are creating your project record, create a project task record for each activity that you will need to accomplish to complete the project.

Project tasks cannot be created independently, they must be associated with project records. Project tasks are used to facilitate project planning and are created only on the project record.

Tasks created with Project Management can also automate information gathering about each task. For example, you can track time budgeted and remaining for a task and calculate the percentage of a task that has been completed.

Project Task Records

Project tasks list each of the actions you must complete to successfully achieve the goal. Enter a task record for each project task that must be completed.

For example, to track a basic office furniture sales and delivery project, you could create a task record for each of the following:

- Order Items From Supplier
- Assemble Items
- Furniture Delivery and Installation
- Bill Customer For Delivery and Items

After you have created a project record, you can create task records for each task required to complete the project. On the Schedule subtab of a project record, click New Project Task to create a new task for a project.

![Schedule subtab](image)

**Note:** The Schedule subtab appears only after you save a project record.

The previous example is a very basic four-task project. However, many projects are more complicated and require more details to be tracked. When many details must be entered on a task record, it is best to keep all details organized to be sure the task runs smoothly.

The task record you create will contain all the information you need to know about the task, such as the kind of task, duration, dependency on other tasks, start and finish dates, and assigned resources.
Assign resources and define the service type, cost, and estimated work. Then, making calculations for each resource assigned to the task, this information forms the basis for pricing project work and determining the expected gross margin. You can assign multiple resources to a task.

**Note:** Only non-fulfillable or receivable service items can be selected on project tasks.

The estimated work for the task must be specified in hours. Similarly, service items to be used on the project task must be priced in hours.

For more details about creating a task record, read [Creating a Project Task Record](#).

### Organizing Tasks

Some tasks are actually a goal that has sub-tasks itself. To keep these tasks organized, group them based on which ones should be completed together and set up task hierarchies.

### Milestones

Project milestones are used to mark a point in your project, usually completion of a set of tasks or as a project health check to determine if you’re on schedule.

Project milestones cannot have estimated hours, assignees, or a Finish No Later Than (FNLT) constraint. When viewing a project Gantt chart or schedule, milestone tasks are differentiated from regular project tasks.

For more information, see [Creating Milestone Tasks](#).

### Parent Tasks and Work Tasks

When you are creating project task records, you can organize tasks in a hierarchy of parent tasks and subordinate tasks to structure the component parts of a project. Tasks can be one of the following:

- **Work task** – A task record that tracks actual project activity, such as time worked.
- **Parent task** – A task record that only tracks cumulative information about subordinate tasks that are required to complete a project.

On task records, you can select a parent in the Parent Task field to set up a hierarchy of tasks and subordinate tasks. Then, parent tasks are summary tasks only, have no resources assigned, and only track cumulative data about subordinate tasks.

For example, you can create the task Project Planning and Estimate Preparation. Then, create these tasks:

- Furniture Layout and Design
- Prepare Presentation
- Generate Estimates

On each of the three tasks, you select Project Planning and Estimate Preparation as the Parent task. Then, these tasks are grouped together and child tasks are indented below the parent task, as shown below.
The parent task record shows data for all child records. Parent tasks cannot have resources assigned to them, they must be assigned to the child tasks.

**Note:** When creating a parent task, the record may initially be saved as a milestone record. After you have added child tasks, the task is converted to a parent task. For more information, see Milestones.

Another way to organize tasks when you enter task records is to show whether they are dependent on other tasks to be completed. This is done by setting up information about predecessors.

**Predecessors**

Predecessor settings define the dependencies for a task. Dependencies are timing relationships among a group of tasks.

- **Finish-to-Start (FS)** – Task starts when preceding task finishes. Start date is adjusted based on the preceding task’s finish date.
- **Start-to-Start (SS)** – Task starts after preceding task starts. Start date is adjusted based on the preceding task’s start date.
- **Start-to-Finish (SF)** – Task finishes after the preceding task starts. Start date is adjusted based on the preceding task’s start date.
- **Finish-to-Finish (FF)** – Task finishes after the preceding task finishes. Start date is adjusted based on the preceding task’s finish date.

Commonly, a completed project plan is a group of milestones, work tasks, and parent tasks, each parent being one phase of the total plan. The Schedule subtab of the project shows an organized view of the complete plan, as shown below:
When entering predecessors, you can also add lag time between your tasks. Lag time is a delay between tasks that have a dependency. You can enter lag time to adjust your project schedule. To enter lag time, enter the number of days in the Lag Days field on the Predecessor subtab.

**Copying Tasks**

You can copy project tasks between projects and within projects. When copying a project task, you can choose to also copy the task assignments, budgets, and any child tasks. On the Schedule subtab of project records, click Copy next to the project task you want to copy. For more information, see Copying Project Tasks.

**Task Views**

You can choose from several ways to view a complete project in the View field. You can choose a Planning view, Tracking view or Variance view. For more information about these view options, read Working with the Project Schedule.

To view a list of projects tasks by assignee, go to Activities > Scheduling > Project Tasks.

**Project Plans**

Creating, viewing, and organizing tasks for a project are all part of utilizing the project plan. For more information, see Working with the Project Schedule.

Project plan is a term to describe the means to schedule and manage project tasks. It organizes the tasks as parts of the project as a whole and defines how they should work together. The project plan shows on the Schedule subtab of the project record and helps you examine the overall scope, progress, and cost for a project.

**Task Baselines**

After a project has input of necessary tasks, task durations, task dependencies, resource assignments, and cost estimates, take a baseline snapshot to compare intended activity to actual activity. Then, when you record the actual timing of tasks, actual resource time investment and actual costs, you can make a comparison.
Resource Time Entry on Project Tasks

The project record tracks the estimated time entered for each resource on a task. Then, when the resource enters time against the project, the actual time worked is tracked.

The Time subtab on the task record displays the planned time entries.

CRM Tasks

Other task records you can choose to create are CRM task records. CRM tasks are "to do" activities that need to be completed. For example, a CRM task might be an upcoming meeting or phone call with a potential new client.

Like project tasks, the record for each CRM task tracks what must be done and who needs to do it. Unlike project task records, CRM task records can be independent and do not need to be associated with a project.

**Important:** It is recommended that you use project task records, not CRM task records to track information for projects. For more information, read:

- Working with CRM Tasks
- Project Task Records

CRM Tasks and Project Management

CRM tasks can be associated with a project, but are not considered part of the project’s cost and time data unless they are explicitly included using the Include CRM Tasks in Project Totals check box. CRM tasks associated with a project do not display in the project schedule. For more information, read Including CRM Tasks in Project Totals.

Viewing Project Tasks on Your Dashboard

Add the Project Tasks portlet to your dashboard to display project tasks assigned to you or other resources. You can customize the portlet to display project tasks in a way that is meaningful to you. For example, customize the portlet to display a list of your project tasks filtered by project. Or if you are a senior project manager, display a list of late tasks across all projects. This portlet is available only if you use the Project Management feature. From the portlet you can quickly access a task to view or edit task details.

If you use the Inline Editing feature, you can update the status and priority of a project task in the portlet. Using Inline Editing in the portlet to make changes works the same as using Inline Editing in a list view. Since the number of project task fields displayed in the portlet is limited, click Customize View, or Edit View on a custom task view, and reorder the fields, if necessary, to expose the status and priority fields.

**Note:** The Priority field is not exposed on the standard project task form. To display project task priorities as a column in the portlet, you must view a custom project task form in the portlet that includes the Priority field.

The portlet is available for full-access and Employee Center users who have View access to project tasks. If you want to view and update your CRM tasks or create new ones, then add the Tasks portlet to your dashboard.

Use the portlet filter options to select the range of project tasks to display in the portlet. For more information, read the help topic Tasks and Project Tasks Portlets on Your Dashboard.
Creating a Project Task Record

Create a project task record for each task required to complete a project. Project tasks are associated with projects and are created only on the project record. For information about project tasks, see Project Tasks.

Note: For details about creating CRM tasks, read the help topic Creating CRM Task Records.

To create a new project task:

1. Go to Lists > Relationships > Projects and click View next to the project you want to create a project task for.
2. On the project record, click New Project Task on the Schedule subtab.
   A new project task window opens.
3. Under Primary Information:
   a. In the Custom Form field, select the form you want to use to enter this record. This field only appears when you have at least one custom form. You can customize this form by clicking Customize Form at the top of the page.
   b. Enter a name for this task.
   c. Select a parent task if the task you are creating is part of a group of tasks. The parent task summarizes data for all of its subordinate tasks.
      You cannot assign resources to a parent task.
   d. In the Insert Before field, place the new task in the proper order in the schedule, by selecting the task that follows it.
   e. Select a status for this project task.
   f. Check the Non-billable box to designate this task as non-billable.
      When time is entered against this task, it is automatically marked as non-billable and cannot be changed to billable.
4. Under Project Task Overview, in the Estimated Work field, enter the amount of time you expect this task to require to complete.
   The remaining fields are populated after the task record is saved and work has started.
   
   Note: The Estimated Work field is updated automatically when resources are assigned or allocated to the project task. If multiple resources are added the field displays the sum of all estimated work. If this is a parent task, this field automatically updates to include the sum of estimated work for all child project tasks.
   If you also use Resource Allocations, when the Allow Allocated Resources to Enter Time to All Tasks project preference is enabled, estimated work includes the total of all planned time from assigned resources and any tracked time from resources not assigned to this specific task.

   Important: Saving a project task with no estimated work, assigned resources, and Finish No Later Than date creates a project milestone. Milestones can be converted to project tasks by adding estimated work or resources. For more information, see Creating Milestone Tasks.
5. Under Project Task Dates:
1. In the **Constraint Type** field, specify how to determine the start and end dates for the task.
   - **As Soon As Possible** – For forward scheduled projects, NetSuite calculates the earliest possible start date for a task based on existing predecessors and sets the end date based on the available work time in the assigned resource's work calendar.
   - **As Late As Possible** – For backward scheduled projects, NetSuite calculates the latest possible end date for a task based on existing predecessors and sets the start date based on the available work time in the assigned resource's work calendar.
   - **Fixed Start** – The task starts on the date you specify. Predecessor relationships are ignored. The task end date is based on the estimated work for the task and the assigned resource's available work time.

2. The **Start Date** field indicates the estimated date to begin work on the task.
   - If the task constraint is Fixed Start, enter the date to begin work on the task.
   - If the constraint is As Soon As Possible or As Late As Possible, NetSuite determines the Start Date based on the schedule.

3. If the task constraint type is Fixed Start, enter the time to begin work on the task in the **Start Time** field. This field is optional. If left blank, the start time is 12:00 am. You cannot enter a start time if the task constraint type is As Soon As Possible.

   For information on project tasks in multiple time zones, see Working with Projects in Multiple Time Zones.

4. In the **Finish No Later Than** field, you can select the date this task must be finished by.

   **Note:** This constraint takes precedence over task relationships and start dates are adjusted according to the fixed end date of a task with a Finish No Later Than constraint.

6. Under **Notes**, you can enter additional information for this task in the Notes field.

7. Under **Assignees** you can add resources to this project task. For more information, see Assigning Project Resources.

   If you use Resource Allocations, you can choose to allocate resources to the project and then assign tasks using the steps below. You can also allocation resources directly to tasks eliminating the need to assign tasks. For more information, see Assigning Resources with Allocations.

8. On the **Predecessors** subtab, set dependency types for the task:
   a. Select an existing project task in the **Task** field.
   b. Select a dependency type for the existing task as it relates to the current task.
      - **Finish-to-Start (FS)** – Task starts when preceding task finishes. Start date is adjusted based on the preceding task's finish date.
      - **Start-to-Start (SS)** – Task starts after preceding task starts. Start date is adjusted based on the preceding task's start date.
      - **Start-to-Finish (SF)** – Task finishes after the preceding task starts. Start date is adjusted based on the preceding task's start date.
      - **Finish-to-Finish (FF)** – Task finishes after the preceding task finishes. Start date is adjusted based on the preceding task's finish date.
   c. If you want to add lag time to your tasks, enter the number of days in the **Lag Days** field.
   d. Click **Add**.
   e. Repeat these steps for each task dependency you need to set up.

9. If you use Project Budgeting, on the **Budget** subtab, enter cost and billing budgets for this task.
Creating a Project Task Record

For more information, see Creating Project Budgets.

10. On the **Communication** subtab, you can enter notes about this task and attach files from the File Cabinet or upload new files that are associated with this project.

11. On the **Time** subtab, you can choose to enter time against the project. For details on time tracking features, read the help topics Entering a Time Transaction, Weekly Time Tracking, or Timesheets.

12. When you have finished, click **Save**.

![Important:](image)

**Important:** When you edit project tasks to make changes on the record, you must refresh your view of the project record to see updated data on the **Financial** subtab that reflect your changes.

---

**Working with Task Records**

After you have saved a task record and started work on your project, NetSuite updates fields on the project task record to reflect changes in your task details.

To view a project task record, go to Lists > Relationships > Projects. Click View next to the Project your task belongs to. On the Schedule subtab, click the name of the task you want to view. The project task record opens.

When viewing the project task record, the following fields are updated as your project progresses:

- The Actual Work field shows the amount of time entered against this project task. This total includes approved and unapproved time.
- The Remaining Work field shows the time for work yet to be done on this project task. This is calculated as:
  
  \[
  \text{[Estimated Work - Actual Work]}
  \]
  
  Before work starts on a task, Remaining Work is the same as Estimated Work. When a task is marked Completed, this number is 0.
- Percent Complete is calculated as:
  
  \[
  \frac{\text{Actual Work time}}{\text{Estimated Work time}}
  \]
  
  The percentage is 100% when the task status is Completed.
- Depending on the project scheduling method, the Start Date or End Date field shows the estimated date when the task will begin or be complete, based on the estimated work and other dependencies. These dates can change over the life of the project if the amount of work, resources assigned, or task dependencies change. For more information, see Project Scheduling Methods.
- If you use Resource Allocations, the Allocated Work field displays the number of hours allocated to this task. The Percent Complete by Allocated Work field displays the progress of the project based on the allocated resources. This field can be useful in showing when projects require more effort than was originally planned.

---

Creating Milestone Tasks

Project milestones are used to mark a point in your project, usually completion of a set of tasks or as a project health check to determine if you're on schedule.

When creating a milestone task, you cannot assign a resource, enter estimated work, or a Finish No Later Than (FNLT) constraint. When viewing a project Gantt chart or schedule, milestone tasks are differentiated from regular project tasks.

**To create a project milestone:**

2. Click the name of the project you want to edit.
3. On the Schedule tab, click New Milestone.

4. Enter a name for your milestone.
5. Click the Predecessors tab.
6. Select a predecessor task and type.
7. Click Add.
8. Continue adding any additional predecessors, when you have finished, click Save.

Converting Milestone Tasks to Project Tasks

A milestone can be converted to a project task by adding a positive number of estimated work or tracking time against the milestone.

**Note:** You can edit a milestone and assign a resource with 0 hours of estimated work without converting the milestone to a project task. However, if the resource tracks time against the milestone it will be converted to a project task.

A Project task can also be converted to a milestone by removing positive estimated work and any FNLT constraint.

Project Task Attributes Table

The following table can help you understand the function of project task record fields by explaining how some fields work differently at different stages of the life of the project.

For each of the project task fields below, a description is specified for how the field functions at the following stages:

- **Before Baseline** – This is the planning stage of a project before a baseline is set.
- **After Baseline** – This is the planning stage of a project after a baseline is set, but before a task starts.
- **Active Project Stage** – This is when work has begun on project tasks.
- **Project Task Completion** – This is when the project task is marked complete.

<table>
<thead>
<tr>
<th>Task Field Name</th>
<th>Field Data Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Date</strong></td>
<td></td>
</tr>
<tr>
<td>Before Baseline</td>
<td>The estimated date that the project task will begin. This date can be changed at this stage, but doing so can have major repercussions. Dependent task start and end dates may be impacted for Fixed Start constraint tasks. Otherwise, this date is based on other task dependencies and work.</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The estimated date that the project task will begin. If this date is changed (or any dependent tasks are changed in a way that impacts this date) after the baseline is set, this date is still only an estimate and will not change the baseline date for which variance will be recorded.</td>
</tr>
<tr>
<td>Field Data Function</td>
<td>Task Field Name</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Note: If for any reason a new baseline is set, the value in the Start Date field will replace this value and all historical information will be lost.</td>
<td>Active Project Stage</td>
</tr>
<tr>
<td>Note: If for any reason a new baseline is set, the value in the Start Date field will replace this value and all historical information will be lost.</td>
<td>Project Task Completion</td>
</tr>
<tr>
<td>Baseline Start Date</td>
<td>Before Baseline</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The value in the Start Date field when the baseline is set. Start date variance will be recorded against this field.</td>
</tr>
<tr>
<td>Active Project Stage</td>
<td>The value in the Start Date field when the baseline is set. Start date variance will be recorded against this field.</td>
</tr>
<tr>
<td>Project Task Completion</td>
<td>The value in the Start Date field when the baseline is set. Start date variance will be recorded against this field.</td>
</tr>
<tr>
<td>Start Date Variance</td>
<td>Before Baseline</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The difference between the Baseline Start Date and the estimated Start Date.</td>
</tr>
<tr>
<td>Active Project Stage</td>
<td>The difference between the Baseline Start Date and the estimated Start Date.</td>
</tr>
<tr>
<td>Project Task Completion</td>
<td>The difference between the Baseline Start Date and the estimated Start Date.</td>
</tr>
<tr>
<td>End Date</td>
<td>Before Baseline</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The estimated end date for a task. This date can be changed only by changing one of the following:</td>
</tr>
<tr>
<td>■ the amount of work</td>
<td>■ resources assigned</td>
</tr>
<tr>
<td>■ dependency relationships for a certain task</td>
<td>■ changing other tasks that have dependencies with this task</td>
</tr>
<tr>
<td>Active Project Stage</td>
<td>The estimated end date for a project task. This date can be changed only by changing one of the following:</td>
</tr>
<tr>
<td>■ the amount of work</td>
<td>■ resources assigned</td>
</tr>
<tr>
<td>■ dependency relationships for a certain task</td>
<td></td>
</tr>
<tr>
<td>Task Field Name</td>
<td>Field Data Function</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Project Task Completion</td>
<td>After the project task is explicitly marked complete, the end date becomes the actual end date of the task. This is determined by using the date of the last time entry entered against the project task. Then, the project task no longer appears as an option in time entry forms.</td>
</tr>
</tbody>
</table>

**Baseline End Date**

<table>
<thead>
<tr>
<th>Before Baseline</th>
<th>This field does not have a value until a baseline is saved.</th>
</tr>
</thead>
<tbody>
<tr>
<td>After Baseline</td>
<td>The date showing in the End Date field when the baseline is set becomes the Baseline End Date. All end date variance is recorded against this date. Note: If for any reason a new baseline is set, the value in the End Date field will replace this value and all historical information will be lost.</td>
</tr>
<tr>
<td>Active Project Stage</td>
<td>The date showing in the End Date field when the baseline is set becomes the Baseline End Date. All end date variance is recorded against this date. Note: If for any reason a new baseline is set, the value in the End Date field will replace this value and all historical information will be lost.</td>
</tr>
<tr>
<td>Project Task Completion</td>
<td>The date showing in the End Date field when the baseline is set becomes the Baseline End Date. All end date variance is recorded against this date. Note: If for any reason a new baseline is set, the value in the End Date field will replace this value and all historical information will be lost.</td>
</tr>
</tbody>
</table>

**End Date Variance**

<table>
<thead>
<tr>
<th>Before Baseline</th>
<th>This field does not have a value until a baseline is saved.</th>
</tr>
</thead>
<tbody>
<tr>
<td>After Baseline</td>
<td>The difference between the baseline end date and the estimated end date.</td>
</tr>
<tr>
<td>Active Project Stage</td>
<td>The difference between the baseline end date and the estimated end date.</td>
</tr>
<tr>
<td>Project Task Completion</td>
<td>The difference between the baseline end date and the actual end date.</td>
</tr>
</tbody>
</table>

**Estimated Work**

<table>
<thead>
<tr>
<th>Before Baseline</th>
<th>The estimated amount of work for a project task. This amount can be changed at this stage, but doing so can have major repercussions. Dependent task start and end dates may be impacted.</th>
</tr>
</thead>
<tbody>
<tr>
<td>After Baseline</td>
<td>The estimated amount of work for a project task. If this amount is changed after the baseline is set, it is still only an estimate, but the baseline work is still recorded for variance purposes. Note: If for any reason a new baseline is set, the value in the Start Date field will replace this value and all historical information will be lost.</td>
</tr>
<tr>
<td>Active Project Stage</td>
<td>The estimated amount of work for a project task. If this amount is changed after task work has started, it affects the entire project schedule, such as dates for other tasks and variances.</td>
</tr>
<tr>
<td>Project Task Completion</td>
<td>After a project task is marked complete, the value in this field is set to the sum of all time entries entered against the task.</td>
</tr>
</tbody>
</table>

**Actual Work**

<table>
<thead>
<tr>
<th>Before Baseline</th>
<th>This field does not have a value until time has been entered against a scheduled project task.</th>
</tr>
</thead>
<tbody>
<tr>
<td>After Baseline</td>
<td>This field does not have a value until time has been entered against a scheduled project task.</td>
</tr>
<tr>
<td>Task Field Name</td>
<td>Field Data Function</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Active Project Stage</strong></td>
<td>The actual time entered against a scheduled project task.</td>
</tr>
<tr>
<td><strong>Project Task Completion</strong></td>
<td>The actual time entered against a scheduled project task.</td>
</tr>
<tr>
<td><strong>Baseline Work</strong></td>
<td></td>
</tr>
<tr>
<td>Before Baseline</td>
<td>This field does not have a value until a baseline is saved.</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The value in the Estimated Work field at the time the baseline is set.</td>
</tr>
<tr>
<td><strong>Active Project Stage</strong></td>
<td>The value in the Estimated Work field at the time the baseline is set.</td>
</tr>
<tr>
<td><strong>Project Task Completion</strong></td>
<td>The value in the Estimated Work field at the time the baseline is set.</td>
</tr>
<tr>
<td><strong>Remaining Work</strong></td>
<td></td>
</tr>
<tr>
<td>Before Baseline</td>
<td>The estimated work minus the actual work. Until the task has started, this is equal to estimated work.</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The estimated work minus the actual work. Until the task has started, this is equal to estimated work.</td>
</tr>
<tr>
<td><strong>Active Project Stage</strong></td>
<td>The estimated work minus the actual work.</td>
</tr>
<tr>
<td><strong>Project Task Completion</strong></td>
<td>After a task is marked complete, this is always 0.</td>
</tr>
<tr>
<td><strong>Work Variance</strong></td>
<td></td>
</tr>
<tr>
<td>Before Baseline</td>
<td>This field does not have a value until a baseline is saved.</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The difference between the baseline work and the estimated work.</td>
</tr>
<tr>
<td><strong>Active Project Stage</strong></td>
<td>The difference between the baseline work and the estimated work. Note: This amount does not dynamically update based on the amount of work complete, it is the overall task estimate.</td>
</tr>
<tr>
<td><strong>Project Task Completion</strong></td>
<td>The difference between the estimated work and the actual work.</td>
</tr>
<tr>
<td><strong>Percent Complete</strong></td>
<td></td>
</tr>
<tr>
<td>Before Baseline</td>
<td>N/A – Actual Work / Estimated Work = 0</td>
</tr>
<tr>
<td>After Baseline</td>
<td>N/A – Actual Work / Estimated Work = 0</td>
</tr>
<tr>
<td><strong>Active Project Stage</strong></td>
<td>Actual Work / Estimated Work</td>
</tr>
<tr>
<td><strong>Project Task Completion</strong></td>
<td>After a task is marked complete, this is always 100%</td>
</tr>
<tr>
<td><strong>Estimated Cost</strong></td>
<td></td>
</tr>
<tr>
<td>Before Baseline</td>
<td>The estimated cost of the labor associated with a task. This has a value only after work has been assigned and resources have been assigned to a certain task.</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The estimated cost of the labor associated with a task. Changing the amount of work or the resources assigned will affect this value.</td>
</tr>
<tr>
<td><strong>Active Project Stage</strong></td>
<td>The estimated cost of the labor associated with a task. Changing the amount of work or the resources assigned will affect this value.</td>
</tr>
</tbody>
</table>
### Project Task Attributes Table

<table>
<thead>
<tr>
<th>Task Field Name</th>
<th>Field Data Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Task Completion</td>
<td>The estimated cost of the labor associated with a task. Changing the amount of work or the resources assigned will affect this value.</td>
</tr>
<tr>
<td><strong>Actual Cost</strong></td>
<td></td>
</tr>
<tr>
<td>Before Baseline</td>
<td>This field does not have a value until time has been entered against a scheduled task.</td>
</tr>
<tr>
<td>After Baseline</td>
<td>This field does not have a value until time has been entered against a scheduled task.</td>
</tr>
<tr>
<td>Active Project Stage</td>
<td>The actual cost of the time entered against the task.</td>
</tr>
<tr>
<td>Project Task Completion</td>
<td>The actual cost of the time entered against the task.</td>
</tr>
<tr>
<td><strong>Baseline Cost</strong></td>
<td></td>
</tr>
<tr>
<td>Before Baseline</td>
<td>This field does not have a value until a baseline is saved.</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The estimated cost of the labor resources * the estimated work assigned to a task.</td>
</tr>
<tr>
<td>Active Project Stage</td>
<td>The estimated cost of the labor resources * the estimated work assigned to a task.</td>
</tr>
<tr>
<td>Project Task Completion</td>
<td>The actual cost of the labor resources * the actual work completed on a task.</td>
</tr>
<tr>
<td><strong>Estimated Cost Variance</strong></td>
<td></td>
</tr>
<tr>
<td>Before Baseline</td>
<td>This field does not have a value until a baseline is saved.</td>
</tr>
<tr>
<td>After Baseline</td>
<td>The difference between the baseline cost and the estimated cost.</td>
</tr>
<tr>
<td>Active Project Stage</td>
<td>The difference between the baseline cost and the estimated cost.</td>
</tr>
<tr>
<td>Project Task Completion</td>
<td>The difference between the baseline cost and the actual cost of the completed task.</td>
</tr>
</tbody>
</table>

### Identifying Parent Tasks

Organize project tasks in a hierarchy of parent tasks and subordinate tasks to structure the component parts of a project.

Tasks can be one of the following:

- **Work task** – A task record that tracks actual project activity, such as time worked.
- **Parent task** – A task record that only tracks cumulative information about subordinate tasks that are required to complete a project.

For example, if you need to manage an installation project that is composed of 3 individual tasks, you can set up task records as follows:

- First, create a task record for the installation. This task will become a parent task record after you identify it as the parent of other tasks.
- Next, enter a work task for each of the three individual tasks. Identify each task as a subordinate of the installation task by selecting it as the parent.

Time employees spend working on the installation is entered on each child task record. Then, data for each child task is summed on the parent task record.
Identifying Parent Tasks

Note: There must be at least one task already associated with the project before the Parent Task field appears.

Important: A parent task cannot have resources assigned to it. This is because parent task records do not track work directly, they only track other tasks.

Parent task records track the following data sourced from its subordinates:

- Start Date – the earliest start date of all subordinate tasks
- End Date – the latest end date of all subordinate tasks
- Estimated Work – the cumulative total estimated work for all subordinate tasks
- Actual Work – the cumulative total actual work done for all subordinate tasks
- Remaining Work – the cumulative total work remaining for all subordinate tasks
- Percent Complete – the percentage of work completed for the task overall

If you use Resource Allocations, the Allocated Work and Percent Complete by Allocated Work fields are also sourced from parent task subordinates.

To set up parent and subordinate tasks, open the task record and select a parent in the Parent Task field.

When you view the task list on a project record, each parent tasks shows its subordinates indented beneath it.

Note: If you use CRM Tasks with projects, please read Including CRM Tasks in Project Totals regarding task hierarchies.

Scheduling Project Tasks

NetSuite prepares a system-calculated schedule for each project based on project start date or end date, task durations, predecessors, constraints, and resource work calendars. The schedule drives planning, billing, and management for the entire project.

For forward scheduling projects, the project Start Date sets the date from which the project schedule is calculated. For backward scheduling projects, the project End Date sets the date from which the project schedule is calculated.
To view the schedule for a project, go to Lists > Relationships > Projects and click View next to the project. On the project record, the Schedule subtab is the top subtab.

**Resource Assignment and Project Scheduling**

Project scheduling is also based on resource and work data entered on task records. The schedule is based on the duration of the tasks. Task duration is calculated as [estimated work x units] for all task resource rows and helps determine the start and end dates for each task.

For example, a task requires 16 hours of work. Two resources are assigned to the task, each set to work at 100% capacity and for 8 estimated hours. Each resource is assigned to the default work calendar of eight hours per day, Monday through Friday. The task is scheduled across two calendar days, so the project work schedule is 2 days in duration. The schedule also takes into account any time off requested by the assigned resources.

**Note:** The task duration calculation is also based on the task relationships. See Adaptive Scheduling below.

Depending on the scheduling method, the start date or end date of a project task is calculated by assessing the number of hours assigned to each task resource. For each assignment, the resource's work calendar is used to add the specified number of hours to the start date-time or end date-time to arrive at the tasks dates. If the start date or end date of your project changes, NetSuite automatically updates the task dates based on the scheduled tasks. If time off is submitted after the creation of the schedule, the project must be recalculated for adjustments to occur. For more information on scheduling methods, see Project Scheduling Methods.

The total number of hours for the project task is calculated by summing the hours assigned to each resource.

**Work calendars**

Work calendars define the work capacity for resources. Then, that capacity determines when tasks can be scheduled. For details, read Project Resource Work Calendars.

**Creating Planned Time Entries**

When you create a project task, you enter the resource work capacity as percentage of available scheduling time in the Units column. NetSuite uses the work capacity and work calendars for resources assigned to project tasks to create the project schedule and generate planned time entries. If you create planned time entries for a project, NetSuite limits the number of time entries that can be created.

In order to prevent projects with excessive number of tasks and time entries, the following rules apply:

**Project tasks**

When assigning a resource to a project task, the resource capacity or units must be 5% or greater. The estimated work for the resource must be 2080 hours or less.

Depending on the work calendar parameters, possible planned time entries vary. The minimum planned time entry possible depends on the hours per day in the work calendar. For resources assigned to a work calendar with eight hour work day, the minimum planned time entry cannot be less than 24 minutes. The smallest planned time entry possible is 3 minutes (5% of 1 hour, the minimum hours per day allowed in work calendar).
The maximum number of planned time entries per task that can be created for a resource is 260. This is the maximum number of work days a resource can be assigned to work on a task.

Projects

The total number of planned time entries for all project resources must be 5200 or less. The total amount of work days scheduled for a project cannot exceed 20 person years of work.

Adaptive Scheduling

Project tasks are capable of adaptive scheduling. This means, when the current project schedule is viewed, the project schedule accurately reflects necessary changes to the project.

For example, when a project plan is initially created based on task dependencies and resource work calendars, the schedule represents an idealized estimate. This initial estimate does not reflect any actual project work if no actual time has been entered against the project from resources working on the project.

After work on the project begins and progresses, resources enter time worked on the project. After resources enter time against a project, some aspects of project tasks may begin to shift. Aspects that may change include the following:

- project costs
- start and end dates
- work and actual work

For example, the work for TaskOneA is 40 hours: 8 hours per day, Monday through Friday. If a resource assigned to the task enters 4 hours for Monday, then the schedule automatically recalculates so that the project plan shows 4 hours of actual time worked on Monday, 8 hours of planned work scheduled Tuesday through Friday, and 4 hours of planned work scheduled the following Monday for a total of 40 hours.

Tasks with predecessor relationships are set to start based on the start and finish of other tasks. Then, if the duration of one task must change, all tasks related to it may be recalculated to show an updated duration and new start and end dates. For more information, read Predecessor-successor relationships below.

The Time subtab on task records shows Planned Time and contributes to a real-time picture of project schedule.

- If resources complete the project task early, it pulls in projected end date of the project.
- If resources cannot complete tasks as quickly as anticipated, the end date is pushed out accordingly.

Task setup and scheduling

The characteristics of a project task are largely derived from its relationship to other tasks for the project. Task relationships can be one of the following:

- parent-child relationships
- predecessor-successor relationships

Tasks for a project can be arranged in a hierarchy by assigning parent-child relationships. For example, you may create Task One. Then, you create tasks TaskOneA, TaskOneB, and TaskOneC, and assign Task One as the parent task for all three tasks. Identifying Parent Tasks are tasks that have child tasks assigned to it.
The parent task, Task One, is also known as a summary task. The data values shown on a summary task are the rolled up values of its children. For example, a summary task’s start date is the earliest start date of its child tasks, and its end date is the latest end date of its child tasks. The summary task’s work is the sum of the work of its leaves.

**Predecessor-successor relationships**

In addition to a hierarchical structure, project tasks relationships can also be defined in terms of dependency. For each task, you can define how that task relates to other project tasks based on when the task should start. Each task is a predecessor or a successor, even if the task runs concurrent to other tasks.

For example, the completion of TaskOneB requires components that are assembled during TaskOneA. Therefore, TaskOneA is a predecessor of TaskOneB. TaskOneB cannot begin until TaskOneA is completed.

Dependency types that can be assigned on tasks are:

- Finish-to-Start (FS) – Task starts when preceding task finishes. Start date is adjusted based on the preceding task’s finish date.
- Start-to-Start (SS) – Task starts after preceding task starts. Start date is adjusted based on the preceding task’s start date.
- Start-to-Finish (SF) – Task finishes after the preceding task starts. Start date is adjusted based on the preceding task’s start date.
- Finish-to-Finish (FF) – Task finishes after the preceding task finishes. Start date is adjusted based on the preceding task’s finish date.

Some data on a project task are calculated using input from its dependency relationships. The start date of a project task is the latest end date of all predecessors in the start-to-finish dependency case and is the last start date of all its predecessors in the start-to-start case.

Project tasks that have no predecessors start on the start date of the project.

**Assigning Resources to Project Tasks**

Assign resources to define who should complete a project task. You can assign one or more resources for each task.

Resources can be assigned either when the project task record is first created, or be assigned later as the project progresses.

**Note:** If you use Resource Allocations, resources can be allocated directly to project tasks. For more information, see Assigning Resources with Allocations.

**Overbooking Resources**

Because a job resource can be assigned to a high number of tasks and not be constrained by time limitations, you must take care not to overbook project resources. Resource workloads are not assessed when a resource is assigned to a particular task.

For example, Bob can be assigned to three project tasks at one time, even if each task requires 10 hours of daily work, meaning Bob’s total work requirement is 30 hours per day.

It could also be the case that a project task gets rescheduled, and a resource who was previously underbooked on a particular day may become overbooked due to the rescheduling.
In order to assess resource booking, you can run the Current Backlog by Resource report. This report lists employees who are assigned open projects, the number of open projects per employee and the total hours remaining assigned.

For details on this report, read Current Backlog By Resource Report.

Resource Assignment and Profit Margins

When assigning project task resources, remember that the resource you assign to a task can affect the cost of the task, and ultimately the cost of the project. That is because the service item selected for the resource dictates the revenue generated from the task.

The service item sources the cost from the resource record. This cost is then multiplied by the units of work to find the cost of using the resource on the task. Selecting a resource with a higher cost can lead to a higher overall cost for the project and lower margins. Selecting a resource with a lower cost can increase profit margins.

Project costs and revenues can be assessed on the Financial subtab of the project record.

Importing Project Tasks from Microsoft Project

A specialized Import Assistant supports the import of project task data from Microsoft Project plans into NetSuite project records, so you can use Microsoft Project to build project plan templates or individual project plans, then load this data into NetSuite to maintain ongoing project records. NetSuite provides a predefined export map that you can use to save MPP file data into a CSV file that is properly formatted for import.

Note: This feature supports addition of new data into NetSuite; updates currently are not supported.

- Requirements for Project Tasks Imports
- Steps for Project Tasks Imports

Requirements for Project Tasks Imports

In order to import project tasks from Microsoft Project into NetSuite:

- The Project Management feature must be enabled for your account.
- You must have the following permissions:
  - Import CSV File
  - Projects (at least View level)
  - Project Tasks (at least Create level)
- You must first complete the following tasks in NetSuite:
  - Create a project in NetSuite to which the project tasks can be added. Be sure to enter a value for start date, as all scheduling for project tasks is generated from this date. Also, all resources listed in Microsoft Project should be listed in the Project's Resources subtab.
    - For more information, read Creating a Project Record.
  - Edit the NetSuite Employee records of project task resources, enabling the Project Resource check box on the Human Resources subtab, so that the import can include assignments.
For more information, read Identifying an Employee as a Project Resource.

**Steps for Project Tasks Imports**

1. To begin a project tasks import, go to Activities > Scheduling > Project Tasks > Import.
2. Download and set up the NetSuite-provided project file containing the export map.
   1. Click the Download link and save the BlankProjectFileWithExportMap.mpp file to your local machine.
   2. Open the downloaded file in Microsoft Project 2003.
   3. Choose Tools > Organizer and click the Maps tab.
   4. In the left box, labeled ‘BlankProjectFileWithExportMap.mpp’, select the Task export for NetSuite element. Click Copy so that this element appears in the right box, labeled ‘Global.MPT’.
   5. Click the Close button.
   1. Open the Microsoft Project file that contains the tasks you want to import into NetSuite.
   2. Choose File > Save As. Browse to a location, enter a file name, change Save as type to CSV, and click Save.
4. Import CSV file data into NetSuite.
   1. On the first page of the Import Assistant, click the Select button, browse to the CSV file containing exported Microsoft Project tasks data, and click Next.
   2. Review and edit the mapping of CSV fields to NetSuite fields on the Field Mapping page, and click Run.

Note the following:

- NetSuite fields are listed in the right pane, with already mapped fields grayed out. CSV file fields are listed in the left pane, with already mapped fields marked with a green check. The Import Assistant provides default mappings for most fields, which you can change as needed.
- For instructions for mapping fields, see the help topic CSV Field Mapping Tasks.
- Required fields are marked with (Req). You must map these fields or provide default values for them. You need to specify a mappings for the Project field, which is the name of the project, as specified on the NetSuite project record.
- You can add or modify a default value for a field by clicking its pencil icon. (Note that by default, a default value of Not Started is set for the Status field.)
You can map fields for project tasks notes, predecessors, and resources by expanding the sublist folders at the bottom of the right pane.

You can omit a mapping for the MS Project Service Item, which is the charge rate, or you can map a service item with a null value, meaning it has a null price attached to it.

There is a 500-character limit for the names of resources imported for each project task. An error will occur if the names of all resources associated with an imported project task contain more than 500 total characters. It is unlikely you will encounter this error, unless you have many resources with long names associated with a project. If you do encounter this error, you can remove one or more resources from the project task and retry the import.

For more information about mapping fields, see the help topic General CSV Field Mapping Tips.

Copying Project Tasks

You can copy project tasks between projects and within projects. When copying a project task, you can choose to also copy the task assignments, budgets, and any child tasks.

**Important:** Administrators automatically have permission to copy project tasks. All other roles must be customized to add the required permissions before they can copy project tasks.

**To add permission to copy project tasks:**

1. Go to Setup > Users/Roles > Manage Roles.
2. Click Customize or Edit next to the role you want to give permission to copy project tasks.
3. In the Name field, you can change the name for your new custom role.
4. On the Permissions subtab, click Setup.
5. In the Permission column, select Copy Project Tasks.
6. Click Add.
7. Click Lists.
8. In the Permission column, select Project Tasks.
9. In the Level column, select a level for the project tasks permission. A minimum of Create is required to copy project tasks.
10. When you have finished, click Save.

You can now assign this custom role to any employees you want to copy project tasks. For information on assigning roles, see the help topic Giving an Employee Access to NetSuite.

**To copy a project task:**

1. Go to Activities > Scheduling > Project Tasks.
2. Click View next to the project task you want to copy.
   Alternatively, you can also click Copy next to the project task you want to copy in the Schedule subtab of the project record.
4. In the Target Project field, select the project into which you want to copy this task.
5. If you want this task to be a child task, select the parent project task.
6. If you want to change the name of this task, enter a new name in the Project Task field.
7. Check the Copy Assignments box to copy any resource assignments on this task.
8. Check the Copy Budget box to copy any billing and cost budgets associated with this task.
9. If this task is a parent task, you can clear the Copy Children box if you do not want child tasks to be copied.
10. When you have finished, click Copy.

Your new task is now available on the target project. You can also access and copy project tasks from the Schedule subtab of the project record by clicking Copy next to the task you want to copy.

Including CRM Tasks in Project Totals

CRM tasks are "to do" activities that need to be completed. An independent record for each CRM task tracks what must be done and who needs to do it. CRM tasks can be assigned to an employee, partner, or vendor for completion.

CRM tasks can be associated with a project, but are not considered part of the project's cost and time data unless they are explicitly included using the Include CRM Tasks in Project Totals check box. CRM tasks associated with a project do not display in the project schedule.

The Include CRM Tasks in Project Totals check box on project records allows CRM tasks to contribute to the costs, work, and actual work for a project. This check box helps accommodate existing, open projects which depend on CRM task records created prior to the 2008.2 release.

**Important:** When you enable the Include CRM Tasks in Project Totals preference on a project, be aware that task hierarchies can be set up only within each distinct set of task types. A CRM task can be defined as a parent or a child task of a CRM task only. A project task cannot have a CRM task set as a parent or child task. Likewise, a CRM task cannot have a project task set as a parent or child task.

**Note:** After the 2008.2 release, it is strongly recommended that you use project task records for costs, work, and actual work.

You must customize project forms to show the Include CRM Tasks in Project Totals check box.

**To customize a project form to use CRM tasks:**

1. Go to Lists > Relationships > Projects and click Edit next to the project.
2. On the project form, click Customize.
3. Enter a name for the form.
4. Click the Fields subtab.
5. Click the Info subtab.
6. Check the Show box next to Include CRM Tasks in Job Totals.
7. Complete other fields on the form as needed.
8. Click Save.

Be sure to use this form for all projects that need to include CRM tasks. When you use the customized form to create a project record, you can check the Include CRM Tasks in Project Totals box.
Important: If you have enabled the Gross Profit feature and Include CRM Tasks in Job Totals is also enabled, then the gross profit values will be inaccurate on the Financial subtab of the project record and on the sales order. This is because CRM tasks do not have prices associated with them. Only cost and time data is sourced from CRM tasks. As a result, the gross profit values that show are less than the actual gross profit.

Using Saved Searches for Project Tasks and CRM Tasks

You can create saved searches to review combined data from project tasks and CRM tasks. Select the Project Task and CRM Task search type when defining the search parameters.

Other search types available for project information are Project, Project Task, and Task. For information on how to create a saved search, see the help topic Defining a Saved Search.

You can create saved searches to provide project information to help you manage your projects and resources. If you want to view project data by employee across projects or project tasks, create a saved search that joins project task records to project task assignment records and select the fields to filter out the data you are looking for.

Additional data for project task assignment records, not exposed in the application at the resource level but available for search, include Actual Work and Estimated Work Baseline. These fields provide useful information for creating advanced searches for resource exposure and profitability by resource.

For example, you can create saved searches for:

- Actual hours worked per resource for a specific task
- Estimated work, estimated work baseline, and actual work performed by resource
- Unit cost, unit price, estimated revenue, and gross profit by project or by resource

For a list of the project related record types available for creating advanced searches that join fields from different records, see the help topic Related Records Fields Available for Advanced Searches.
Project Task Manager

The Project Task Manager provides a graphic interface that shows all of your project resources and tasks in one place, allowing you to ensure that your project tasks are being staffed effectively.

Staffing managers get a real-time view in their NetSuite accounts of each resource and their assigned tasks. They can quickly identify issues in how tasks are staffed and then resolve these issues within the Project Task Manager itself.

The Project Task Manager lets you:

- identify tasks that are under- or over-staffed
- reassign or reschedule tasks for resources who are overbooked by dragging and dropping tasks to other time slots or assign them to other resources
- adjust the details of each project task by either changing the size of the bar or by altering the information in the Task Assignment Detail popup

The Project Task Manager is an extension of the Project Management feature and requires that this feature be enabled in your NetSuite account.

**Important:** The Project Task Manager is a shared SuiteApp. Your account must be given access to the SuiteApp prior to installation. Contact your account manager for more information.

The Project Task Manager is available as a SuiteApp in Production:

- Location – Production
- Name – Project Task Manager
- Bundle ID – 241945
- Account ID - 5112211

The Project Task Manager is a managed SuiteApp and is automatically updated whenever there are changes. These issue fixes and enhancements are available after the SuiteApp is updated in your account.

You can install the Project Task Manager from the Enable Features page. Go to Setup > Company > Enable Features. On the Company subtab, in the Project section under Related SuiteApps, click Project Task Manager. Click the Install button to begin installing the bundle.

Layout of the Project Task Manager

Before you use the Project Task Manager, familiarize yourself with the layout.
You can filter the information shown by changing the view at the top of the page. You can also create custom views, see Working with Views.

With the buttons in the upper left corner of the Project Task Manager, you can expand or collapse the task assignments for each resource, export or print the displayed information, and you can adjust the time period you are viewing. For more information, see Selecting a Time Period to View.

A summary bar shows the dates each employee resource is staffed. The bars are color coded so you can tell at a glance when a resource is overstaffed or a project is not properly staffed. Each color is explained in the upper right corner. The Project Task Manager takes into account each resource’s work schedule with non-working dates (weekends, for example) which are indicated by a light gray pattern.

Clicking on a task assignment opens a window with task assignment details. You can make adjustments to task assignments and save your changes from within the Project Task Manager. For more information, see Adjusting and Reassigning Tasks.
How to Use the Project Task Manager

When installed, administrator and full access roles can access the SuiteApp by default. Other roles need additional permissions to access the SuiteApp. The table below outlines the permissions required for accessing the Project Task Manager. For information about customizing roles, see the help topic Customizing or Creating NetSuite Roles.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists &gt; Projects</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Project Tasks</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Work Calendar</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Employees</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Vendors</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Items</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Customers</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Generic Resources</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Documents and Files</td>
<td>View</td>
</tr>
<tr>
<td>Transactions &gt; Track Time</td>
<td>View</td>
</tr>
</tbody>
</table>

Required if Resource Allocations is enabled:
### Permission Levels

<table>
<thead>
<tr>
<th>Lists &gt; Resource Allocations</th>
<th>View</th>
</tr>
</thead>
</table>

Required if Classes, Departments, or Locations, or all three options are enabled:

| Lists > Classes | View |
| Lists > Departments | View |
| Lists > Locations | View |

When logged in as administrator, you can view the Project Task Manager at Lists > Custom > Project Task Manager. When logged in with other roles, the Project Task Manager is located in the following places:

<table>
<thead>
<tr>
<th>Center</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting</td>
<td>Vendors &gt; Other &gt; Project Task Manager</td>
</tr>
<tr>
<td>Executive</td>
<td>Expenses &gt; Other &gt; Project Task Manager</td>
</tr>
<tr>
<td>Support</td>
<td>Cases &gt; Other Lists &gt; Project Task Manager</td>
</tr>
<tr>
<td>Marketing</td>
<td>Campaigns &gt; Other Lists &gt; Project Task Manager</td>
</tr>
</tbody>
</table>

You can adjust the settings of your Project Task Manager by clicking the Settings icon at the top of the chart.

![Settings Popup](image)

The Settings popup lets you control the appearance of your Project Task Manager. You can choose to show numbers and details, select colors for the task bars, and select how your information is displayed.

Task assignments are broken down by resource in the far left pane. You can expand or collapse specific resources or projects by clicking the box beside the name.
Working with Views

You can choose which data is shown in the Project Task Manager by setting up views.

The default view shows all task assignments in your NetSuite account, but you can create your own view by clicking the Customize View button at the top of the page.

You can filter task assignments by date, resource, customer, or by task or project. If you want to make your view available to other staffing managers, check the Share This View box.
How to Use the Project Task Manager

After you have created custom views, you can click Edit View to make changes to the view you are currently using. Click Clone View to create a new view from an existing one, making it faster for you to create views that are similar but with slight differences.

Each time you view the Project Task Manager, the filter you selected the previous time is selected by default.

In the event that your data exceeds your SuiteScript usage limit, a message is shown indicating that the data displayed is incomplete. You can often avoid this situation by adding additional filter criteria to limit the data shown.

Selecting a Time Period to View

You can do any of the following to change the period of time that is displayed in the Project Task Manager:

- Click Daily, Weekly, or Monthly in the top header row to change the chart to that time period.
- Click the Next and Previous buttons on either side of the date range move the chart forward and backward.

In the top right corner of the chart are also Next and Previous buttons for pagination of the chart when you have many projects and resources. Use these buttons, or the dropdown, to change the chart to display additional pages.

Adjusting and Reassigning Tasks

The Project Task Manager lets you see a total picture of your task assignments and to adjust them so that you are using resources effectively. Using the Search Resource field at the top of the page, you can quickly find tasks associated with specific resources.
You can modify task assignments in the chart directly or by clicking on an assignment and making changes in the Edit Task Assignment Details popup.

In the chart, you can do the following:

- Change a task assignment's estimated hours by stretching or shortening the start or end of the bar.
- Reassign a task by moving it up or down in the chart to another resource.

**Note:** Task assignments that are set to begin As soon as possible cannot be rescheduled in the Project Task Manager in any way that would change the start date of the task.

Changing the start date or estimated hours on preceding task assignments could affect the scheduling of later tasks that are set to begin As soon as possible.

All task hours (actual and planned) can be reassigned by dragging and dropping to a new resource. This does not affect time entries for reassigned tasks. Time entered for the task remains attributed to the original resource on his or her time transaction. When dragging and dropping a task, a green check mark appears if the new location is available for the task and a red No symbol appears if the new location is not allowed for the currently selected task.

When you click on a task assignment in the chart, you can change the resource, end date, estimated work, unit cost, unit price, units %, and service item in the Task Assignment Detail pane. When you make changes in this way, click Save, and the chart is updated.

Changing the units % or estimated hours updates the length of the bar in the chart.

### Exporting and Printing

You can export and print the data displayed in your Project Task Manager by using the buttons at the top left corner of the chart.

![Project Task Manager](image)

Click the icon that corresponds with how you want to export your information—PDF, CSV, Excel, or print.

**Note:** When using CSV to export your data, if you use Excel to open your exported CSV file, any commas or special characters are not converted properly. You can use Excel to open your CSV files only if your resource and task names do not contain any special characters. If you use special characters, you must open your CSV file in plain text.
Working with Resources in Project Management

People you assign and use as labor on a project are project resources. These resources can be your employees or vendors you employ as subcontractors.

Anyone you use as a project resource must first be set up as a project resource on their record. Project resources are then available for assignment when you create a project task. You can add only project resources to project tasks. This enables you to track and measure precise labor information for your projects and resources.

For example, when you set up an employee record to show that person as a project resource, you can record their hourly labor costs and days available to work. This data helps you with scheduling and calculating profits for a project. Resource rates you set can be overridden later on individual project tasks.

For any employee or vendor you want to assign as a resource on projects, you must complete the steps below to set up the record to show them as a project resource.

Setting Up Project Resources

Complete the following to use resources on your projects.

1. Check the **Project Resource** box on each employee and vendor record that you want to assign to projects.

   **Important:** In order to assign vendors and employees to complete project tasks or manage projects, they must first be identified as a project resource on their record. After a resource has been assigned to a project, if you clear the Project Resource box, the resource is still available to be assigned if you use the Display All Resources for Project Task Assignment preference when creating your project in NetSuite.

   Read the following for more information:
   - Identifying an Employee as a Project Resource
   - Identifying a Vendor as a Project Resource

2. Create one or more work calendars to set work and non-work days, and assign a work calendar to each resource.

   Read **Project Resource Work Calendars**.
3. Create project resource roles.
   Read Creating a Project Resource Role.

After you have set up resource records and created resource roles, you can implement these resources on projects. When creating a project, for each project task, select a resource to complete the task and select the role they will use to complete it.

For example, Amy Nguyen is identified as a project resource and has a Standard U.S. Work Calendar assigned on her employee record. When she is selected as a resource on the ABC Office Expansion project, her role is identified as Staff.

In addition to specific employees and vendors, you can also create a generic resource to act as a placeholder when creating project plans and templates. Generic resources are used when a specific resource has not yet been identified. For more information, read Generic Resources.

### Identifying an Employee as a Project Resource

You can identify an employee as a project resource on their employee record. Then, they can be utilized on projects to complete necessary tasks.

When an employee is marked as a project resource, the employee can be selected in the following places:

- In the Name dropdown on the Resource tab of project records
- In the Resource column on the Assignee subtab on project tasks
In the Manager dropdown on the Create Projects from Sales Orders page

**To set an employee as a resource:**

1. Go to Lists > Employees > Employees.
2. Click **Edit** next to the employee you want to make a resource.
3. Click the **Human Resources** subtab.
4. Under Job Information, check the **Project Resource** box.

**Important:** After a resource has been assigned to a project, if you clear the Project Resource box, the resource is still available to be assigned if you use the Display All Resources for Project Task Assignment preference when creating your project in NetSuite.

5. In the **Target Utilization** field, select the percentage utilization of a project resource. For more information on target utilization, see Utilization.
6. In the **Work Calendar** field, select a work calendar. For more information on work calendars, read Project Resource Work Calendars.
7. In the **Labor Cost** field, enter the hourly overhead labor cost rate for this employee. This ensures the correct rate is charged per hour when this resource works on assigned project tasks. Pricing project labor in this way simplifies pricing to reduce errors and help ensure that proper margins are met.
   
   This rate to calculate project costs and profitability. The resource rates you set can also be overridden on individual project tasks.
8. Click **Save**.

To assign employees and vendors to projects and tasks, go to Lists > Relationships > Projects. Click Edit next to a project in the list to open the record.
Identifying a Vendor as a Project Resource

You can identify a vendor as a project resource on their vendor record. Then, they can be assigned as resources on projects and tasks you create. For example, this can be useful if you subcontract work to vendors.

When a vendor is marked as a project resource, the vendor can be selected in the following places:

- In the Name dropdown on the Resource tab of project records
- In the Resource column on the Assignee subtab on project tasks
- In the Manager dropdown on the Create Projects from Sales Orders page

To set a vendor as a resource:

1. Go to Lists > Relationships > Vendors.
2. Click Edit next to the vendor you want to mark as a resource.
3. Click the Financial subtab.
4. Under Project Information, check the Project Resource box.

**Important:** After a resource has been assigned to a project, if you clear the Project Resource box, the resource is still available to be assigned if you use the Display All Resources for Project Task Assignment preference when creating your project in NetSuite.

5. In the Work Calendar field, select a work calendar. For more information on work calendars, read Project Resource Work Calendars.
6. In the Labor Cost field, enter the hourly overhead labor cost rate for this vendor. This ensures the correct rate is charged per hour when this resource works on assigned project tasks. Pricing project labor in this way simplifies pricing to reduce errors and helps to ensure that proper margins are met.
7. In the Hourly Rate field, enter the hourly price which is paid by the customer. This rate calculates project costs and profitability.
8. Click **Save**.

**Note:** A vendor must be assigned an employee role and given access to enter time against projects. For more information, read the help topic *Giving Vendors Access to Time Tracking*.

### Creating a Project Resource Role

When you identify an employee or vendor as a resource on a project, you can identify their role for that project.

For example, create a project resource role called **Assistant Manager**. Then, you can assign the Assistant Manager role to one of the resource personnel for a project.

**Note:** When assigning resources to a project, you can select multiple project roles for a single resource using a multi-select field.

Multi-select for the Role field is not available when using SuiteScript or SOAP web services for project tasks. Multiple roles are accessible using SuiteScript or SOAP web services with each resource listed one time for each assigned role.

To select project resource roles on projects, you must first create resource role records.

**To create a project resource role record:**

1. Go to Setup > Accounting > Project Resource Roles > New.
2. Select **Project Resource Role**.
3. Enter a name for the role. This is the name that appears in the Role dropdown on projects. For example, enter Assistant Manager.
4. Enter a description for the role.
5. Check the **Allow Replacing Task Assignments in Bulk** box to enable employees with this role to reassign project tasks in bulk.
6. If you also use Resource Allocations and Time-Off Management, check the **Send E-mail Notification if Time-off Collides with Project Resource Allocation** box to send notifications to employees assigned this role when resource allocations for projects conflict with approved time off.
7. Check the **Project Time Approve** box to enable employees with this role to approve project time for the projects in which they are assigned this role.
8. Check the **Own Time Approval** box to automatically approve any time tracked by employees with this role. If you clear this box, any time entered toward a project by a resource with this role will need to be approved by the resource’s manager or a project level approver.
9. Click **Save**.

Now, this project resource role can be assigned to resources on projects.

### Generic Resources

Generic resource records can be used as placeholders when project managers and resource managers are planning a project in NetSuite. This feature enables resource allocations and project task assignments to be made when a specific resource may not yet be identified.

**To create a generic resource record:**

1. Go to Lists > Employees > Generic Resources > New.
2. In the **Name** field, enter a name for your generic resource. For example, you could enter Software Developer to act as a placeholder for an unidentified development resource.

3. If you use Per Employee Billing Rates, select a billing class for this resource. For more information, see the help topic **Using Billing Classes**.

4. If you use Per Employee Billing Rates, enter a labor cost. This can be useful when creating budgets for projects when resources have not been identified.

5. Enter a price for this resource.

6. Select a work calendar for this generic resource. Work calendars are used when creating project schedules and resource allocations.

7. Click **Save**.

Your generic resource is now available for project task assignments and resource allocations. Generic resources can be useful when creating project templates. You can save a project template with generic resource task assignments and resource allocations. For more information about project templates, see **Project Templates**.

If you also use Resource Allocations, generic resources are available for bulk task reassignment. For more information, see **Bulk Project Task Reassignment**. Generic resources, project templates, and bulk task reassignment can all be used together to further streamline your project management process.

**Note:** If you use Resource Allocations and choose only to show allocated resources for project task assignments, generic resources are available to be assigned even when they have not been allocated to a project. For more information see, **Creating a Project Record**.

---

## Creating Resource Groups

Resource groups enable you to create a group of resources to be assigned together to a single project task. For example, if you have a group of engineers that typically work on tasks together, you can create a resource group for those engineers. Then, when creating project tasks, you can assign the group to the task instead of each individual engineer.

When assigning groups to a project task, you can choose to divide the estimated work evenly across the members of the resource group or you can assign each member the estimated work entered for the task.

**Note:** Resource groups are not currently available with resource allocations.

### To create a resource group:

1. Go to .
2. Enter a name for this resource group.
3. Enter a description for this resource group.
4. Optionally, select a subsidiary, billing class, class, department, or location for this resource group.
5. In the **Resource** field, select a project resource for this group.

**Note:** Only employees marked as project resources appear in the Resource field. Generic resources and vendors are not available to add to resource groups. For more information, see **Identifying an Employee as a Project Resource**.

6. Click **Add**.
7. Continue to select resources and click **Add** to add resources to this group.
8. When you have finished, click **Save**.
Your resource group is now available to assign to project tasks.

**To assign a resource group:**

2. Click View next to the project you want to update.
3. On the Schedule subtab, click Edit next to the task you want to assign a resource group to.
5. Select a resource group.
6. In the Planned Work field, enter the total amount of work planned from this group of resources.
7. Check the Divide Hours box to divide the hours evenly for all resources.
8. In the Units field, enter the percentage of regular working time that should be devoted to this project task.
9. Select a cost method for this resource group. Employee Cost pulls the labor cost from each employee's record. Unit Cost enables you to enter a specific unit cost to use for each employee on this task.
10. Select a service item for this resource group assignment.
11. You can clear the Source Billing Class from Resource box to select a specific billing class to be used for all the resources in this group for this assignment.
12. When you have finished, click Add.

Each resource is added to the Assignees tab. You can make changes to individual resources by clicking the line for that resource.

**Assigning Project Resources**

After you begin Working with Resources in Project Management, you can then assign resources to projects and tasks as needed. Resources assigned to a project can enter time against the project. You can calculate resource productivity based on reported time.

While assigning resources, you can use the Target Utilization feature for each Project Resource. For more information, see Utilization.

You can also assign generic resources to projects and project tasks when a specific resource has not yet been identified. Generic resources are added in the same way that defined project resources are added to projects and project tasks. For more information, see Generic Resources.

**Important:** If you use Resource Allocations you must first allocate a defined resource to a project before project task assignments can be made. Generic resources may be added to a project task regardless of project allocation. For more information, see Resource Allocations.

You can also allocate resources directly to project tasks. For each project, it is recommended that you choose to either allocate resources directly to project tasks or allocate resources to the project and then assign to project tasks. Using both resource allocations to project tasks and task assignments can create inconsistencies in your project data. For more information, see Assigning Resources with Allocations.

Assigning resources works in conjunction with other project preferences you select on the Preferences subtab when creating the project record.

- **Allow Time Entry** - This preference determines whether time can be entered against the project. You must select this preference in order for anyone to record time against a project for billing purposes.
If you select this preference and the Limit Time and Expenses to Resources preference, then time entry is restricted to only resources identified on the project record.

- **Display All Resources for Project Task Assignment** - Select this if you want to be able to select from a list of all employees and vendors designated as project resources or previously assigned to any project when assigning resources to project tasks.

  **Important:** After a resource has been assigned to a project, if you clear the Project Resource box, the resource is still available to be assigned if you use the Display All Resources for Project Task Assignment preference when creating your project in NetSuite.

  If this option is not selected, then you can assign only resources listed on the Resource subtab of the project to a project task.

  **Note:** If you use Resource Allocations, enabling this preference overrides the need to allocate resources prior to making task assignments. Disabling this preference requires you to allocate defined resources prior to making task assignments. Generic resources are available for task assignments regardless of project allocation.

- **Limit Time and Expenses to Resources** - This preference determines whether only resources assigned to the project can enter time and expenses against the project and its project tasks.

  If you select this preference and Display All Resources for Project Task Assignment, then any resource assigned to a project task is automatically added to the Resources subtab, and therefore, can enter time worked on the project in time tracking.

You have two options when assigning resources to project tasks. Based on how you set the Display All Resources for Project Task Assignment option for the project, you can assign resources from a list of either:

- Resources designated on the project record only - see Assigning Resources Restricted to the Project
- All project resources - see Assigning Resources not Restricted to the Project

### Assigning Resources Restricted to the Project

If the Display All Resources for Project Task Assignment option is not selected for a project, then complete these steps to assign resources. You can select and assign only resources added to the Resources subtab of the project record.

**Assign resources to the project:**

1. Go to Lists > Relationships > Projects and click **Edit** next to the project.
2. Click the **Resources** subtab.
3. In the **Name** column, select the employee or vendor you want to add as a resource.
4. In the **Role** column, select a project role for this resource. For more information on project roles, read Creating a Project Resource Role.
You can select multiple roles for a single resource by holding down Ctrl while selecting roles with your mouse.

5. If you use Job Costing and Project Budgeting, a cost associated with the selected role or employee is automatically populated. In the Cost Override column, you can enter a new cost to be used for this project.

6. Click Add.

7. Repeat steps 3 through 5 for each resource you want to assign to this project.

8. Click Save.

**Assign resources to project tasks:**

For any project task, you can assign one or multiple resources to complete the task.

1. Go to Lists > Relationships > Projects and click Edit next to the project.

2. On the Schedule subtab, click Edit next to the task you want to assign resources to.

3. In the Project Task window, click the Assignees subtab.

4. In the Resource column, select the employee or vendor you want to add as a resource.

   **Note:** The Resource dropdown displays only the resources that you added to the Resources subtab of this project. If you use Resource Allocations, only allocated defined resources and all generic resources are displayed. For more information, see Resource Allocations.

5. Select the service item required for this resource on this task.

6. Enter a unit cost and unit price for this service item on this task.

7. Click Add.

8. Repeat steps 4 through 7 for each resource you want to assign to this task.

9. Click Save.

Each assigned resource may have a different amount of work to perform on the task and may work at a different rate, such as full-time or half-time. The percentage of time the employee dedicates to a single task is often referred to as his or her “full-time equivalent.”

You can also use resource groups to assign multiple resources to a project task at one time. For more information, see Creating Resource Groups.

**Assigning Resources not Restricted to the Project**

If the Display All Resources for Project Task Assignment option is selected for a project, then you can assign any designated project resource. This includes any employee or vendor identified as a project resource on the entity record.

**Important:** After a resource has been assigned to a project, if you clear the Project Resource box, the resource is still available to be assigned if you use the Display All Resources for Project Task Assignment preference when creating your project in NetSuite.

**Assign resources to project tasks:**

For any individual task, you can assign one or multiple resources to complete the task.

1. Go to Lists > Relationships > Projects and click Edit next to the project.
2. On the Schedule subtab, click Edit next to the task you want to assign resources to.
3. In the Project Task window, click the Assignees subtab.
4. In the Resource column, select the employee or vendor you want to add as a resource.

**Note:** An employee or vendor name shows in this list if they are identified as a Project Resource. For more information, read Working with Resources in Project Management.

5. Select the service item required for this resource on this task.
6. Enter a unit cost and unit price for this service item on this task.
7. Click Add.
8. Repeat steps 4 through 7 for each resource you want to assign to this task.
9. Click Save.

Each assigned resource may have a different amount of work to perform on the task and may work at a different rate, such as full-time or half-time. The percentage of time the employee dedicates to a single task is often referred to as his or her “full-time equivalent.”

You can also use resource groups to assign multiple resources to a project task at one time. For more information, see Creating Resource Groups.

### Overbooking and Underbooking

Note that resource assignment is not automatically limited by the time constraints of that resource. Such as, a resource that works 20 hours a week can be assigned to 50 hours of tasks. You must assess time reports to determine if resources are under or over their planned utilization across multiple tasks or projects.

For example, Brenda is scheduled to work on Task 1 full time all of next week (40 hours). It is still possible to assign Brenda to Task 2 full-time for all of next week also, even though she will work only 40 hours total that week.

After resources are assigned on projects and begin to enter time against it, you can do the following:

- View the progress of the project by clicking View Gantt Chart on the Schedule subtab of the project record.
- Monitor resource productivity by running the Utilization by Resource Reports.

### Bulk Project Task Reassignment

A preference is available on the Project Resource Role record that enables project resources to reassign task records in bulk. The preference is enabled by default for the Project Manager resource role.

Bulk task reassignment is available only for task assignments. If you use Resource Allocations, you cannot reassign project task allocations using bulk project task reassignment. For more information on using project task allocations, see Assigning Resources with Allocations.

**To enable the bulk project task reassignment preference:**

1. Go to Setup > Accounting > Project Resource Roles.
2. Click Edit next to the role you want to update.
3. Check the Allow Replacing Task Assignments in Bulk box.
4. Click Save.

After the preference is enabled, Project Manager or anyone else who is allocated to the project can use this feature. Reassigning tasks is available on the Resource Detail subtab of project records in View mode.

**To reassign a project task in bulk:**

2. Click View next to the project with tasks that you want to reassign.
3. Click Resources.
4. Click Resource Details.
5. Click the clipboard icon next to the task you want to reassign to open the Reassign Tasks popup. A list of tasks to be reassigned appears.

**Note:** Only resources assigned to tasks for this project have the clipboard icon in the Reassign Tasks column.

6. In the Resource field, select a new resource to assign selected tasks. Generic resources and resources allocated to this project are available for task reassignment.

**Note:** When reassigning a task that has multiple resources, you cannot bulk assign tasks to a resource already listed on the task. For example, if you are reassigning all of Joe’s tasks to Jane, any tasks with both Joe and Jane already assigned will remain untouched.

7. You can check the Update Task Properties box to also make bulk updates to some properties for this resource.

**Important:** If you check the Update Task Properties box, you must fill in all additional fields. Leaving fields blank will remove any current values set for those fields on the individual tasks.

   a. In the Unit Cost field, enter a new unit cost for this resource.
   b. In the Service Item field, select a new service item for this resource.
   c. In the Unit Price field, enter a new unit price for this resource.

8. Check the Apply box next to each task you want to reassign.
9. When you have finished, click Process.

Reassigning project tasks in bulk can be a valuable tool for streamlining project management when combined with project templates and generic resources.

**Project Resource Work Calendars**

You can set up work calendars to track and manage the work capacity for employees and vendors you assign as resources on projects. Knowing the work capacity for each employee helps you to schedule resources for project tasks.

Also, any employee or vendor you plan to assign as a project resource must have a work calendar assigned on their record.

To begin using work calendars, first create one or more work calendars as needed to assign to your resources. A work calendar defines the standard work week for the employee and lists non-working days, such as holidays and vacation days.
There is no limit to the number of work calendars you can create. You can create a calendar for each group of resources that are differentiated as follows:

- A group based on non-working days
  For example, you could create a U.S. Work Calendar and a Canada Work Calendar to assign calendars with the appropriate non-working holidays for each group.

- A group based on working days
  For example, you could create a standard Full Time Employee calendar for working days 8 hours a day, Monday through Friday and a Part Time Calendar for working days 4 hours a day Monday, Wednesday and Friday.

Calendar settings also determine the criteria used to schedule resources and tasks for a project. Each resource assigned to a project task has a work calendar that identifies how many hours and days in a week a resource is available to work on project tasks. When assigning a resource to a task, you specify the percent of available work time the resource has for scheduling. NetSuite then calculates the length of time to complete the task.

For example, if the employee's work calendar specifies eight hour work days and the employee's capacity or units for a task is 50%, then NetSuite creates four hours of planned time for enough days to complete the estimated work for the task. Using the work calendar parameters for each project resource, the capacity defined for a resource on the project task, and the estimated work for each task, NetSuite builds out the project schedule. For more information about scheduling and the limits for planned time entries, see Scheduling Project Tasks.

After you define a work calendar, select a calendar on each employee and vendor record to define their valid working times. The assigned work calendar determines the capacity for that employee or vendor.

After assigned to a work calendar and identified as a resource, that employee or vendor can be selected for tasks on a project.

To create a work calendar, go to Lists > Employees > Work Calendars > New. For more details, read Setting Up a Work Calendar.

For details about assigning a work calendar to employees and vendors, read Assigning Project Resources.
Important: If you change a saved work calendar, the changes are reflected only in newly created projects or projects you edit and save.

When you change a work calendar after that calendar has been assigned to project resources, those changes are NOT reflected in the project tasks set up before the calendar change. In order to reflect calendar changes in a previously existing project, you must open each project, click Edit and click Save.

Setting Up a Work Calendar

Create a work calendar to determine the work days available for scheduling project tasks and assigning resources.

If you also use Time-Off Management, work calendars enable the system to determine which days are working days for the employee, which it uses to calculate the number of hours to deduct from an employee's balance when a time-off request is submitted.

Each work calendar must have at least one working day and one or more hours of work time per day.

Important: Setting up a work calendar requires enabling either the Time-Off Management or Projects feature. For more information, see Enabling Project Features.

To set up a work calendar:

1. Go to Lists > Employees > Work Calendars > New.
2. Enter a name for the calendar and add comments as needed.
3. Check the Default Calendar box to assign this work calendar to resources by default. The work calendar can be changed on individual records as needed.
4. On the Working Days subtab, enter values that are used to determine the available work days for a project schedule.
   1. In the Start At field, enter the workday start time.
   2. In the Hours Per Day field, enter the number of hours in a workday. This number must be 1 or greater.
5. Check the box next to each day you want to include in your regular work week. You must include at least one day.
   Clear the box next to each day you want to exclude from your regular work week.
6. Click the Non Working Days subtab. On this subtab, enter a date and description for each date you plan to exclude from all project work schedules, such as holidays.
7. In the Date column, select or enter the date of the non-working day. For example, you could enter 12/25/2008.
8. In the Description column, enter a description of the non-working day. For example, you could enter Christmas Day.
9. Click Add.
10. Repeat steps 7 through 9 for each non-working day you want to include on this work calendar.
11. Click Save.

Now, this work calendar can be assigned on vendor and employee records. For more information, read Assigning a Resource Work Calendar.

Assigning a Resource Work Calendar

Each employee and vendor you want to use as a project resource must have a work calendar assigned on their record. A record is initially assigned by default, but you can select any work calendar you have created to assign as needed.

Employee Resources

To assign a work calendar to an employee:
1. Go to the list of employee records at Lists > Employees > Employees.
2. Click Edit next to the employee you want to assign a calendar to.
3. Click the Human Resources subtab of the employee record.
4. In the Work Calendar field, select a calendar.
5. Click Save.

Vendor Resources

To assign a work calendar to a vendor:
1. Go to the list of employee records at Lists > Relationships > Vendors.
2. Click Edit next to the vendor you want to assign a calendar to.
3. Click the Financial subtab of the vendor record.
4. In the Work Calendar field, select a calendar.
5. Click Save.

**Inline Editing**

If you want to update the work calendar for many employee or vendor records at one time, you can run a search for the appropriate records and then use Inline Editing to update the necessary records quickly. For more information, read the help topic Using Inline Editing.
Resource Allocations

**Important:** For information on the availability of Resource Allocations, please contact your account representative.

Resource Allocations are designed to help resource managers allocate and assign the right resources to projects based on availability, skill sets, and other criteria. After a resource has been allocated, or reserved, to a project, a project manager may then decide to assign that resource to a specific task.

You can also allocate resources directly to project tasks eliminating the requirement for resources to be assigned separately. This can be useful when the same person both allocates resources and assigns project tasks.

**Note:** For each project, it is recommended that you choose to either allocate resources directly to project tasks or allocate resources to the project and then assign to project tasks. Using both resource allocations to project tasks and task assignments can create inconsistencies in your project data.

Resource allocations enable companies to get a good sense of employee utilization, a critical efficiency/productivity metric. NetSuite utilization reporting allows customers to select the metrics that matter most to them—worked hours, allocated hours, or assigned hours. These values are divided by available hours, taking into account work calendars and exempt time.

For information on enabling Resource Allocations, see Enabling Project Features.

**Important:** When Resource Allocations is initially enabled, NetSuite creates resource allocation records for all existing project assignments using a work queue. Project records are not available during this time. After this process is complete, project records will be available.

**Resource Allocation Records**

Resource time is requested by entering a resource allocation record. When entering the record, you can select the resource, project, task, dates, and hours requested for each allocation. For ongoing, long-term projects, you can also set a recurrence schedule. After a resource allocation record has been created for a project, the allocated resource is available to be assigned to project tasks. If you select a project task when creating the allocation, you do not need to assign the allocated resource on the project task. For more information, see Assigning Resources with Allocations.

Resource allocation records for projects do not assign resources to any specific task. Allocating a resource to a project, as opposed to a project task, allows the resource to be assigned for specific tasks on projects they are allocated to.

For example, a resource manager creates a resource allocation record for Project A allocating a specific resource to 40 hours of work over a two week period. The manager does not select a specific project task on the allocation record. The allocated resource is now available on the project record to be assigned to specific project tasks.

**Note:** Resource allocations for projects do not limit the time frame or duration of project tasks each employee can be assigned to. Resource allocation records should be used as a tool for resource utilization and planning.

NetSuite automatically levels the requested hours over the time period specified. For a resource who typically works a 40 hour work week, an allocation of 20 hours over two week would result in 2 hours per day of allocated project work.
If you also use Time-Off Management and select a time period that conflicts with approved time off, you will receive a warning when entering a new resource allocation. The Time-Off subtab on resource allocation records shows any approved time off for the selected employee. Resource managers can use this information to better plan their upcoming resource allocations.

Resource allocation records can be created directly from a project record by clicking the New Resource Allocation button at the top of the Resources subtab. Clicking the New Resource Allocation button automatically creates an allocation for the current project.

**Note:** Creating a resource allocation from a project while in view mode requires the project record to be refreshed before the new allocation is available to assign to a project task.

You can also go to Activities > Scheduling > Resource Allocations > New to create a new allocation record. You view all your resource allocation records at . If you use inline editing, you can update your resource allocation records directly in the list.

**Note:** When updating the Allocate By field, any necessary recalculations to the Number of Hours and Percentage of Time fields occur after the page is refreshed.

If you make changes to both the Number of Hours and Percentage of Time fields, NetSuite will first look at the Allocate By field to determine which change to honor. For example, if the Allocate By field is set to Hours, then NetSuite will recalculate based on the change made to the Number of Hours field and ignore any updates made to the Percentage of Time field.

You can delete multiple resource allocation records from the list using inline editing. Select the record you want to delete by clicking in one of the editable fields. Hold down the Ctrl key and continue to select records to be deleted. When you have finished selecting records, hover over the green icon in the New column of any selected line and click Delete Record to delete all the selected records.

### Assigning Resources with Allocations

With the Resource Allocations feature, you can allocate resources to individual projects or directly to project tasks.

**Important:** For each project, it is recommended that you choose to either allocate resources directly to project tasks or allocate resources to the project and then assign to project tasks. Using both resource allocations to project tasks and task assignments can create inconsistencies in your project data.

When creating a new resource allocation in NetSuite, after you select a project in the Customer:Project field, the Project Task field is populated with all available tasks from the selected project. Selecting a specific project task allocates the chosen resource to that task within the project. Leaving the Project Task field blank allocates the resource to the selected project.

On the project task record, the Resources subtab lists all the project resources allocated to the task. The Estimated Work field is updated for both projects and project tasks based on the allocated time for each resource. You can create new resource allocations from the Resources subtab by clicking New Resource Allocation. Clicking the New Resource Allocation button automatically creates an allocation for the current project task.

Resources allocated to individual tasks can track time against those project tasks. If an allocation is deleted, the resource is no longer able to track any additional time against those project tasks.

### Allocating by Percentage

In addition to allocating resources for a specific number of hours, you can also choose to allocate by percentage of time. When allocating a resource by percentage of time, NetSuite uses the resource's work
calendar and designated work hours to determine the number of hours per day in the certain time period the resource is allocated to the project.

For example, a resource that typically works 8 hours a day for a 5 day work week is allocated 50% for two weeks would work on the project 4 hours per day for a total of 40 hours.

**Allocation Type**

When creating a resource allocation, you must select the type of allocation—Hard or Soft.

In the Allocation Type field, select the type of allocation.

- Hard – This allocation request is not flexible; the resource is committed to the dates and hours required on this request.
- Soft – This allocation request is flexible; adjustments can be made to the date and hours if needed to accommodate other priorities.

**Note:** The allocation type pertains to project scheduling and staffing methodology and not an indication of the allocation record being unavailable for editing. Records with a hard allocation type can be edited. It is a recommended best practice to use the allocation types as suggested above when creating resource allocations in NetSuite. Allocation types also have no effect on the availability of a resource to be assigned to any specific project task. Allocation types are intended as another tool for resource utilization and planning.

**Resource Allocation Chart/Grid**

After you have enabled Resource Allocations, you can install the Resource Allocation Chart/Grid SuiteApp. This SuiteApp can be installed directly from Setup > Company > Enable Features by clicking Resource Allocation Chart/Grid in the Related SuiteApps section under Resource Management.

**Note:** Resource Allocation Chart/Grid is a shared bundle. Please contact your account manager for provisioning of the Resource Allocation Chart/Grid bundle.

When installed, administrators and resource managers can access the Resource Allocation Chart/Grid at Lists > Services > Resource Allocation Chart/Grid. The Resource Allocation Chart/Grid offers two tools for visually managing your resource allocations, with the ability to edit existing allocations and create
Creating a Resource Allocation Record

You can create resource allocations to allocate resources to projects for a specific number of hours over a defined period of time.

**To enter a resource allocation:**

1. Go to Activities > Scheduling > Resource Allocations > New.
2. Select a resource for this allocation.
   You can select a specific resource or a generic resource. For more information see, Generic Resources.

3. Select the project to which you want to allocate this resource.

4. If you are using allocations to assign tasks for this project, select the project task you want this resource allocated to.

   **Important:** For each project, it is recommended that you choose to either allocate resources directly to project tasks or allocate resources to the project and then assign to project tasks. Using both resource allocations to project tasks and task assignments can create inconsistencies in your project data. For more information, see Assigning Resources with Allocations.

5. Enter or select the start date and end dates for this allocation.
   If you also use Time-Off Management and the selected resource has approved time off scheduled during this time period, you will receive a warning alerting you to this conflict. You can view the Time-Off subtab to see any approved time off for the selected employee.

6. In the **Allocate** field, enter the number of hours this resource is allocated to this project.
   You can also select **Percent of Time** in the dropdown, and then enter the percent of time this resource is allocated to this project.

   **Note:** When allocating a resource by percentage of time, NetSuite uses the resource work calendar and designated work hours to determine the number of hours per day in the time period the resource is allocated to the project. For example, a resource that typically works 8 hours a day for a 5 day work week is allocated 50% for two weeks would work on the project 4 hours per day for a total of 40 hours.

7. In the **Allocation Type** field, select the type of allocation.
   - **Hard** – This allocation request is not flexible; the resource is committed to the dates and hours required on this request.
   - **Soft** – This allocation request is flexible; adjustments can be made to the date and hours if needed to accommodate other priorities.

   **Note:** The allocation type pertains to project scheduling and staffing methodology and not an indication of the allocation record being unavailable for editing. Records with a hard allocation type can be edited. It is a recommended best practice to use the allocation types as suggested above when creating resource allocations in NetSuite. Allocation types also have no effect on the availability of a resource to be assigned to any specific project task. Allocation types are intended as another tool for resource utilization and planning.

8. If you want to set a recurrence schedule, click the **Recurrence** subtab.
   - Select how often this allocation should occur:
     - **Daily** – Enter the interval between days if this allocation is every day or every few days, or select every weekday if this allocation is every day except Saturdays and Sundays. Enter 1 as the interval if this allocation is every day, for example, or enter 2 if the allocation is every other day.
     - **Weekly** – Enter the interval between weeks, and select the day of the week this allocation repeats on.
     - **Monthly** – If this allocation occurs on the same day of every month or every few months, enter the date the allocation repeats, and select the interval between months.
Creating a Resource Allocation Record

If this allocation occurs on the same day of the week every month or every few months, select the week, the day of the week, and enter the interval between months.

- **Yearly** – If this allocation occurs one time a year, select the month and day of the allocation, or select the week, day and month.

b. In the **End By** field, set the date this allocation stops recurring.

c. If the allocation continues indefinitely, check the **No End Date** box.

9. When you have finished, click **Save**.

After you have entered a resource allocation for a project, the resource is listed on the Resource Allocations subtab of the project record. The resource is now available to be assigned to project tasks and the allocated time appears on the Time Tracking subtab of the project record.

Creating a resource allocation for a project task removes the additional step of assigning the resource to the project task. The resource appears on the Resources subtab of the project task record and is available to track time against the project task. For more information, see Assigning Resources with Allocations.

**Note:** Creating a resource allocation from a project while in view mode requires the project record to be refreshed before the new allocation is available to assign to a project task.

Allocated resources can also be allowed to enter time against project tasks even if they are not individually assigned to the tasks. You can set this preference on individual project records by checking the Allow Allocated Resources to Enter Time to All Tasks box on the Preferences subtab. When this preference is enabled, time tracked by allocated resources is added to the total estimated work for project tasks.

Resource Allocations and Work Calendars

When creating a resource allocation, NetSuite looks for working days within the range of the selected start date and end date. The allocated time is spread evenly over the available working days. If no working days are found in the selected range, the time is allocated evenly across the non-working days within the range. If a single working day is found within the selected range, all time will be allocated to that single day regardless of the amount of time requested.

Displaying Resource Allocations in the Calendar Portlet

Employees marked as project resources that have been allocated to a project can choose to show their resource allocations in the calendar portlet on their dashboards. To enable the preference, in the top right corner of the Calendar portlet, hover over the dropdown icon and click Setup. Check the Show Resource Allocations box and click Save.

**Note:** The preference is not available for employees not designated project resources or with no current allocations.

Resource allocations now appear as the project name at the top of each allocated day in the calendar portlet. Clicking the project name opens the corresponding resource allocation record.

Resource Allocations and Time-Off Management

When using resource allocations with time-off management, project managers can get a real-time overview of any conflicts between allocated resources and approved time-off.
When you allocate an employee as a resource on a project record, the **Time-Off** subtab in the Resource Allocation record displays a list of the approved time-off for the selected employee. Any conflicts are detailed in a warning message. You can choose to either make any necessary changes or save the record with the conflicts. Conflicts are also reflected on the **Time-Off Conflicts** subtab on the project record.

If employees’ time-off requests are approved after they are allocated as a resource, and the approved time-off conflicts with the scheduled time period for the project, the project or resource manager receive an email notification. The notification provides details about conflicts between approved time-off and resource allocations, and provides a link to a saved search.

**To set up resource allocations and time-off management:**

1. Enable the Project Management, Resource Allocations, and Time-Off Management features. For more information, see the help topic Enabling Features.
2. Set up the Time-Off Management feature, including assigning time-off plans to employees. For more information, see the help topic Time-Off Management Setup. If you also use SuitePeople U.S. Payroll, see the help topic Time-Off Management Integration with SuitePeople U.S. Payroll.
3. Assign a work calendar to employees. For more information, see Setting Up a Work Calendar.
4. Identify employees as project resources. For more information, see Identifying an Employee as a Project Resource.
5. Set up email notifications for time-off conflicts:
   a. Go to Setup > Accounting > Job Resource Role.
   b. Beside Project Manager, click **Edit**.
   c. Check the **Send E-mail Notifications if Resource Allocations and Planned Time Off Conflict** box.
   d. Click **Save**.
6. Create a project. For more information, see Creating a Project Record.
7. Create a resource allocation. For more information, see Creating a Resource Allocation Record.

**Resource Allocation Chart/Grid SuiteApp**

The Resource Allocation Chart/Grid offers a visual tool for viewing, creating, and editing resource allocations. You can choose to view your allocations in either a chart or a grid.

**Installing the Resource Allocation Chart/Grid SuiteApp**

**Prerequisites**

Before you install the Resource Allocation Chart/Grid SuiteApp, go to Setup > Company > Setup Tasks > Enable Features. Make sure that the following features are enabled on your account:

- From the SuiteCloud tab:
  - Custom Records
  - Client SuiteScript
  - Server SuiteScript
- From the Company tab:
To install the Resource Allocation Chart/Grid SuiteApp:

1. Go to Setup > Company > Enable Features.
2. Under Resource Management, check the Resource Allocations box if the feature is not yet enabled.
4. In the SuiteApp Details page, click Install.

**Important:** The ability to track time in NetSuite is required to use the Resource Allocation Chart/Grid SuiteApp.

Roles and Permissions for Resource Allocation Chart or Grid

Administrators and resource managers can access the chart and grid by default. Other roles need additional permissions to access the chart and grid.

The Resource Allocation Chart or Grid is being enhanced to support Custom Segments as filters. This will allow resource managers to be far more efficient in identifying the appropriate resources for a given project, based on user defined dimensions such as industry, team, or geography.

The following table outlines the permissions required for accessing the Resource Allocation Chart or Grid. For information about customizing roles, see the help topic Customizing or Creating NetSuite Roles.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists &gt; Custom Record Entries</td>
<td>Full</td>
</tr>
<tr>
<td>Lists &gt; Customers</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Documents and Files</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Employee Record</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Employees</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Generic Resources</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Notes Tab</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Project Templates</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Projects</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Project Tasks</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Resource Allocation Approval</td>
<td>View / Full</td>
</tr>
<tr>
<td>Lists &gt; Resource Allocations</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Resource Allocations</td>
<td>Full (required for editing or creating new allocations)</td>
</tr>
<tr>
<td>Lists &gt; Work Calendar</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Vendors</td>
<td>View</td>
</tr>
<tr>
<td>Permission</td>
<td>Level</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
</tr>
<tr>
<td>Setup &gt; Accounting Lists</td>
<td>View</td>
</tr>
<tr>
<td>Required if Classes, Departments, or Locations, or all three options are enabled:</td>
<td></td>
</tr>
<tr>
<td>Lists &gt; Classes</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Departments</td>
<td>View</td>
</tr>
<tr>
<td>Lists &gt; Locations</td>
<td>View</td>
</tr>
<tr>
<td>Required for OneWorld accounts:</td>
<td></td>
</tr>
<tr>
<td>Lists &gt; Subsidiaries</td>
<td>View</td>
</tr>
</tbody>
</table>

### Granting Custom Roles Access to Resource Allocation Chart/Grid

After customizing a role to access the Resource Allocation Chart/Grid, an administrator must also add these new roles to the script deployment. Doing so ensures that the SuiteApp will launch when a user logs in with the new role.

**To add access for a custom role:**

1. Go to Customization > Scripting > Script Deployments.
2. Click **Edit** next to `customdeploy_psa_racg_su_main`.
3. On the **Audience** subtab, in the **Roles** field, select the roles you want to have access to the Resource Allocation Chart/Grid.
   
   You can select multiple roles by holding down the Ctrl button while selecting each role.

   **Note:** To view the Resource Allocation Chart/Grid in the Project Center, you must add the roles that you use in the Project Center as an audience.

4. When you have finished, click **Save**.

### Running Scripts for Resource Allocation Chart/Grid

When you run a script for Resource Allocation Chart/Grid, make sure that you execute the script as an administrator. On the script deployment record, set the **Execute as Role** field to Administrator. This setting ensures that the script executes based on the record-level permissions assigned to the administrator. For more information, see the help topic Executing Scripts Using a Specific Role.

**Note:** All scripts for Resource Allocation Chart/Grid, except RA Main (`customscript_ra_ss_main`), must be executed using the administrator role.

### Navigation Path for Resource Allocation Chart/Grid

When logged in as an administrator, you can access the Resource Allocation Chart/Grid at Lists > Services > Resource Allocation Chart/Grid. For more information on installing the SuiteApp, see Installing the Resource Allocation Chart/Grid SuiteApp.
When logged in with other roles, you can find the Resource Allocation Chart/Grid in the following places:

<table>
<thead>
<tr>
<th>Center</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting</td>
<td>Vendors &gt; Other &gt; Resource Allocation Chart/Grid</td>
</tr>
<tr>
<td>Executive</td>
<td>Expenses &gt; Other &gt; Resource Allocation Chart/Grid</td>
</tr>
<tr>
<td>Support</td>
<td>Cases &gt; Other Lists &gt; Resource Allocation Chart/Grid</td>
</tr>
<tr>
<td>Sales</td>
<td>Customers &gt; Other Lists &gt; Resource Allocation Chart/Grid</td>
</tr>
</tbody>
</table>

Setting Up and Navigating the Resource Allocation Grid

The Resource Allocation Grid offers visual management of your resource allocations in a grid format. You can edit existing allocations and create new allocations directly from the grid.

To view the grid, administrators can go to Lists > Services > Resource Allocation Chart/Grid and click Grid in the Resource Allocations page. For more information on where you can find the grid with other roles, see Navigation Path for Resource Allocation Chart/Grid.

Navigating the Resource Allocation Grid

For each resource, a summary row shows the total percentage of allocated time within each column. You can choose to view the grid by day, week, or month. The calculations are color coded so you can tell, at a glance, when a resource is overbooked. The grid considers each resource's work schedule with non-working dates (weekends, for example).

⚠️ Important: Scheduled time off is not displayed in the Resource Allocation Grid.

Refer to the following image and table to know more about the different parts of the Resource Allocation Grid.
<table>
<thead>
<tr>
<th>Page Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 New Resource</td>
<td>Click this button to create a new allocation. For more information, see Creating a New Allocation from the Resource Allocation Chart or Grid.</td>
</tr>
<tr>
<td>Allocation</td>
<td></td>
</tr>
<tr>
<td>2 Default and Custom</td>
<td>Select default or custom filter to set the grid view and the fields that will appear in the filter panel. You can select from existing filters or create your own custom filter. For more information, see Using Default Filters to Change the Chart or Grid View and Customizing Resource Allocation Chart/Grid Filters.</td>
</tr>
<tr>
<td>Filters</td>
<td></td>
</tr>
<tr>
<td>3 Filter Panel</td>
<td>Set the values for each filter to customize the information you see on the Resource Allocation Grid. You can select multiple values for some filters. The number on the left of the filter field indicates how many values have been selected for the specific filter. Click the X icon next to this number to clear all selected values for the filter.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can select only 1 value for the Resource Type filter. You can leave the field blank to include all three values in the Resource Type filter.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you do not set a value for the <strong>Start Date</strong> field on the default filters, the system will automatically set it to the current date. The start date is displayed in the format specified on the Set Preferences page.</td>
</tr>
<tr>
<td>4 Large Data Component</td>
<td>Clicking the double arrow icon opens a popup window that lets you select the values for the dropdown fields. The data in these fields are retrieved only when you click the icon, thereby minimizing data searches when the chart or grid initially loads.</td>
</tr>
<tr>
<td>Dropdown</td>
<td>The icon appears when the data in a dropdown field is greater than the value of the Maximum Entries in Dropdowns preference. To set the limit, go to Home &gt; Set Preferences &gt; General.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot type on dropdown fields with the double arrow icon.</td>
</tr>
<tr>
<td>5 Resource Allocation</td>
<td>■ Expand All — Click to view details of all projects and allocations for each available resource.</td>
</tr>
<tr>
<td>Menu</td>
<td>■ Collapse All — Click to hide details of the projects and allocation for each available resource.</td>
</tr>
<tr>
<td></td>
<td>■ Download Icon — Click to download the data on the Resource Allocation Grid and save it as a PDF, CSV, or Excel file. Hold your cursor over the icon to see download options.</td>
</tr>
<tr>
<td>Page Element</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Print Icon</strong></td>
<td>Click to print the data on the Resource Allocation Grid.</td>
</tr>
<tr>
<td><strong>Settings Icon</strong></td>
<td>Click to change the settings for the Resource Allocation Grid. For more information, see Adjusting Resource Allocation Grid Settings.</td>
</tr>
<tr>
<td><strong>Grid</strong></td>
<td>Click to display resource allocations in grid view.</td>
</tr>
<tr>
<td><strong>Chart</strong></td>
<td>Click to display resource allocations in chart view.</td>
</tr>
<tr>
<td><strong>Timeline Display</strong></td>
<td>You can select a specific date or use the buttons beside the date picker to adjust the time frame that is currently displayed. Click Daily, Weekly, or Monthly to adjust how the allocations are displayed, and then use the arrows to move the timeline forward or backward.</td>
</tr>
<tr>
<td><strong>Pagination</strong></td>
<td>Hold your cursor over the page range and click the page that you want to view. You can also click the right or left arrow to view the next or previous page of the grid.</td>
</tr>
<tr>
<td><strong>Total Count</strong></td>
<td>Lists the total number of resources currently shown in the grid.</td>
</tr>
<tr>
<td><strong>Information Icon</strong></td>
<td>Hold your cursor over this icon to display brief information about the resource allocation chart or grid.</td>
</tr>
</tbody>
</table>

**Grid Action Menu**

You can access additional options by clicking the green icon that appears when you hold your cursor over a cell. You can also click the other cells in this column to show more options. The following options are available through the action menu:

- Click the icon at the top of the column to add a resource.
- Click the icon or the cell beside the resource to access the following options:
  - Add Project
  - Edit Resource
  - Remove Allocations

**Note:** The Edit Resource and Remove Allocation options are not available for a generic resource when it is associated to at least one project template.

- Click the icon or the cell beside a project to access the following options:
  - Add Project Task
  - Edit Project Task
  - Re-allocate Project Task
  - Remove Project Task

**Search**

- **Search Resource Field** — Enter a name in the field and click the search icon to filter the grid for that resource. To return the grid to the selected view, clear the Search Resource field and click the Search icon.
- **Sort Resource Dropdown** — Hold your cursor over the narrow space directly to the right of the search icon to show the dropdown button. Click the button to show the following options:
  - Sort Ascending — Click to sort the resources in ascending order.
  - Sort Descending — Click to sort the resources in descending order.
  - Columns — Select the columns that you want to show or hide in the grid.

**Summary Row**

The summary row displays the following information:

- Total allocation — Shows the total allocation for each resource. You can expand the allocations to view more details about the resource's allocation.
<table>
<thead>
<tr>
<th>Page Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Approved time off — A blue triangle on the lower right corner of the cell indicates approved employee time off. The icon is visible in the Resource Allocation Grid when you are using the daily or weekly view. When viewing allocations weekly, the blue triangle appears on the week of the approved time off.</td>
<td></td>
</tr>
</tbody>
</table>

This feature is available in the Resource Allocation Chart/Grid if the following prerequisites are enabled or installed on your account:
- Time Off Tracking feature
- Time Off Tracking SuiteApp

| Editable Cells and Grid Context Menu | Hold your cursor over the cell to view details about that allocation. Click the cell to edit the resource’s allocation. Right click the cell to access the grid context menu. For more information, see Cell Values. |

**Note:** You cannot edit or create new allocations for generic resources assigned to project templates from the Resource Allocation Grid.

**Important:** You must click **Save** at the top of the page before you navigate away from the Resource Allocation Chart/Grid. If you do not click **Save**, any changes you make while working with the grid will not be saved.

---

**Adjusting Resource Allocation Grid Settings**

Before you begin using the grid, you can adjust the grid’s appearance and available filters.

**To adjust the grid settings:**

1. Click the Settings icon at the top of the resource allocation grid.

![Settings](image)

**Note:** Not all settings are available when using the Resource Allocation Grid.

2. Adjust the following settings as necessary:
- **Limit Decimal Places Display** — Choose the maximum number of decimal places to display in the grid. You can select a number from zero to four. When you choose to limit decimal places, the number displayed will be rounded up or down to the selected number of decimal places.

- **Default Date Range** — Select the date range that will be displayed by default when you load the Resource Allocation Grid.

- **Show details on hover** — Check this box to see allocation details when you hold your cursor over an allocation on the grid.

- **Show project tasks** — Check this box to display the project task for allocations made at the task level. Enabling this feature adds a *Project Task* column to the grid.

  > Note: This setting is not available when you are viewing allocations by project or customer.

- **Include resources without allocations** — Check this box to show active resources that do not have any current allocations.

  > Note: This setting is not available when you are viewing allocations by project or customer.

- **Include project templates** — Check this box to view project templates with resource allocations on the grid. When enabled, project templates will also be available in the Project dropdown on the filter panel.

  > Note: You can allocate a generic resource to a project template from the Project Template record. On the Project Template record, go to Resources > Resource Allocations, and then click New Resource Allocation. For more information, see [Project Templates](#).

- **Show rejected allocations** — If you also use Approval Routing for resource allocations, check the box to add values of rejected allocations to the grid.

3. When you have finished, click **Save**.

After you have updated your settings, you can begin using the grid to work with your resource allocations. For more information, see [Using the Resource Allocation Chart/Grid](#).

### Cell Values

You can update single allocations by clicking the cell you want to update and changing the values directly in the grid. The hours displayed are calculated based on how you choose to view the grid.

> Note: Editing options for recurring allocations are not available in grid view.

- **Daily**: Total Hours Allocated for the Given Day
- **Weekly**: \( \frac{\text{Total Allocated Work Hours}}{\text{Total Working Days}} \) * Number of Work Days in the Week
- **Monthly**: \( \frac{\text{Total Allocated Work Hours}}{\text{Total Working Days}} \) * Number of Work Days in the Month

> Note: When updating adjacent cells with the same value, NetSuite merges the allocation into a single record if the allocation percentage is the same across the entire time frame. For example, entering 20 hours in two adjacent weeks creates a single allocation spanning two weeks for 40 hours when the allocation percentage is the same across both weeks. Updating adjacent cells with different values creates multiple allocation records.

When using the weekly or monthly views, multiple allocations are rolled-up, and the values are displayed as a link. To edit these rolled-up values, hold down the Ctrl key and click the link. The grid automatically
switches from monthly to weekly or weekly to daily, so you can edit the individual allocations directly in the grid cells. After saving your edits, changes are allocated equally over the number of working days or weeks in the edited allocation.

You can also right-click the grid cells to access the grid context menu, where you can choose from more options to edit the values.

The **Project Notes** field on allocation records can be updated by typing directly in the **Comments** field.

![Resource Allocation Chart Grid](image)

**Note:** Any changes made to allocations on the grid do not need to be saved before switching to the chart. You can switch between the grid and chart without losing any information.

### Setting Up and Navigating the Resource Allocation Chart

The Resource Allocation Chart lets you visually manage your resource allocations, giving you the ability to edit existing allocations and create new allocations directly from the chart. To see the chart view, administrators can go to Lists > Services > Resource Allocation Chart/Grid and click **Chart** under Resource Allocations. For more information on where to find the chart with other roles, see Resource Allocation Chart/Grid SuiteApp.

Refer to the following image and table to know more about the different parts of the Resource Allocation Chart:

![Resource Allocations](image)
Navigating the Resource Allocation Chart

For each resource, a summary bar shows the total percentage of allocated time within each column. The bars are color coded so you can tell, at a glance, when a resource is overbooked. Each color is explained in the Legend at the top of the chart. The chart considers each resource's work schedule with non-working dates (weekends, for example) which are indicated by a cross-hatched gray pattern. Individual allocation bars are also coded by allocation type.

⚠️ **Important:** Scheduled time off is not displayed in the Resource Allocation Chart.

Refer to the following image and table to know more about the different parts of the Resource Allocation Chart.

<table>
<thead>
<tr>
<th>Page Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 New Resource</td>
<td>Click this button to create a new allocation. For more information, see Creating a New Allocation from the Resource Allocation Chart or Grid.</td>
</tr>
<tr>
<td>Allocation</td>
<td></td>
</tr>
<tr>
<td>2 Default and</td>
<td>Select a default or custom filter to set the grid view and fields that will appear in the filter panel. You can select from existing filters or create your own custom filter. For more information, see Using Default Filters to Change the Chart or Grid View and Customizing Resource Allocation Chart/Grid Filters.</td>
</tr>
<tr>
<td>Custom Filters</td>
<td></td>
</tr>
<tr>
<td>3 Filter Panel</td>
<td>Set the values for each filter to customize the information you see on the Resource Allocation Chart. You can select multiple values for some filters. The number on the left of the filter field indicates how many values have been selected for the specific filter. Click the X icon next to this number to clear all selected values for the filter.</td>
</tr>
<tr>
<td>Note: You can select only 1 value for the Resource Type filter. You can leave the field blank to include all three values in the Resource Type filter.</td>
<td></td>
</tr>
<tr>
<td>Note: If you do not set a value for the Start Date field on the default filters, the system will automatically set it to the current date. The start date is displayed in the format specified on the Set Preferences page.</td>
<td></td>
</tr>
<tr>
<td>4 Large Data</td>
<td>Clicking the double arrow icon opens a popup window that lets you select the values for the dropdown fields. The data in these fields are retrieved only when you click the icon, thereby minimizing data searches when the chart or grid initially loads.</td>
</tr>
<tr>
<td>Component Dropdown</td>
<td></td>
</tr>
<tr>
<td>Page Element</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>5 Resource Allocation Menu</strong></td>
<td>The icon appears when the data in a dropdown field is greater than the value of the Maximum Entries in Dropdowns preference. To set the limit, go to Home &gt; Set Preferences &gt; General.</td>
</tr>
<tr>
<td></td>
<td><strong>Expand All</strong> — Click to view details of all projects and allocations for each available resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Collapse All</strong> — Click to hide details of the projects and allocation for each available resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Download Icon</strong> 📋 — Click to download the data on the Resource Allocation Chart and save it as a PDF, CSV, or Excel file. Hold your cursor over the icon to see download options.</td>
</tr>
<tr>
<td></td>
<td><strong>Print Icon</strong> 🎨 — Click to print the data on the Resource Allocation Chart.</td>
</tr>
<tr>
<td></td>
<td><strong>Settings Icon</strong> — Click to change the settings for the Resource Allocation Chart. For more information, see Adjusting Resource Allocation Chart Settings.</td>
</tr>
<tr>
<td></td>
<td><strong>Grid</strong> — Click to display resource allocations in grid view.</td>
</tr>
<tr>
<td></td>
<td><strong>Chart</strong> — Click to display resource allocations in chart view.</td>
</tr>
<tr>
<td></td>
<td><strong>Timeline Display</strong> — You can select a specific date or use the buttons beside the date picker to adjust the time frame that is currently displayed. Click Daily, Weekly, or Monthly to adjust how the allocations are displayed, and then use the arrows to move the timeline forward or backward.</td>
</tr>
<tr>
<td></td>
<td><strong>Pagination</strong> — Hold your cursor over the page range and click the page that you want to view. You can also click the right or left arrow to view the next or previous page of the chart.</td>
</tr>
<tr>
<td></td>
<td><strong>Total Count</strong> — Lists the total number of resources currently shown in the chart.</td>
</tr>
<tr>
<td></td>
<td><strong>Information Icon</strong> 🚧 — Hold your cursor over this icon to display brief information about the resource allocation chart or grid.</td>
</tr>
<tr>
<td><strong>6 Search Resource Field</strong></td>
<td>Enter a name in the field and click the search icon to filter the chart for that resource. To return the chart to the selected view, clear the Search Resource field and click the Search icon.</td>
</tr>
<tr>
<td><strong>7 Summary Bar</strong></td>
<td>The summary row displays the following information:</td>
</tr>
<tr>
<td></td>
<td><strong>Total allocation</strong> — Shows the total allocation for each resource. You can expand the allocations to view more details about the resource's allocation.</td>
</tr>
<tr>
<td></td>
<td><strong>Approved time off</strong> — A blue triangle on the lower right corner of the cell indicates approved employee time off. The icon is visible in the Resource Allocation Chart when you are using the daily or weekly view. When viewing allocations weekly, the blue triangle will appear on the week of the approved time off.</td>
</tr>
<tr>
<td></td>
<td>This feature is available in the Resource Allocation Chart/Grid if the following prerequisites are enabled or installed on your account:</td>
</tr>
<tr>
<td></td>
<td>□ Time Off Tracking feature</td>
</tr>
<tr>
<td></td>
<td>□ Time Off Tracking SuiteApp</td>
</tr>
</tbody>
</table>

**Projects**
<table>
<thead>
<tr>
<th>Page Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold your cursor over the project to view a popup listing additional details about the project or project task. You can also click the project to open a popup that lets you reassign the resource for the chosen allocation.</td>
<td></td>
</tr>
</tbody>
</table>

**Important:** When in chart mode, only the project name is displayed for each allocation. To view both the project name and customer name, you must enable Auto-Generated Numbers for projects. For more information, see the help topic Set Auto-Generated Numbers.

9 | Allocation Bar | Hold your cursor over the allocation bars to view details about that allocation. Click the bar to edit the resource's allocation or drag and drop the bar to reassign the allocation to a different resource. You can also adjust the start or end dates by stretching or shortening the allocation bar. For more information, see Allocation Bars. |

### Adjusting Resource Allocation Chart Settings

Before you begin using the chart, you can adjust the chart's appearance and available filters.

**To adjust the chart settings:**

1. Click the Settings icon at the top of the resource allocation chart.

2. Adjust the following settings as necessary:
   - **Allocate Using** — Select **Percentage** or **Hours** to determine how allocations are displayed in the chart.

   **Note:** When switching between **Percentage** and **Hours**, you must refresh the chart after saving your preferences for your changes to take effect.

   - **Limit Decimal Places Display** — Choose the maximum number of decimal places to display in the chart. You can select a number from zero to four. When you choose to limit decimal places, the number displayed will be rounded up or down to the selected number of decimal places.
■ Default Date Range — Select the date range that will be displayed by default when you load the Resource Allocation Chart.

■ Include project templates — Check this box to view project templates with resource allocations on the chart. When enabled, project templates will also be available in the Project dropdown on the filter panel.

   **Note:** You can allocate a generic resource to a project template from the Project Template record. On the Project Template record, go to Resources > Resource Allocations, and then click **New Resource Allocation**. For more information, see [Project Templates](#).

■ Show numbers on bars — Check this box to list the allocation values within the bars on the chart.

■ Show details on hover — Check this box to show the allocation details when you hold your cursor over an allocation bar.

■ Show project tasks — Check this box to show the allocations made directly to project tasks.

   **Note:** This setting is not available when you are viewing allocations by project or customer.

■ Include resources without allocations — Check this box to show active resources that do not have any current allocations.

   **Note:** This setting is not available when you are viewing allocations by project or customer.

■ Show rejected allocations — If you also use Approval Routing for resource allocations, check this box to add values of rejected allocations to the chart.

■ Chart Density — Select how compact you want your chart to appear.

■ Allocation — Customize colors to define the different allocation ranges.

   **Note:** When you are viewing allocations by **Customer** or **Project**, color settings for the allocation bars will not be applied to the chart. The allocation bars will be displayed in white.

3. When you have finished, click **Save**.

   After you have updated your settings, you can begin using the chart to work with your resource allocations. For more information, see [Using the Resource Allocation Chart/Grid](#).

### Allocation Bars

Within the Resource Allocation Chart, you can hold your cursor over an allocation bar to see details about that allocation.
You can drag and drop the bar to reassign the allocation to a different resource. When moving the bar, a small green check icon appears if the allocation can be reassigned at the current location. If the allocation cannot be reassigned to the current location, a small red prohibited sign appears.

You cannot reassign allocations through drag and drop if it overlaps with another assignment, or if the start and end dates fall on non-working days. Collapsed allocations cannot be reassigned with drag and drop.

You can adjust the selected dates for the allocation by stretching or shortening the allocation bar. You can also click the allocation bar to open the Edit Resource Allocation window, where you can modify the allocation details.

**Note:** You cannot edit or create new allocations for generic resources assigned to project templates from the Resource Allocation Chart.

**Note:** Any changes made to allocations on the chart do not need to be saved before switching to the grid. You can switch between the chart and grid without losing any information. You must however, click **Save** at the top of the page before you navigate away from the Resource Allocation Chart/Grid. Otherwise, any changes you make while working with the Chart or Grid will not be saved.

For more information about creating resource allocations, see **Creating a Resource Allocation Record**.

Using the Resource Allocation Chart/Grid

**Customizing Resource Allocation Chart/Grid Filters**

You can customize the filters that appear on the filter panel of the Resource Allocation page. The filters let you limit the data on the resource allocation chart or grid so that only information that matches the specified conditions are shown. You can define up to 8 filters.

**To customize the filters for the Resource Allocation Chart and Grid:**

1. Click **Customize Filter** or **Edit Filter** next to the **Filter** dropdown.
2. In the **Filter Name** field, enter a name for your new custom filter.

3. Check the **Share this filter** box to make this filter available to other users when they use the Resource Allocation Chart or Grid. Values selected for each filter are also shared.

   **Note:** Only the filter owner can change the selected values in the shared filter.

4. In the Available Filters section, set values for the following options:
   - **Record** — Select either **Resource** or **Allocation**.

      **Note:** To use custom segments that you applied to a Customer, Generic Resource, and Vendor as a filter, you must select **Record**. You can use both the List/Record and Multi-select types of custom segment.

   - **Field Name** — Fields available in this selection are taken from the specified record. Select the field that you want to use as a filter.

      **Note:** Billing classes, locations, departments, classes, subsidiary, approval status, and project task are only available as filters if these features are enabled on your account.

5. When you have finished, click **Save**. The custom filter will be added to the Filter dropdown. Custom filters are grouped according to the default filter from which they were created.
Note: The fields you select for your custom filters do not have default values. You must select the values for each field from the filter panel area.

Using Default Filters to Change the Chart or Grid View

Default filters let you view the allocations on the chart and grid by resource, customer, or project. The default fields assigned to each filter cannot be removed. You can, however, further customize each filter by adding more fields or conditions. For more information, see Customizing Resource Allocation Chart/Grid Filters.

Note: If you do not set a value for the Start Date field on the default filters, the system will automatically set it to the current date.

From the Filter dropdown on the Resource Allocation Chart or Grid, the following default filters are available:

- **Resource** — Select this option to view the allocations of each resource. The chart or grid will display the resource and their corresponding allocations for a project.

- **Customer** — Select this option to view the allocations of each resource that is assigned to a customer. The chart or grid will display the customer, the project for that customer, and the resources on the project. This preference is currently available for the Resource Allocation Chart.

- **Project** — Select this option to view the allocations of each resource that is assigned to a project. The chart or grid will display the project name, the resources for the project, and their corresponding allocation. This preference is currently available for the Resource Allocation Chart.

When you view allocations by project or customer, the following fields or settings will not be available:

- **Project Task** field in the Edit Resource Allocation form
- **Show project task** check box in the Settings popup
- **Include resources without allocations** checkbox in the Settings popup

Note: To view both the project name and customer name on the chart, you must enable Auto-Generated Numbers for projects. When the setting is disabled, only the project name is visible on the chart. For more information, see the help topic Set Auto-Generated Numbers.

Creating a New Allocation from the Resource Allocation Chart or Grid

To create a new allocation:

1. Click **New Allocation** at the top of the Resource Allocation Chart or Grid.
2. Set values for the following fields:
   - **Resource** — Select a resource for this allocation.
     - To search for a resource, click the search icon next to the Resource field. You can search by availability, required skills, billing class, labor cost, and years of experience.
     - Using the resource search lets you view resource resumes without accessing employee records.
Note: Searching for resources by billing class and required skills requires enabling Per-Employee Billing Rates and Resource Skill Sets.
For more information on searching with skill sets, see Using Resource Skill Sets.
Work calendars are required to search for resources. For more information, see Project Resource Work Calendars.

- **Customer:Project** — Select a project for this allocation.
- **Project Task** — If you are using allocations to assign tasks for this project, select the project task you want this resource allocated to. This field is available if you have chosen to show project tasks in the chart or grid settings menu.

Note: This field is not available if you are viewing allocations by Customer or Project.

Important: For each project, it is recommended that you choose to either allocate resources directly to project tasks or allocate resources to the project and then assign to project tasks. Using both resource allocations to project tasks and task assignments can create inconsistencies in your project data. For more information, see Assigning Resources with Allocations.

- **Start Date** — Select a start date for this allocation.
- **End Date** — Select an end date for this allocation.
  Resource allocations can begin and end on non-working days if at least one working day is included in the duration of the allocation.
- **Allocate** — Enter the percentage or number of hours that you want to allocate.
  You can select how you want to allocate by clicking the **Settings** icon at the top of the Resource Allocation Chart.
- **Allocation Type** — Select the type of allocation. The allocation type pertains to project scheduling and staffing methodology. It is not an indication of the allocation record being unavailable for editing. Records with a hard allocation type can be edited. It is a recommended...
best practice to use the allocation types as suggested when creating resource allocations in NetSuite.

- **Hard** – This allocation request is not flexible; the resource is committed to the dates and hours required on this request.
- **Soft** – This allocation request is flexible; adjustments can be made to the date and hours if needed to accommodate other priorities.

- **Next Approver** — If you use approval routing for resource allocations, select the next approver.

- **Recurrence** — Select how often this allocation should occur.
  - **Daily** – Enter the interval between days if this allocation is every day or every few days, or select every weekday if this allocation is every day except Saturdays and Sundays.
    Enter 1 as the interval if this allocation is every day, for example, or enter 2 if the allocation is every other day.
  - **Weekly** – Enter the interval between weeks, and select the day of the week this allocation repeats on.
  - **Monthly** – If this allocation occurs on the same day of every month or every few months, enter the date the allocation repeats, and select the interval between months.
    If this allocation occurs on the same day of the week every month or every few months, select the week, the day of the week, and enter the interval between months.
  - **Yearly** – If this allocation occurs one time a year, select the month and day of the allocation, or select the week, day and month.

In the **End By** field, set the date this allocation stops recurring. If the allocation continues indefinitely, check the **No End Date** box.

**Note:** After saving your allocation, a recurring symbol appears on the grid next to each instance of a recurring allocation. Editing options are not available in the grid view for recurring allocations.

3. When you have finished, click **OK**.

**Note:** Resource Allocation records that do not match the filter values for **Resource** and **Customer:Project** in the current view, will not be visible on the chart or grid after saving. You can modify the filter values to view the resource allocation.

**Note:** Any changes made to allocations on the chart do not need to be saved before switching to the grid. You can switch between the chart and grid without losing any information.

**Customer, Resource, and Project Popup Details**

When you hold your cursor over a resource, customer, or project on the chart or grid, a tooltip pops up to display additional information. The following popup details are available:

- **Project and Project Template Details**
- **Employee Details**
- **Vendor Details**
- **Customer Details**
- **Generic Resource Details**
Project and Project Template Details

The Project Details popup provides information about the overall progress of a project. It shows the estimates, the actual work done, and the remaining work for the project. The allocated work displays the total hours allocated for the project. If there are changes to the project that affects the allocated work, an icon appears next to the total hours. This icon indicates that the currently displayed hours may no longer be accurate due to a recent change. The icon will disappear, and the total hours will be updated, when you save your changes.

The Project Template Details popup shows the start date, estimated work for the project, and a link to the project template record.
**Employee Details**

The employee details popup provides information about the employee's labor cost, type, job, and skills and expertise. The labor cost displays the hourly overhead labor rate for the employee.

For new employees, the Job information will be available on the Employee details popup if the **Job Management** feature is enabled on your account. For more information, see the help topic **Job Management**.

The Skills and Expertise field displays a **View** link if the Resource Skill Sets SuiteApp is installed in your account. Clicking the link opens the Resource Skills record, where you can view the Skills & Expertise of the employee. For more information, see **Resource Skill Sets**.

**Note:** You can view the Resource Skills record if the **Project Resource** check box is enabled on your Employee record.

---

**Vendor Details**

The vendor details popup provides information about the vendor's 1099 eligibility and labor cost. The labor cost displays the hourly overhead labor cost rate for the vendor.
Customer Details

The customer details popup shows information on the customer's ID, name, category, subsidiary, primary contact, and address. Click the View link to open the customer record.

Generic Resource Details

The generic resource details popup shows the generic resource name, labor cost, price, and a link to view the generic resource record.

Resource Skill Sets

Resource Skills Sets is a SuiteApp designed to work in tandem with Resource Allocations and the Resource Allocation Chart. It enables you to add information to employee and vendor records about skills and expertise and then search that information for the best matched project resource.

When installed, you must first define skill categories for your company and update employee and vendor records with applicable skills and expertise levels. For more information on installation of the SuiteApp, see Resource Skill Sets.

Setting Up Resource Skill Sets

If you also use Resource Allocations, you must first set the Resource Saved Search as the default search for the Resource Manager role.

To define the default search for the Resource Manager role:

1. Go to Lists > Search > Saved Searches.
2. Click **Edit** next to Resource Search.

3. In the **Search Title** field, enter **Project Resource Search**.

4. On the **Roles** tab, find the Resource Manager role and check all the boxes in that row.

5. Click **Save As**.

Now, your resource managers use the Project Resource saved search by default when searching within NetSuite. Next, you must create your skill categories.

**To create a skill category:**

1. Go to Setup > Services > Skill Category > New.

2. Enter a name for this skill category.

   For example, you could create a category named Software to record employees' skill levels with the types of software your company uses.

3. On the **Skill** tab, enter the names of each skill you want included in this category. Click **Add** after each skill.

4. On the **Skill Level** tab, there are three default skill levels provided. You can edit the existing levels by selecting the line you want to edit, making your changes and clicking **Done**. Add new levels by inserting a line or adding a new line to the bottom of the list. Skill levels should appear in this list from lowest to highest proficiency.

   The level you enter here are available for each skill entered on the **Skill** tab.

5. When you have finished, click **Save**.

Each skill category is available as a subtab on the Skills & Expertise tab of the employee or vendor record.

---

**Note:** Any user without access to custom record entries will not have access to skill, skill level, and skill set records in NetSuite or through SuiteScript. Employees will be able to set and update their skills through the My Skill Set page in the Employee Center.

**Important:** Any user can access the My Skill Set page in the Employee Center if they are marked as a project resource. For more information, see **Identifying an Employee as a Project Resource**.

---

**To add skills to an employee or vendor record:**

1. Go to Lists > Employees > Employees for an employee record or Lists > Relationships > Vendors to update a vendor record.

2. Click **Edit** next to the record you want to update.

3. Click **Skills & Expertise**.

4. Enter the number of years of experience for this resource.

5. On the subtabs, select skills for each skill category and set the skill level. Click **Add** after each added skill.

6. On the **Portfolio** subtab, you can enter social media information and upload a recent resume or work samples.
Important: The Portfolio subtab uses the NetSuite File Cabinet to store attachments. Administrators have permission to the File Cabinet by default. You must edit the permissions for any additional roles you want to access the documents on the Portfolio subtab to include access to the File Cabinet. For information on permissions, see the help topic Set Permissions.

Note: When adding a portfolio item, you must choose a type of portfolio item—work samples, resume, or other. New is an available option, however, creating a new type is not currently supported. Selecting New and attempting to create a new portfolio type will result in an error.

7. When you have finished, click Save.

After you have updated your employee and vendor records with skill sets and set the default search form, your resource managers can search for project resources based on the skills required on their projects.

Note: The Project Resource box on employee and vendor records must be checked for the record to appear in a skill category search. For more information, see Identifying an Employee as a Project Resource.

You can choose to add Skills & Expertise information only to those employees and vendors marked as project resources.

To update skills for project resources:

1. While logged in as an administrator go to Lists > Relationships > Resources. Resource managers can go to Cases > Other Lists > Resources.
2. Click Edit next to the project resource you want to update.
3. On the subtabs, select skills for each skill category and set the skill level. Click Add after each added skill.
4. On the Portfolio subtab, you can enter social media information and upload a recent resume or work samples.
5. When you have finished, click Save.

The resources list offers the ability to update skills without having full permission to edit vendor and employee records. Employees with other roles have the ability to update their own skill sets using My Skill Set. Depending on the role, My Skill Set usually appears with other entity lists.

Data Retention

In the event that you need to uninstall the Resource Skill Set SuiteApp for any reason, backup data is created and stored in the File Cabinet. This lets you import your skill sets, skill levels, skill categories, and skills without requiring you to repeat the set up process when reinstalling the SuiteApp.

Backup data can be accessed and downloaded at File Cabinet > Resource Skill Sets > Data Backup.

Using Resource Skill Sets

After you have defined your skill categories and added skills and expertise to your project resources, you can begin using targeted searches for project resources. If you use Resource Allocations, you can search for resources with a specified skill set directly from the Resource Allocation Chart.
To search project resources based on skill categories using the resource allocation chart:


2. Click New Allocation.

3. Click the Search icon next to the Resource field.

4. In the Availability section, select a date range and % Available required for this allocation. Percent availability is calculated as Unallocated Working Hours / Total Working Hours.

5. In the Other section, enter additional required criteria, such as billing class, labor cost, and years of experience.

   **Note:** Make sure that the Per-Employee Billing Rates feature is enabled in your NetSuite account. For more information, see Resource Skill Sets.

6. Under Available Skills, select the desired skill and click the arrow to move the skills to the Required Skills box.

7. When you have finished, click Submit.

A list of project resources that best fit the selected criteria is shown. You can use this list to decide which resource best fits your needs for this allocation.
The displayed search results list several pieces of information on each resource that can help resource managers select the most qualified candidate, including labor cost, SkillSet Score, and specific skill levels.

**SkillSet Scores**

SkillSet Scores are only displayed in the search results when searching for resources through the Resource Allocation chart.

- **Resource 1** has a SkillSet score of 33% because:
  - Basic Level = 1
  - Highest Possible Skill Level = Expert = 3
  - \( \frac{1}{3} \times 100 = 33\% \)

- **Resource 2** has a SkillSet score of 67% because:
  - Intermediate Level = 2
  - Highest Possible Skill Level = Expert = 3
  - \( \frac{2}{3} \times 100 = 67\% \)

When searching for multiple skills, the skill levels are added together and divided by the highest possible skill level for the group.

- **For example**, you are looking for a resource with proficiency in a combination of Skills A, B, and C.
  - **Resource 1** has a skill level of basic in A and B, and intermediate in C.
  - **Resource 2** has a skill level of expert in A, intermediate in B, and basic in C.
Resource Skill Sets

Resource 1 has a SkillSet score of 44% because:
Skill Level = basic + basic + intermediate = 1+1+2 = 4
Highest Possible Skill Level = Expert for each skill = 3 * 3 = 9
4/9 * 100 = 44%

Resource 2 has a SkillSet score of 67% because:
Skill Level = expert + intermediate + basic = 3+2+1 = 6
Highest Possible Skill Level = Expert for each skill = 3 * 3 = 9
6/9 * 100 = 67%

The higher the SkillSet score the more closely matched the resource is to the required skills. The more skills are added to a search the more difficult it is to match a resource with a high SkillSet score.

Resource Allocations Custom Approval Workflow

After you have enabled Resource Allocations, you can install the Resource Allocations Custom Approval Workflow SuiteApp. This SuiteApp can be installed directly from Setup > Company > Enable Features by clicking the SuiteApp name in the Related SuiteApps section under Resource Management.

**Important:** Approval Routing and SuiteFlow are also required to use the Resource Allocations Custom Approval Workflow SuiteApp. For more information on Approval Routing, see the help topic Approval Routing. For more information on SuiteFlow, see the help topic SuiteFlow Overview.

**Note:** The Resource Allocations Custom Approval Workflow is a shared bundle. Please contact your account manager for provisioning of this bundle.

This SuiteApp enables you to implement resource allocation approvals through NetSuite's SuiteFlow feature without building a workflow from scratch. The SuiteApp installs a default approval routing workflow that you can use as is, or copy and customize to suit your company's specific needs.

Before you can begin using this SuiteApp, you must turn on approval routing for resource allocations. Go to Setup > Accounting > Accounting Preferences > Approval Routing and check the Resource Allocations box. Approval routing for Resource Allocations is now available in your account.

**Important:** When Approval Routing for resource allocations is enabled, only administrators can edit unapproved resource allocations.

After the SuiteApp is installed and enabled, the workflow adds Approval Status and Next Approver fields to the resource allocation record. When an employee enters a resource allocation, the status is automatically set to Pending Approval, and the Next Approver field defaults to supervisor defined on the employee record. If a supervisor is not defined, the Next Approver field is required before submitting the resource allocation record.

When a resource allocation is submitted, the next approver receives an email notification that there are pending resource allocations for approval. The message contains a link directly to the record where it can be approved or rejected. Resource allocations can also be approved from the individual records or bulk approved.

**To bulk approve or reject resource allocations:**

1. Go to Activities > Scheduling > Resource Allocations > Approve.
2. In the **Action** field, select **Approve** or **Reject**. The list of pending resource allocations will refresh.

3. Check the box in the **Select** column to select each resource allocation you want to approve or reject. You can also click **Mark All** to select all listed resource allocations.

4. Click **Submit**.

After a resource allocation has been approved or rejected an email is sent to the original requester with an updated status.

## Project Resource Management

The Project Resource Management SuiteApp offers visual management of your project task assignments and resource allocations. You can edit existing tasks and allocations, and create new task assignments and allocations directly from the grid.

**Important:** Project Resource Management is a shared SuiteApp. Your account must be given access to the SuiteApp prior to installation. Contact your account manager for more information.

## Prerequisites

Before you install the Project Resource Management SuiteApp, make sure that the following features are enabled in your NetSuite account:

- Project Management and Resource Allocations features. For more information, see [Enabling Project Features](#).
- Per-Employee Billing Rates feature. For more information, see the help topic [Using Billing Classes](#).
- Time Tracking feature. For more information, see the help topic [Managing Time Tracking](#).

## Installation

To install Project Resource Management, go to Customization > SuiteBundler > Search & Install Bundles. Use the following information to search for the SuiteApp:

- **Name** – **Project Resource Management**
- **Bundle ID** – 164289
- **Account ID** - 4679177

Project Resource Management is a managed SuiteApp and is automatically updated whenever there are changes. These issue fixes and enhancements are available after the SuiteApp is updated in your account.

When installed, administrator and full access roles can access the SuiteApp by default. Other roles need additional permissions to access the SuiteApp. The table below outlines the permissions required for accessing Project Resource Management. For information about customizing roles, see the help topic [Customizing or Creating NetSuite Roles](#).

<table>
<thead>
<tr>
<th>Permission</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists &gt; Projects</td>
<td>View</td>
</tr>
</tbody>
</table>

Projects
After you have customized a role to access Project Resource Management, an administrator must also add these new role to the script deployment in order for the SuiteApp to launch when using the new role.

To add access for a custom role:

1. Go to Customization > Scripting > Script Deployments.
2. Click **Edit** next to customdeploy_prm_sl_main.
3. On the **Audience** subtab, in the **Roles** field, select the roles you want to have access to Project Resource Management.
   
   You can select multiple roles by holding down the Ctrl button while selecting each role.
4. When you have finished, click **Save**.

When logged in as administrator, you can view Project Resource Management at Lists > Custom > Project Resource Management. When logged in with other roles, the chart is located in the following places:

<table>
<thead>
<tr>
<th>Center</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting</td>
<td>Vendors &gt; Other &gt; Project Resource Management</td>
</tr>
<tr>
<td>Executive</td>
<td>Expenses &gt; Other &gt; Project Resource Management</td>
</tr>
<tr>
<td>Support</td>
<td>Cases &gt; Other Lists &gt; Project Resource Management</td>
</tr>
</tbody>
</table>
Setting Up Project Resource Management

The grid is organized first by project and then task and resource. It displays the estimated hours and percent complete for each project and task. For each resource, the grid displays the allocated hours and percentage as well as the assigned hours and the number of hours worked. The Hours Allocated, Hours Assigned, and Hours Worked columns roll up to display the totals for each project listed. For more information, see Project Resource Management Grid Columns.

You can choose to display the grid in a daily, weekly, or monthly format by clicking the links at the top of the grid. You can also customize and save a view to filter the grid by start date, resource type, resource, customer, project, and task.

Before you begin using the grid, you can adjust the grid's appearance and available filters.

**To adjust project resource manager settings:**

1. Click the Settings icon at the top of the project resource management grid.
2. Check **Include All Projects** to include all your available projects on the chart.
   If not checked, the grid displays only projects that do not have allocations and assignments.

3. If you also use Approval Routing for resource allocations, check the **Show rejected allocations** box to add values of rejected allocations to the grid. Rejected allocations are displayed on the grid in red font.

   **Note:** If a project has only one resource and that resource has no task assignment, the resource will no longer be displayed on the grid even if that resource's allocation has been rejected.

4. Check **Show Details on Hover** to show details when you use your mouse to hover over a project, resource, or task assignment cell.

5. Check **Show Resource Allocations** to show resources allocated to the project.
   When checked, resources allocated to a project are listed in the resource summary under the project, and the Percent Allocated, Hours Allocated and Hours Worked columns become available on the grid.

6. Check **Show Task Assignments** to show task assignments identified for the project.
   When checked, task assignments are listed right below the resource summary, and the Hours Assigned and Hours Worked columns become available on the grid.

   - Dense — Displays a maximum of 15 projects per page.
   - Standard — Displays a maximum of 10 projects per page.
   - Relaxed — Displays a maximum of 5 projects per page.

8. When you have finished, click **Save**.

   **Note:** Valid settings require that either **Show Resource Allocations** or **Show Task Assignments** or both are checked.

After you have updated your settings, you can begin using the grid to work with your projects.

At the top of the page, you can select a view to choose what projects appear in your grid. All active projects are displayed on the grid in the Default view. You can also create customized views to filter the results displayed in the grid and share views with other users.

**To customize a project resource manager grid view:**

1. Click **Customize View** next to the **View** field.
2. In the **Custom Form** field, select the form you want to use to create this view.

**Note:** The screenshot in Step 1 above shows the PRM View form.

3. In the **Name** field, enter a name for your new view.

4. Check the **Share View** box to allow other users to use this view when using the project resource management grid. Only the view's creator can edit or delete a view.

5. Under **Start Date**, select which record you want to use for the start date on this view, then select a start date to begin this new view.

6. Under **Resources**, select the type of resources you want to see in this view. You can choose to show employees, vendors, and generic resources. Check the box corresponding to the resource type to include all active resources of each type. If you want to include only specific resources, select the names in the respective list boxes.

7. Under **Resource Properties**, you can also filter resources by billing class or subsidiary. Check the box to include sub-subsidiaries.

8. Under **Project Properties**, you can further filter projects by customer, project, or task.

9. When you have finished, click **Save**.
Your new view is now available in the View field at the top of the page.

After you have created custom views, you can click Edit View to make changes to the view you are currently using.

**Note:** Each time you view the project resource management grid, the filter you selected the previous time is selected by default.

You can also use the buttons at the top of the grid to adjust the time frame that is currently displayed. Click Daily, Weekly, or Monthly to adjust how the information is displayed and then use the arrows to move the timeline forward and backward. You can view total allocations for each time segment by clicking the pop-up icon in the date column header.

Additionally, you can switch between pages using the page selector in the upper right section of the chart. The total number of projects is displayed right next to the page selector. Click the information icon for additional details about the grid format.
Using Project Resource Management

The Project Resource Management grid is organized by project and then by task and resource. You can search the current view for a specific project by using the Search Project field at the top of the Project/Task/Resource column. Enter the name or part of the name in the Search Project field and click the search icon to filter the grid for that project.

Additionally, you can do the following in the grid:

- Expand and collapse the resource summary and tasks for each project, and task assignments for each task by clicking the box next to the project or task name, respectively.
- Modify resource allocations and task assignments. For more information, see Using Action Menus and Adjusting Allocations and Assignments.
- Use your mouse to hover over a project, resource, or task assignment cell to see details, if you have the Show Details on Hover checked in your settings.

![Note: Hover details are not available in overlapping allocations. Resources with overlapping allocations are displayed on the grid in blue and are underlined.](image)

You can also create new allocations and assignments by clicking the New Resource Allocation or New Task Assignment button at the top of the grid. For more information, see Entering New Allocations and Assignments.

Project Resource Management Grid Columns

The project resource management grid organizes resource allocations and task assignments according to the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Menu</td>
<td>The action menu column, indicated by a green icon, provides actions you can select to adjust the information displayed on the grid or modify project, task, and resource details. For more information, see Using Action Menus.</td>
</tr>
<tr>
<td>Project/Task/Resource</td>
<td>Lists projects, tasks, and resources depending on your settings.</td>
</tr>
<tr>
<td>Hours Estimated</td>
<td>Lists the equivalent of each project’s Estimated Work.</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>Lists the equivalent of each project’s Percent Work Complete.</td>
</tr>
<tr>
<td>Percent Allocated</td>
<td>Lists the percentage of time a resource is allocated to a project.</td>
</tr>
<tr>
<td>Hours Allocated</td>
<td>Lists the equivalent of each resource’s allocated hours and each project task’s Estimated Work.</td>
</tr>
<tr>
<td>Hours Assigned</td>
<td>Lists the equivalent of each resource’s Estimated Work for each task. The values automatically roll up to the project level. You can modify assigned hours for any task in the grid provided there is no actual work entered against it. For more information, see Adjusting Allocations and Assignments.</td>
</tr>
</tbody>
</table>
Project Resource Management

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Important:</strong> When viewed in the Daily time frame, a project task's total Hours Assigned includes only the Estimated Work of all resources assigned to it for the day. When viewed in the Weekly or Monthly time frame, each total includes the Estimated Work of all assigned resources and the Actual Work entered against the task for the period by any allocated resource unassigned to the task. If the Allow Allocated Resources to Enter Time to All Tasks preference is enabled for a project, the Hours Assigned column lists assigned resources' Estimated Work and time entered by allocated resources unassigned to the task in any time frame.</td>
</tr>
<tr>
<td>Hours Worked</td>
<td>Lists the equivalent of each resource's Actual Work for each task. The values automatically roll up to the project level. For more information, see Adjusting Allocations and Assignments.</td>
</tr>
</tbody>
</table>

For more information on project records, see Working with Project Records.

**Using Action Menus**

The action menu column, in the far left pane of the project resource management grid, contains a dropdown list of actions in each project/task/resource level.

- **Header level** — Click the green icon at the top of the column and select Add Project to add a project or project template to the grid. Only projects and project templates that do not have any resource allocations and task assignments can be added. If Include All Projects is selected in your settings, the Add Project action is disabled.

- **Project level** — Click the green icon next to a project name to add a resource to the project, remove allocations from the project, or remove resource allocations and task assignments.
  - Add Resource Allocation — Select this action to add resource allocations using the Resource Allocation form. For more information, see Entering New Allocations and Assignments.
  - Remove Allocations — Resource allocations may be removed from a project provided that none of the resources has any task assignments. Additionally, a project will also be removed from the grid when its resources are removed and it has no task assignments.
  - Remove Resource Allocations and Task Assignments — Select this action to delete all allocations and task assignments from the project. This action is not available when at least one project task assignment has worked hours entered against it.

- **Resource summary level** — Click the green icon next to a resource name to assign the resource to a task, edit the resource, or remove resource allocations from the project.
  - Assign Resource to Task — Assign the resource to a task using the Task Assignment form. For more information, see Entering New Allocations and Assignments. This action is not available when the project does not have any task.
  - Edit Resource — This action reallocates all allocation records of the resource to another. If the Display All Resources for Project Task Assignment preference is not enabled on the project record, this action is disabled for a resource who is already assigned to a project task.
  - Remove Resource Allocations — This action removes all allocations of the resource from the project. If the resource has no allocations, this action is not available. If the Display All Resources for Project Task Assignment preference is not enabled on the project record, and the resource has both allocations and task assignments, this action is also not available.
  
  If the Display All Resources for Project Task Assignment preference is enabled and you remove a resource's allocations, the allocation records are deleted but the resource remains on the grid if that resource has task assignments.
For more information, see Adjusting Allocations and Assignments.

Note: The action menu is not available in overlapping allocations. Resources with overlapping allocations are displayed on the grid in blue and are underlined.

- **Project task level** — Click the green icon next to a task to assign a resource to it, re-assign resources, or remove task assignments.
  - **Assign Resource** — If the Display All Resources for Project Task Assignment preference is not enabled on the project record, only resources allocated to the project are available to be assigned to project tasks.
  - **Re-assign Resources** — You can reassign all task assignments to a new task regardless of project task constraints, provided that none of the task assignments has worked hours entered against it.
  - **Remove Task Assignments** — You can remove a project task and its task assignments provided that neither project task nor any task assignment has worked hours. Project task assignments removed through this action are deleted from NetSuite and project tasks are converted into project milestones. If a project only has the project task you removed, and it has no resource allocations, the project is removed from the grid.

  For more information, see Adjusting Allocations and Assignments.

- **Task assignment level** — Click the green icon next to a task assignment to edit or remove task assignments.
  - **Edit Task Assignment** — If the Display All Resources for Project Task Assignment preference is not enabled on the project record, only resources allocated to the project and generic resources are available to be assigned to project tasks. Otherwise, all project resources, whether allocated to the project or not, can be assigned. A task assignment cannot be edited when it has worked hours.
  - **Remove Task Assignment** — Take note of the following results when you select this action:
    - The resource is removed from the project task.
    - The project task is also removed when no other assignments remain.
    - The resource is removed from the resource summary if the resource has no allocations and remaining task assignments.
    - The project is also removed from the grid when it has no other resource allocations and project tasks.
    - Hours Estimated values in the project task and project levels are updated.

    If the task assignment you want to remove has worked hours entered against it, the action is not available.

    For more information, see Adjusting Allocations and Assignments.

### Adjusting Allocations and Assignments

The project resource management grid lets you see a total picture of your resource allocations and task assignments, and to adjust them so you are using resources effectively.

You can modify resource allocations and task assignments for your projects directly in the grid using the action menus in the leftmost column. For more information, see Using Action Menus. Any change you make from the grid is saved in corresponding records in NetSuite. Similarly, any change you make in a project, resource, allocation, task, or task assignment record is reflected in the project resource management grid.
Not all of the cells in the grid can be edited. Click the information icon in the upper right corner of the chart for the display legend.

In the grid, you can adjust values in the following cells:

- **Hours Allocated** — Left-click on the Hours Allocated cell of a resource to enter the resource’s allocated hours to the project. Press the Enter key to save the value. If the resource already has allocated hours and you want to edit the value, right-click on the cell and select Edit Allocation. Enter and save the new value using the Resource Allocation form.

- **Hours Assigned** — Left-click on the Hours Assigned cell of a resource to adjust the resource’s assigned hours to the task. Press the Enter key to save your changes. If you want to edit the task assignment, right-click on the cell, select Edit Project Task Assignment, and enter and save new values in the Task Assignment form.

- **Hours Estimated** — Right-click on the Hours Estimated cell of a task assignment, select Edit Project Task Assignment, and enter changes in the Task Assignment form. For more information, see Entering New Allocations and Assignments.

**Important:** Any change you make to assigned hours to tasks roll up to the project task and project’s estimated work, and duration of project tasks may be affected.

To create new resource allocations and task assignments, see Entering New Allocations and Assignments.

### Entering New Allocations and Assignments

For more information, see Creating a Resource Allocation Record and Assigning Resources to Project Tasks.

**To enter a new allocation with project resource management:**

1. Click **New Resource Allocation** at the top of the grid.
2. If you customized a resource allocation form, select it in the Custom Form field.

3. In the Resource field, select a resource for this allocation.

   To search for a resource, hover your mouse to the right of the field and click the Resource Search icon. Enter or select values in the search filters and click Search.

4. Select the project to which you want to allocate this resource.

   **Important:** For each project, it is recommended that you choose to either allocate resources directly to project tasks or allocate resources to the project and then assign to project tasks. Using both resource allocations to project tasks and task assignments can create inconsistencies in your project data. For more information, see Assigning Resources with Allocations.

   **Important:** Creating new allocations with project task assignment is not currently supported in Project Resource Management. If you are creating this allocation to assign tasks for the project, enter a new task assignment after creating this allocation.

5. In the Notes field, enter any additional information about this allocation.

6. Select a start date and end date.

   **Note:** Resource allocations can begin and end on non-working days if at least one working day is included in the duration of the allocation.

7. In the Allocate field, enter the number of hours you want to allocate.

8. In the Allocation Type field, select the type of allocation.

   - **Hard** – This allocation request is not flexible; the resource is committed to the dates and hours required on this request.
   - **Soft** – This allocation request is flexible; adjustments can be made to the date and hours if needed to accommodate other priorities.

   **Note:** The allocation type pertains to project scheduling and staffing methodology and not an indication of the allocation record being unavailable for editing. Records with a hard allocation type can be edited. It is a recommended best practice to use the allocation types as suggested above when creating resource allocations in NetSuite.

9. In the Communication subtab, attach documents in the file cabinet or click the User Notes to add any notes related to this allocation.

10. In the Recurrence subtab, choose the recurrence for this allocation.

11. When you have finished, click Save.

To edit resource allocations from the project resource management grid, see Adjusting Allocations and Assignments.

To enter a new task assignment with project resource management:

1. Click New Task Assignment at the top of the grid.
2. In the **Project** field, select the project for this assignment.

3. In the **Project Task** field, select a task for this new assignment.

4. In the **Resource** field, select a resource for this assignment.
   
   To search for a resource, hover your mouse to the right of the field and click the Resource Search icon. Enter or select values in the search filters and click Search.

5. In the **Unit Percent** field, enter the percentage of available work time this resource will commit to this task.

6. Select a billing class for this resource to apply to this project task. For more information about billing classes, read [Project Billing Rates](#).

7. In the **Unit Cost** field, enter the cost for this resource to work on this task.

8. Enter the amount of work time you expect this resource to spend on this task.
   
   The estimated work for the task must be specified in hours. Similarly, service items to be used on the project task must be priced in hours.

9. In the **Unit Cost** field, enter the cost for this resource to work on this task.

10. Select a service item for this resource's work on this task.
    
    Only non-fulfillable or receivable service items can be selected on project tasks.

**Note:** When opened from the grid using **Assign Resource to Task**, the Task Assignment form opens with the Project and Resource fields populated. For more information, see [Using Action Menus](#).
Note: Adding a service item is optional. If you do not specify a service item, unit price, or assign a resource for a task on a Time and Materials project, then NetSuite displays a warning when you refresh the Schedule subtab of the project record. For Time and Materials projects, a task must have an assignee and a unit price to be billed on the sales order.

11. When you have finished, click Save.

To edit task assignments from the project resource management grid, see Adjusting and Reassigning Tasks.

Printing

To print the currently displayed page of the grid, click the printer icon in the upper right corner of the grid to open your browser printing dialog.
Managing Time and Expenses for Project Resources

In order to estimate costs accurately for projects, you need to be able to accurately capture resource time entries for utilization and productivity on projects and assess how that time figures into each project.

First, the sections below describe what utilization and productivity are, in relation to project management. Next, you can read how to customize the input of this data using Classifying Time for Projects.

Productivity

Productive time is time spent working on a project, but is not time spent toward completing a specific project task, such as time spent in training or in transit. Such factors can adjust costs because resources are not actually working their full assigned time.

You can adjust for productive time by having time classified as productive when resources make a time entry against a project. Then, run the Utilization by Resource Reports to assess time spent on projects.

Utilization

Utilized time is time spent actually working toward completing a specific project task. Utilization factors affect the cost or duration of a task depending on the resource used. When managing projects, you need to consider resource utilization factors and their affects on tasks.

For example, when choosing which resource to assign, you should consider the experience or skill of each resource. A resource with more experience or skill than another may complete a task in less time or with fewer mistakes. This means a shorter task duration.

However, these resources usually also have higher hourly costs as well, so the project cost could increase as well.

For example, you need a resource to complete a project task and you can assign either Joe or Billy. Joe has many years experience and completed this task many times before. He is likely to complete it quickly and make few mistakes, but his salary costs are high. Billy is new and his salary costs are much lower, but he does not have much experience at this task. He will take longer to complete it and likely make more mistakes than Joe.

In light of such considerations, you may need to adjust schedules to adjust the cost based on who is going to do the work.

The Target Utilization field allows you to set how much of resources Total Hours can be described as actual work time. For example, if a target utilization of 85% is entered on a project resource employee record, NetSuite determines the available hours by multiplying the Total Hours on the employee’s defined work calendar by 0.85. Thus 85% of the resources time should be devoted to actual working (and should be entered to Timesheets), and the remaining 15% includes breaks, filling in timesheets and other work not connected to project. The Total Hours column reports the total number of hours from the defined work calendar. The Available Hours reports the specific number of hours which has to be tracked to get 100% utilization.

Time subtab on Tasks

The Time subtab on task records shows Planned Time and contributes to a real-time picture of project schedule.
If resources complete the project task early, it pulls in the projected end date of the project.
If resources cannot complete tasks as quickly as anticipated, the end date is pushed out accordingly.

Classifying Time for Projects

You can set up how time entries are classified by default when resources enter time against projects they work on. This determines how project time is entered and used in calculations for project utilization and productivity.

Time that resources enter against a project can be classified as utilized time, productive time, and/or exempt. This helps you accurately calculate utilization and productivity for resources on projects.

For more information about utilization and productivity, read Managing Time and Expenses for Project Resources.

The classification of time as utilized, productive, or exempt is sourced from the setting on the project record.

**Note:** Time that is entered against a customer without a project is set as utilized and productive but not exempt, by default. Time entered without a customer is not utilized, not productive, and not exempt.

To give you flexibility to manage projects, you can control the settings for how resource utilization is calculated for both the numerator and denominator.

**To classify time entered on project records:**

2. Click **Edit** next to a project in the list to open the record.
3. Click the **Preferences** subtab.
4. Check or clear the following boxes to set these defaults:
   - **Classify Time as Utilized**
     When this box is checked, time entered on this project is marked as Utilized time by default.
   - **Classify Time as Productive**
     When this box is checked, time entered on this project is marked as Productive time by default.
   - **Classify Time as Exempt**
     When this box is checked, time entered on this project is marked as Exempt time by default.

   Any time that should not be included in the denominator of utilization calculations should be identified as exempt.

5. Click **Save.**
When you save these time settings for each project, they are used for all time entries associated with the project.

The following are available time classification data that are displayed in the Utilization by Resource Reports.

- **Exempt hours**
  
  Time that should not be considered for utilization calculations in either the numerator or the denominator. Time included in this category generally includes vacations and holidays.

  
  There are many variations of ways companies determine what should be included in the Net Time that constitutes the denominator. Exempt time can provide flexibility in this area. Any time that should not be included in the denominator can technically be marked exempt in the time entry.

- **Net hours**
  
  Time that can be utilized for productive activities.

  Calculated as: \([\text{Available time} - \text{Exempt time}]\)

- **Utilized hours**
  
  Time that is directly tied to revenue generation for a project. Examples are billable time or non-billable time on a fixed bid project.

- **Utilization**
  
  The percentage of utilization for project resources.

  Calculated as: \(\frac{\text{Utilized time}}{\text{Net Time}}\)

- **Productive hours**
  
  Time that is not directly tied to generating revenue, but is important for the project. Examples are time investments for training, pre-sales support, and non-billable support roles.

- **Productivity**
  
  The percentage of productivity for project resources.

  Calculated as: \(\frac{\text{Productive time}}{\text{Net Time}}\)

### Customize Time Forms and Customer Records to Classify Time

You can also customize time entry forms to show classification check boxes and then classify each time entry individually. For more information on customizing time entry forms, see the help topic Creating Custom Entry and Transaction Forms.

In order to see how individual time entries are classified on a project, you can customize the list view on the Schedule subtab of the Project record or the Time Tracking subtab of the Project Task record. You can add both the Utilized and Productive columns to either of these lists to view the time classification of individual tasks. For more information, see the help topic Customizing List Views.

### Assess Time Reports

After resources have worked on projects and entered time against them, those time entries classify productive and utilized time according to the settings you have indicated. Then, utilized or productive
time entered against a project is used in calculations that appear in the Utilization by Resource Reports. Run these report to make time and expense management assessments about your projects.

**Entering Time Against Projects**

After you create a project record, using NetSuite's time tracking capabilities, you can enter time against the project directly from the project record. You can estimate time budgeted for a task and then track progress being made on the project and the percentage of completion as time is entered.

Entering time against a project also lets you calculate resource productivity and utilization. For more information, read Managing Time and Expenses for Project Resources.

Recording project time affects:

- **Scheduling:** When you enter time for yourself or your employees, NetSuite compares the estimated time to complete each task with the actual time recorded in Time Tracking. It modifies the project schedule as needed based on the task constraint and predecessor attributes.
  
  For example, the estimated time to complete Task A is 4 days. Task A must be finished before Task B can begin. It takes you five days to complete Task A. When you record five days of work against Task A in Time Tracking, NetSuite advances the start and end dates of Task B, and all tasks that depend on Task B, by one day.
  
  The Gantt chart updates to show the actual time worked and the new task start and end dates.

- **Billing:** For Time and Materials projects, time must be entered, marked billable, and approved to be billed. Recording time worked on a project affects the amount billed because invoices reflect only billable time performed. Time entry does not affect the timing of billing because invoices are generated at specified intervals. Changes in the amount of time it takes to complete tasks may affect the number of invoices that get generated for a project. For example, tasks that take longer than planned to complete may extend into an additional billing period and trigger an additional project billing cycle for the project.
  
  For Fixed Bid, Interval projects, recording time worked on a project does not affect the timing of billing but does affect the amount billed. Bills are generated at specified intervals based on the expected percentage of work completed for each interval. Resources must account for all planned time in each billing interval to ensure that invoices are generated for worked performed rather than for work planned. As with time and materials projects, the number of billing cycles may also increase or decrease based on project progress.
  
  For Fixed Bid, Milestone projects, billing depends on completing a set of tasks. If the task completion dates change, then the time when invoices can be created and sent to customers also changes.

- **Reporting:** Project time and utilization report information is based on the time classification attributes selected on the Info subtab for the project. For more information about productivity and utilization, see Project Resource Time and Expense Management and Project Management Reports.
  
  Planned time entries are available in both search and reporting and can be used to report on expected future work.

- **Project Management:** Each project task record displays the estimated, actual, and remaining work needed to complete the task which enables you to manage the project from within the project record. You can access Time Tracking directly from each task to record project hours.

**Entering Time for a Project**

Time can be tracked against a project directly from the project record or by selecting the project in the Customer:Project field on time transactions. NetSuite recommends that time primarily should be tracked
from the Employee Center role or a role with similar time restricted permissions. Implementing this best practice maintains approval and status preferences. CRM tasks associated with a project are also available for time entry. Select a CRM task from the Case/Task/Event dropdown list.

**Important:** If you selected Approve Automatically on the project’s preferences subtab, time should only be entered through the Employee Center role. When using any role with additional time tracking permissions, you must manually set the Approval Status field on individual time transactions or submit a weekly timesheet for time to be approved. For more information, see Setting Up Project Record Preferences and Approving Time and Expenses for Projects.

**To enter time against a project from the project record:**

2. Click **Edit** next to a project in the list to open the record.
3. Click the **Resources** subtab.
4. Click the **Time Tracking** subtab.
5. On the **Time Tracking** subtab, you can choose to enter time against the project in one of two formats:
   - Single Entry Format – Enter a single instance of time a resource worked on a project. Click **New Time** to open a single entry format time entry form.
   - Weekly Entry Format – Enter the time resources worked on projects a week at a time. Click **New Weekly Time** to open a weekly format time entry form.
6. A window opens with the time entry form. The **Project** field is autofilled with the project name. In the **Case/Task/Event** field, select a project task.
   
   For more information on completing time entry forms, click one of the links below:
   - For details on the New Time form, read the help topic Entering a Time Transaction.
   - For details on the New Weekly Time form, read the help topic Weekly Time Tracking.
   - For details on the Timesheets form, read the help topic Timesheets.
7. When you have completed the form, click **Save**. The time data is updated on the project record.

You can also choose to enter time for a project by going to Transactions > Employees > Track Time or to Transactions > Employees > Weekly Time Sheet and selecting a project in the Customer:Project field.

**Entering Project Time Against a Case, Task, or Event**

If you track time in NetSuite, employees and other project resources can enter time against a project task, case, CRM task, or other activity by selecting an item in the Case/Task/Event field when entering time. This field is available only if you use Project Management. The items that appear in the dropdown list for this field vary depending on the features that you enable for your organization.

- If you enable both Project Management and Time Tracking for CRM, then the Case/Task/Event field shows only the uncompleted project tasks assigned to the employee or resource. The dropdown list also shows all activities and cases associated with the customer and project selected in the Customer:Project field, regardless of who the activities and cases are assigned to. In this configuration, a resource can enter time for only his or her project tasks, but can enter time against all CRM tasks associated with the customer and project.
  
  The Time Tracking subtab appears on case, task, and event records.
Entering Time Against Projects

Note: If any case, task, or event record has more than 9500 time entries to display on the Time Tracking subtab, all records display a static list of time entries. You cannot edit entries directly from the list.

- If you enable Project Management, but do not enable Time Tracking for CRM, then the Time Tracking subtab is not available on activity or cases records. Resources can still enter time against activities and cases. The Case/Task/Event field displays in time transactions and the dropdown lists the uncompleted project tasks assigned to the resource, plus all events, phone calls, and cases for the customer and project.
- If you do not enable Project Management, then the Case/Task/Event field does not appear.

The Case/Task/Event dropdown identifies the type of item in parentheses () after the item name. Items in the dropdown list are sorted by type and then name.

- Project task - (Project Task)
- CRM task - (Task)
- Other activities - (Phone call) (Event)

Note: Cases display only the case number and no case name, for example, Case #125.

Note: If you plan to enter a memo for the time transaction, always select an activity in the Case/Task/Event field before you enter the memo.

Deleting Project Time

You can delete time entered against a project if the time has not been approved by the project manager or resource supervisor.

To delete time entered for a task:

1. On the Schedule subtab for a project, click a task name.
2. On the Time Tracking subtab, click Edit next to the item you want to delete.
   Only unapproved time is available for editing.

   Note: If any case, task, or event record has more than 9500 time entries to display on the Time Tracking subtab, all tasks display a static list of time entries. You cannot edit entries directly from the list.

3. If you use Time Tracking, the time entry record opens. In the More Actions menu, click Delete.
   Close the window to return to the Schedule subtab.
   Note: NetSuite deletes only the selected time transaction if there are multiple time entries in the time record.
4. If you use Timesheets, the timesheet record opens. Find the entry you want to delete and remove it. Click Done to save the line. When you have finished, click Submit to submit the timesheet for approval or Save for Later to save the timesheet without submitting.

Restricting Time Entry on Project Tasks

You can choose to limit who can enter time transactions and how they enter them.
Restricting Time Entry on Project Tasks

Restrict time entry and expense entry on a project to only personnel associated with the project.

**To restrict time entry on project records:**

2. Click **Edit** next to the Project you want to restrict.
3. On the Project record, click the **Preferences** subtab.
4. Check the **Limit Time and Expenses to Resources** box to restrict time entry against this project. When you check this box, only assigned resources can enter time for this project's tasks. Also, only assigned resources can enter expenses for the project.
5. Click **Save**.

For information on how to assign resources to projects, see Assigning Project Resources.

**Role Restrictions**

You can choose to restrict time entry for a role. Then, you restrict personnel to enter time for only themselves or their subordinates using role management. NetSuite recommends that time primarily be tracked from the Employee Center role or a role with similar time restricted permissions. Implementing this best practice maintains approval and status preferences.

**Note:** Only Administrators can edit roles to restrict time entries.

**Restrict time entry for a role:**

1. Go to Setup > Users/Roles > Manage Roles.
2. Click **Customize** next to the role you want to restrict.
3. Enter a new name for the restricted role.
4. On the Role page, in the **Employee Restrictions** field, select **self and subordinates only**.
5. Click **Save**.
6. Repeat steps 2 through 5 for each role you want to restrict from being able to enter time for every employee.

You must update your employee records to assign the restricted roles. For more information, see the help topic Assigning Roles to an Employee.

For the roles that you customize, additional areas of NetSuite are restricted based on the selection you've made. For more information, see the help topic Set Employee Restrictions.

**Entering Project Expenses**

To enter employee expenses incurred while working on project tasks, complete an employee expense report and select the customer and project from the Customer list. For information on how to complete an expense report, see the help topic Entering an Expense Report.

You can enter project expenses, such as materials and supplies by selecting a customer and project when creating a purchase order or sales order. For instructions, see the help topics Entering a Purchase Order and Creating Sales Orders.

To allow only resources assigned to a project to enter expenses related to that project, check the Limit Time and Expenses to Resources box. See Restricting Time Entry on Project Tasks.
Approving Time and Expenses for Projects

Approve resource time and expense transactions recorded against a project to process payroll and bill customers for billable charges. When you use the Project Management and Time Tracking features, a project manager or designated time approver can approve time transactions entered against projects. The employee’s supervisor or expense approver can approve expenses.

**Note:** Project time approvers can only approve time for projects in which they are assigned a role with project time approval permissions.

For example, an employee is selected as the project manager for a project but not designated as the employee supervisor for any of the resources working on the project. When project resources report the time worked on the project, the employee can approve time transactions that require approval. The employee cannot approve any employee expense report items charged to the project.

Identify default approvers for employee time and expense reports on the Human Resources subtab on the employee record. If an approver is not designated, then the supervisor for the employee must approve any expense reports. Project time can be approved depending on how project time approval preferences are enabled. See the help topic Human Resources Information for an Employee.

Project time approvals are dependent on project resource roles. On the project resource role record, the Project Time Approver preference determines if project resources assigned the role can approve time. The Own Time Approval preference enables time entered using this role to be automatically approved. The Project Manager resource role has both preferences enabled by default.

**To add project time approval permissions to a project resource role:**

1. Go to Setup > Accounting > Project Resource Roles.
2. Click **Edit** next to the role you want to update.
3. Check the **Project Time Approver** box.
4. Check the **Own Time Approval** box to automatically approve any time tracked on projects by employees with this role assigned for that project. If you clear this box, any time entered toward a project by a resource with this role will need to be approved by the resource's manager or a project level approver.
5. Click **Save**.

**Note:** When you edit a project resource role to add project time approval permissions, you do not need to update project role assignments on your projects. Any employee with the edited role assigned now has project time approval permissions for the project in which they are assigned the edited role.

After you have enabled project time approval for your roles, you can also select who has approval privileges for each individual project.

**To set time approval preferences by project:**

2. Click **Edit** next to the project you want to update.
3. Click **Preferences**.
4. In the **Time Approval** field, select one of the following options:
   - Approve time automatically – Project time is approved automatically when entered from the Employee Center or a time restricted role.
Approving Time and Expenses for Projects

- Default Time Approver – Project time can be approved only by each employee's supervisor or time approver defined on the employee record.
- Project Time Approver – Project time can be approved only by project resources with project time approval permission defined on the project resource role.
- Project Time Approver or Default Time Approver – Both project time approvers and default time approvers can approve project time. This option is selected by default.

5. When you have finished, click Save.

<table>
<thead>
<tr>
<th>Selected Project Time Approval Preference</th>
<th>Approve and Receive Notifications</th>
<th>Approver for Roles with Approval Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>Approve time automatically</td>
<td>N/A</td>
<td>Automatically Approved</td>
</tr>
<tr>
<td>Default Time Approver</td>
<td>No</td>
<td>Default Time Approver</td>
</tr>
<tr>
<td>Project Time Approver</td>
<td>Yes</td>
<td>Automatically Approved</td>
</tr>
<tr>
<td>Project Time Approver or Default Time Approver</td>
<td>Yes</td>
<td>Automatically Approved</td>
</tr>
</tbody>
</table>

Important: The Time Approval preference does not override roles with full time permissions. Any role that has full time permissions and unrestricted employee permissions will be able to approve and reject time entries for any employee regardless of the selection made in this field. In addition, automatic approvals are not available for a role with full time permissions. Any time entered with a full time permissions role must update the Approval Status field on individual transactions or submit a weekly timesheet for time to be marked as approved. For more information about permissions, see the help topics Customizing or Creating NetSuite Roles and Set Employee Restrictions.

The default selection in the Time Approval field is Project Time Approver or Default Time Approver.

Since billable project time must be approved before you can bill your customers, review the Time Approval page on regular basis. Time reported in Time Tracking is used to calculate the actual time worked on project tasks whether it is approved or not.

Project Time Approval Permissions

When you use project-based time approval, the way time is approved for each resource depends on how you set up your approval preferences on both your project resource roles and each individual project.

Any project resource role that does not have the Project Time Approver box checked cannot approve any time transactions. See the table below for information on how approval permissions are affected based on your resource role and project preferences.

To approve time related to a project:

1. Go to Transactions > Employees > Approve Time.
2. Select an employee or All.
3. If you use Time Tracking, check the Approve box for time you want to approve. Click Submit.

For more information on time approval with Time Tracking, see the help topic Approving or Rejecting a Time Transaction.
To approve employee expense for a project:

1. Log into the Employee Center.
2. Go to Expense Reports > Approve Expense Reports.
3. Select the name of the employee who submitted the report.
4. Check the box next to the expense report you want to approve.
5. Click Save.

For more information about approving expense reports, see the help topic Approving an Expense Report.
Tracking and Managing Projects

- Project Dashboard
- The Project Center
- Viewing Project Schedules
- Working with the Project Schedule
- Tracking Project Baselines and Variance
- Setting a Project Baseline
- Planned Work
- Refreshing Project Items on Transactions
- Creating Sales Orders from Projects

Project Dashboard

Similar to your main NetSuite Home dashboard, you can access a project dashboard with information specific to an individual project.

The project dashboard offers portlets and quick links for creating project tasks, managing resources, viewing the Gantt chart, and entering time and expenses.

There are visual indicators to quickly give you an idea of the project's status. The % Complete Meter offers an at-a-glance look at where your project is along the timeline. Key Performance Indicators are available to show additional information about the health of your project.

You can also view a list of project tasks and resource allocations directly from the Project Dashboard. You can customize the dashboard with additional standard and custom portlets and rearrange how they appear by clicking Personalize Dashboard at the top of the page.

To view the project dashboard for a project, click the Dashboard icon at the top of the project record or in the Projects list.

Personalizing a Project Dashboard

NetSuite provides a default set of project dashboard portlets. This default dashboard configuration is largely personalizable. NetSuite lets you change your project dashboard content almost completely.

You can personalize a dashboard in the following ways:

Add content to a dashboard

- Click the Personalize Dashboard link in the top right corner of the page.
- On the Add Content panel that appears on the left side of the page, click on content to add it to a default location on the page, or drag and drop content to add it to another location.
  - Content that is already displayed includes a check mark and bold text.
  - You can roll your cursor over a folder or content listing to see popup help.
Delete content from a dashboard

- Select Remove from the menu in the upper right corner to remove the portlet.

(You cannot remove a portlet from a dashboard through any action on the Add Content panel; there is no mechanism within the panel for clearing a content listing.)

Set up portlet content

- After they appear on the project dashboard, most portlets have a Set Up link available under a dropdown arrow in the upper right corner. You can click this link to open a popup window, where you can choose data to display in the portlet and/or define portlet layout options.

Print or export portlet content

- The KPI Meter portlet has menu options for printing and exporting the content, under the same link as the Set Up option. It has options to print the chart, or download it to a PNG, JPG, PDF, or SVG file.
- Each popup trend graph includes a button for printing the chart, a button for downloading it to a PNG, JPG, PDF, or SVG file, and an Export to CSV link.

Minimize portlets on a dashboard

- To minimize a portlet, click on the title bar at the top of the portlet. Minimizing a portlet prevents it from loading when the page is generated, improving the speed at which the page loads. After the page is loaded, you can click portlet's title bar again to display its contents as needed.
If a dashboard contains a portlet that is extremely slow to load, the first time the portlet opens, NetSuite may display a popup suggesting that you minimize the portlet, to speed dashboard loading time.

**Refresh portlet content**

- Portlets with content that is calculated from current data include a Refresh icon in the upper right corner, that you can click to ensure content is based on the latest data.

**Rearrange portlets on a dashboard**

- You can use drag and drop to reorder your portlets. Click the header of the portlet, and drag the portlet to the location you desire on your page. You can drag them above or below other portlets, and to the left, center, or right column. For more detailed steps to drag and drop portlets, see *Arranging Dashboard Portlets*. Depending on the type, some portlets will display more detailed information if placed in the center column of a page.

**The Project Center**

NetSuite offers a standard Consultant role with access to the Project Center. The Project Center allows access to NetSuite using a specialized interface that routes the most important functions of project work directly to the home page.

The Project Center has the following standard tabs: Home, Activities, Projects, Time & Expenses, Resources, Reports, Documents, and Support. Each tab offers access to links and information that deal directly with project management in NetSuite.

**The Home Page**

The Home tab contains a variety of at-a-glance portlets for easy access to the most used tasks and information for projects. Included on the Home page are Quick Links for entering time and expenses, creating a case, and allocating resources.
The Project Center

Note: Resource allocation quick links and information are only available when also using the Resource Allocations feature.

The Projects portlet contains a list of assigned projects with links to view the project record and additional information. The Time Entries portlet offers a list of entries for a certain time period including the status of each entry. A specialized Utilization KPI Meter offers a visual representation of current utilization.

The Projects Page

The Project tab is used to manage information about customers, projects, and project tasks. You can access the following records from the Projects tab:

- Customers
- Prospects
- Leads
- Projects
- Project Tasks

A project search portlet shows a list of projects that can be filtered using the dropdowns at the top of the list.

The Time & Expenses Page

The Time & Expenses tab is used to track and approve time entries, enter and approve expense reports, and enter and approve purchase orders. The Time Entries portlet shows a list of your recent time entries.

The Resources Page

The Resources tab appears only if you also use Resource Allocations. On the Resources tab you can enter new resource allocations and see a list of your current allocations.

Note: For information on the availability of Resource Allocations, please contact your account representative.

To give employees access to the Project Center, add the Consultant role to their employee record. For information on giving access to employees, see the help topic Giving an Employee Access to NetSuite.
Viewing Project Schedules

After you have created project records and set up a schedule to complete the project, you can view the project schedule to assess progress. The project schedule is also commonly known as a project plan.

The project plan, or schedule, for a project is found on the Schedule subtab of the project record.

To view a project schedule:

1. Go to Lists > Relationships > Projects and click View next to the project.
2. On the project record, click the Schedule subtab.

   The schedule shows the existing tasks for the project, and for each task, the start date, end date, estimated work and cost are shown.

   **Note:** The Schedule subtab displays project tasks in the order in which they would be listed on a project plan or work breakdown structure. You cannot sort or reorder the project tasks displayed on the Schedule subtab.

For details about using the Schedule subtab for managing project tasks, read Working with the Project Schedule.

Working with Projects in Multiple Time Zones

If your organization has employees in different time zones who work on projects, the following time zone considerations apply:

- NetSuite displays the start and end dates for a project in the time zone preference for the organization, selected in Company Information. For example, the company time zone is GMT -8:00 Pacific Time (US & Canada), and the project start date is 11/20/2008. Project staff in California and Japan will see the same start date, 11/20/2008, when viewing the project record.
- NetSuite displays the project task start and end dates based on the time zone preference of the user logged in. For example, a resource in New York is assigned to a project task with a start date of 10/28/2008 9:00 am. When an employee in California logs in and views the project, the start date for this task displays as 10/28/2008 6:00 am.
- For Fixed Start project tasks, the start time for the task is based on the time zone of the user who creates the task. If a user in New York creates a Fixed Start task with a start time of 9:00 am, the start time displays as 6:00 am to a resource viewing the task in California.
- No time zone conversion occurs for time entries. Planned time displays for a resource on the same date as the task date in the project schedule.

Working with the Project Schedule

The project schedule shown on the Schedule subtab of each project record provides the capacity for scheduling and managing project tasks.

The project schedule is a workspace that helps you examine the overall scope, progress and cost for a project. It also organizes the tasks as parts of the project as a whole and defines how they should work together.
To view a project schedule:

1. Go to Lists > Relationships > Projects and click View next to the project.
2. On the project record, click the Schedule subtab.

The schedule shows the existing tasks for the project, and for each task, the start date, end date, estimated work and cost are shown.

**Note:** The Schedule subtab displays project tasks in the order in which they would be listed on a project plan or work breakdown structure. You cannot sort or reorder the project tasks displayed on the Schedule subtab.

In the View field, you can select various views of the planned tasks for the project, including Planning, Tracking, or Variance views:

- **Planning** – The planning view looks at relationships between tasks, start and end dates, and the estimated level of effort and cost. It is most useful when you are beginning to create a project schedule.
- **Tracking** – The tracking view looks at current task progress and the current estimated task dates versus the baseline dates. The tracking view is best for an active project that has tasks you are working on.
- **Variance** – The variance view compares the original baseline plan to the current plan highlighting changes to tasks over time. These changes, or variances, may be in terms of either the targeted dates, the estimated quantity of work, or both.

These views also can be customized and new views can be defined. Whichever view you select, the same view displays again the next time you access that page.

You can also view a Gantt Chart to open a popup window with a graphical representation of tasks for the project.

### Gantt Chart

On the Schedule subtab, you can click View Gantt Chart to open a new window with a Gantt chart of the project. A Gantt chart is a bar chart that represents the project schedule and clearly illustrates the start, end, milestones, and progress of individual tasks.

The Gantt chart offers an interface that allows for zooming and scrolling through the project schedule and highlighting important project metrics, such as the critical path.
NetSuite calculates the critical path of your project by determining the tasks that must stay on schedule for the project to be completed on time.

You can also filter the Gantt chart to show tasks with less than 30% complete and highlight tasks scheduled for longer than seven days. The chart offers a visual tool that can be used to gauge project health and keep schedules on track.

**Tracking Project Baselines and Variance**

Because aspects of a project can change over time, it is valuable to capture a snapshot of your original estimates for the project plan before any work begins. This snapshot is called a baseline. After you have set up all tasks, you can capture a baseline for comparison to actual work and revised schedules later in the execution phase of your project.

When you click Set Baseline on the project, you capture the complete original project, including all intended tasks and costs for the schedule. This baseline becomes your point of reference as an idealized goal for the project.

It is important to record this starting point so that if plan changes become necessary, you can track variances against actuals as the project progresses. Comparing the baseline values against current values can help you determine the success of the project. For example, you can see if work estimates were greatly underestimated or if costs are running over what was expected.

You can see baseline and variance views on the Schedule subtab of projects, as well as on Gantt chart views.

Baseline values are stored for both the project and for individual project tasks. The following baseline values are stored:

- Planned Hours
- Planned Cost
- Planned Start Date
- Planned End Date

By default, the standard project task form and standard project form do not show baseline fields. You must customize these forms to show these fields.

**Setting a Project Baseline**

After the details of a project have been finalized, you can set a project baseline. A baseline captures a snapshot of your original estimates for the project plan before any work begins. Then, you can use the
baseline data for comparison to actual work and revised schedules later in the execution phase of your project.

**Note:** Only users with Edit or Full permission for Projects can set a project baseline.

**To set a project baseline:**

1. Go to Lists > Relationships > Projects and click *View* next to the project that is ready to have a baseline set.
2. On the project record, click *Set Baseline*.

Now, the baseline data is recorded. The project record now shows a Last Baseline Date field in the header that displays the date you most recently set a baseline.

If you need to reset the baseline data for a project, you can click Set Baseline again. The data previously stored in the baseline fields will be overwritten with the more current data.

**Planned Work**

The Planned Work feature enables project plans to be fixed regardless of actual time tracked against a project. By keeping a project plan fixed, you can improve your future project planning by comparing the difference between planned time and actual time. Planned Work also enables you to select to plan your projects with a forward or backward scheduling method. For more information, see Project Scheduling Methods.

To enable the Planned Work feature, go to Setup > Company > Enable Features. Under Projects, check the Planned Work box, and click Save.

**Important:** When enabling Planned Work, NetSuite recalculates all projects and their project plans that do not have a Closed status. Please ensure any projects you have finished are set as Closed prior to enabling this feature. Projects that are finished but have not been set as Closed may have adjustments made to the percent complete, billing, or revenue recognition.

Enabling the Planned Work feature renames the Estimated Work field to Calculated Work on project records. A Planned Work field is added to project and project task records. When planning a project, planned work is entered on project or project task records. If you enter planned work on project tasks, the sum of the hours entered rolls up to be displayed in the Planned Work field on the project record.

If time is entered outside of the planned work for the project, the Planned Work field does not change. The Planned Work field is only updated if additional hours are manually entered on the project or project task records. Calculated Work is the sum of planned work and any actual time tracked outside of planned work. As time is tracked for the project, the Calculated Work field is updated when time is tracked outside the planned time.
Planned Work

Note: When using Planned Work, planned time entries are not converted to actual time entries, they remain in NetSuite as planned time. If you also use Advanced Project Profitability, this can result in a duplicate calculation of your committed costs. It is recommended that you ensure your custom profitability calculations do not have Planned Time enabled on the Settings page. For more information, see Advanced Project Profitability.

Warning: There is a 250 entry limit for any single assignment on a project. Because planned time entries are not converted when using Planned Work, it is possible in very large projects to reach this limit. If the limit is reached, the project plan is no longer recalculated and cannot be edited. As a work around, you may clear the Create Planned Time Entries box on the Preference subtab of the project record or increase the duration of individual time entries for the assignment to prevent multiple small planned time entries.

If you previously had saved searches and reports using the Estimated Work field, you must manually update your searches and reports to include the Calculated Work field. Calculated Work and Planned Work are both available to add to searches and reports so that you may easily track your project planning accuracy.

After enabling Planned Work, go to Setup > Accounting > Accounting Preferences. On the Projects tab, under Project Management, in the Percent Complete Denominator field, select how you want your denominator determined for percent complete calculations.

- **Planned Time** – the total number of hours for planned for the project
- **Planned Time + Actual Time** – the total number of hours planned for the project plus any time tracked over the planned hours
- **Allocated Time** – if you use resource allocations, the total number of hours allocated for the project
- **Allocated Time + Actual Time** – if you use resource allocations, the total number of hours allocated for the project plus any time tracked over the allocated hours

After you have initially set this preference, any changes made will require recalculation of your open project plans. This could affect your calculated percent complete, progress, revenue recognition, or charge-based billing. If allocated time is selected, NetSuite uses all allocated time (both project and project task) for percent complete calculations.

**Refreshing Project Items on Transactions**

When you edit a sales order, estimate, or opportunity that is associated with a project you can refresh the items from the project to update the transaction with the most current information from the project.

Note: Depending on your project preferences and the changes made to your projects, updating items from projects may create duplicate line-items with updated information. To prevent having duplicate lines, delete the outdated lines before saving your sales order.

- If the Consolidate Projects on Sales Transactions preference is Off:
  Specify the project in the project header field. Then, on the Items subtab above the item list, click Refresh Items from Project.
- If the Consolidate Projects on Sales Transactions preference is On:
  Specify the project in the dropdown associated with the item list. Then, click the refresh button next to the dropdown.

When the refreshed items load, the transaction displays the current items and totals.
Refreshing Project Items on Transactions

Note: After you have begun billing an order, you can no longer refresh the items to transactions.

If you use Charge-Based Billing, you can refresh items from your projects by first generating a forecast. When you create charge rules based on service items, those service items can be added to your transactions based on the charges forecast. This lets you create opportunities and sales orders prior to generating charges. For more information, see Generating Charges.

For more details about the consolidation preference, read Using the Project Consolidation Preference.

Creating Sales Orders from Projects

You can create a sales order from an existing project. NetSuite creates line items on the sales order for the service items associated with the project tasks. The new sales order defaults the customer, project, and items from the project tasks and schedule. You can add additional items to the sales order that are not part of the project, such as inventory items, discounts, assemblies, descriptions and subtotals.

To be able to create a sales order from a project:

- You must select a billing schedule for the project.
- Do not select the Consolidate Projects on Sales Transactions preference.

To create sales orders from a project:

1. Open a project in Edit or View mode.
2. In the New dropdown, click Sales Order. NetSuite creates a new sales order with the customer, project, and items from the project.
3. Click Save.

On the sales order, the line item shows the following project information:

- Project Item: Indicates that the line item came from the project associated with the sales order.
- Billable Estimate: Displays the estimated amount of billable time for the item. This amount is included in the total amount of the sales order and represents time not yet recorded in Time Tracking for the task or tasks associated with the item. This amount displays only if you do not enable the Consolidate Projects on Sales Transactions feature.

Generally, you create a sales order a single time from a project at the point you have customer approval for the project. If the project schedule changes before invoicing the customer, then click Refresh Items from Project to update the sales order items to match the project information.

Note: You can create sales orders at several different points in the order to cash process. Based on your business needs, you may want to create sales orders from opportunities or estimates instead of from projects.

You can add project names to sales order reports by customizing the report to include Bookings > Project > Job Name. If you use the Consolidate Projects on Sales Transactions preference, you can customize your reports to include Bookings > Entity (Line) > Name to display the project name. For more information on customizing reports, see the help topic Report Customization.
Project Billing

NetSuite provides flexible billing options for project billing. You can bill projects based on completing project work, achieving project milestones, or according to a schedule of dates. The project billing type determines which method of billing to use. The project billing schedule provides the details for when and how to bill the customer over a range of time. For information about the three types of project billing schedules, read Project Billing Schedule Types.

You must enable Project Management and Advanced Billing to bill projects.

You can create a billing schedule specific to the project or select an existing billing schedule. After a billing schedule is set on the project record, the billing schedule is associated with the sales order when you source items from the project. The rules that determine when the order is ready to bill depend on the billing schedule type.

**Note:** You can use a standard billing schedule to bill a project, if that meets your business needs. When you create a project, select Fixed Bid, Interval as the billing type but do not select a billing schedule. Then on the sales order, edit the project line and assign a standard billing schedule (one that is not Fixed Bid, Interval, Fixed Bid, Milestone, or Time and Materials). The billing schedule assigned on the sales order overrides the billing schedule on the project, if entered.

When an order includes work that has been completed and is ready for billing, that order automatically shows in the bulk billing queue or shows the Next Bill button on the sales order form. Use the Bill Sales Order page as the primary place to invoice for project work associated with an order, including project billable time that is billed on a time and materials basis. Project time must be entered and approved to be billable.

The recommended best practice is to create sales orders for your projects and then bill the sales orders individually or in bulk on the Bill Sales Order page.
Important: Using the Invoice Billable Customers page is not recommended to bill time for Time and Materials projects that have associated sales orders because the invoice is not linked to the originating order. The Invoice Billable Customers page is ideal to process time that is not associated with an order.

When creating invoices, all approved, billable time entered against the project is automatically selected to be included on the invoice. The Billable Time subtab also displays approved billable time not related to a sales order, such as time entered against a case. Select any non-sales order time that you want to include on the invoice. Project totals do not include non-sales order items billed to the customer.

To bulk bill projects, go to Transactions > Sales > Bill Sales Orders. For details about the bulk billing process, read the help topic Billing Customers Using Billing Schedules.

For details about project billing using all billing schedule types, read Project Billing Schedule Types.

The billing schedule for a project can be viewed on the sales order by clicking the Schedule subtab under the History subtab.

Invoice Schedule Recalculation

Modifications made to projects, project tasks, and time entries can affect sales order invoice schedules if the project is assigned a billing schedule type. When such changes are entered, they trigger a project plan recalculation, as well as an invoice schedule recalculation.

For example, you may have a weekly billing schedule associated with a sales order for a project with a duration of 2 weeks. The invoice schedule lists two expected bill dates. If a project task record is changed in a way that the project duration becomes 4 weeks, then the invoice schedule on the sales order is also updated. The updated schedule will include four expected bill dates.

Note: The following changes do not trigger project plan or invoice schedule recalculation:
- Changes made to work calendars
- Changes made to billing schedules

Project Billing Schedule Types

To set up billing for a project, select a billing type and billing schedule on the Financial subtab of the project record. The billing type and the billing frequency of the associated schedule determine how Advanced Billing executes project billing.

Billing types include:

- Projects and Time and Materials Billing – Bill customers for actual project expenses, such as resource time and materials
- Fixed Bid, Interval Billing Schedules – Bill customers for work completed at predefined intervals
- Fixed Bid, Milestone Billing Schedules – Bill customers based on percent of work completed, or preset milestones
Charge-Based Project Billing — If you use the Charge-Based Billing feature, you can create charge rules that provide added flexibility for calculating billable value on projects. Billing Rate Cards can be used to set billing rates on Charge-Based projects.

**To enter financial information for a project record:**

1. Go to Lists > Relationships > Projects. Click **Edit** next to the project you want to enter financial information for.
2. Click the **Financial** subtab on your new project record.
3. Select a billing type for this project.
4. Select a billing schedule for this project or select **New** to create a new schedule.
   For details about creating a billing schedule, read the help topics Creating Billing Schedules and Creating Billing Schedules From an Estimate or Sales Order.
5. If you select a **Fixed Bid** type schedule, enter the following:
   1. In the **Billing Item** field, select the service item that will appear on transactions billed to the customer.
   2. In the **Project Price** field, enter the project price. This is the price billed to the customer on transactions. It is also used to calculate gross profit margin for the project.
6. If you use the Multi-Currency feature, select a currency for this project. The **Exchange Rate** field shows the appropriate exchange rate.
7. If you use the Revenue Recognition feature, in the **Rev Rec Forecast Template** field, select a revenue recognition template created for a project. It is used only to forecast the expected revenue to be recognized for the project according to the schedule.
8. If you use Job Costing, in the **Project Expense Type** field, select an expense type for this project. Check the **Apply to all time entries** box to apply this project expense type to all time transactions overriding any project expense types from service items. For more information, see Job Costing and Project Budgeting.
9. You can now click **Save** to save your project record.

**Billing and Project Consolidation**

Consider the following points when using billing schedules with the Consolidate Projects on Sales Transactions preference. For more details on the consolidation preference, read Using the Project Consolidation Preference.
Billing Schedule Types and Consolidation

Billing schedules can be edited on the project sales order. With the Consolidate Projects on Sales Transactions preference disabled, the standard sales order form includes a billing schedule field. When you select the customer and project on the sales order form, the billing schedule associated with the project autofills the billing schedule field.

**Important:** Because you can change the billing schedule associated with a project when creating a sales order, it is possible to assign a fixed bid billing schedule to a time and materials project, or a time and materials billing schedule to a fixed bid project. Verify that the schedule type is the same on the project and its sales order before billing.

Project and Sales Order Schedule Synchronization

On a sales order form, if the billing schedule is set at the header level, there can be only one billing schedule for that sales order. If there are multiple projects on the sales order, then each of the projects could have a different billing schedule specified on the project record.

In this case, the header-level billing schedule takes precedence over the project-level billing schedules and is used for all projects. This result can be confusing because the information on the individual projects may not be the same as the billing schedule on the sales order.

To avoid this confusion, if you enable Consolidated Projects on Sales Transactions preference, use a sales order form with line-level billing schedules. Then, when you add project items to the sales order, the billing schedule for that project comes to the sales order with the item, and the billing schedule on the sales order and the project match.

For more information, see To customize a sales order form for per-line billing schedules:

It is also important to determine billing schedules for estimates and sales orders at the same level. For example, if an estimate uses a header-level billing schedule, the sales order should also.

Fixed Bid, Milestone Project Billing with Consolidation

With the Consolidate Projects on Sales Transactions preference enabled, you must customize the standard sales order form to show billing schedules on item lines to bill Fixed Bid, Milestone projects.

For example, on the Items subtab on a standard sales order, you select a project with a Fixed Bid, Milestone billing schedule, in the Refresh Items from Project field. When you click Refresh, NetSuite adds the services items from the project to the sales order, but the Billing Schedule field on the form (header level) is not populated. In order to bill this type of project, follow the steps below to customize the sales order.

**To customize a sales order form for per-line billing schedules:**

1. Open the standard sales order you need to customize.
2. Click Customize.
3. Click the Screen Fields subtab.
4. On the Columns subtab, check the Billing Schedule box.
5. Click Save.

Then, when you use the customized form to create a sales order, the billing schedule for each line item defaults to the billing schedule identified on the project, if any.
Fixed Bid, Milestone Billing without Consolidation

If you disable the Consolidate Projects on Sales Transactions preference, always verify that the schedule selected on the project and sales order match.

For example, you specify a Fixed Bid, Milestone type billing schedule on the project, but select a standard billing schedule on the sales order. Viewing the project record, you would expect milestones to be billed. But due to the schedule selected on the sales order, they would not be.

If you select a project-based billing schedule (Time and Materials, Fixed Bid, Interval, or Fixed Bid, Milestone) on the sales order, all line items for the order will be invoiced based on the project billing schedule whether they are project items or not.

For example, you specify a Fixed Bid, Milestone billing schedule type on a project and source that billing schedule onto the sales order. If you then add non-inventory items to the sales order, these items will be billed in the same milestone percentages as the service items from the project.

Project Billing Rates

You specify the billing rates for a project when you assign resources to the project’s tasks. The employee price rate defaults when you assign a resource to a task, but you can enter a different rate if necessary. If you change the default rate on an employee record, then NetSuite updates the rate on the project record.

You can define pricing for service items in the following ways:

- **Use Service Item Price**
  This is the simplest form of billing. The price for each unit of time defaults from the service item associated with the project task assignment line.
  - **Price Level**
    The price level for the associated customer determines the default price for the service item if you assign a customer before saving the project.
    - If you assign a customer to a project after saving it, then the base price for the service item is used.
  - **Quantity Pricing**
    If quantity pricing is enabled, then quantity-based discounts are enabled on a line-by-line basis.
    For example, if specific pricing is available for quantities of 10 or more, then that pricing applies only if a single task line has more than 10 units of work associated with it. This means, even if the task has more than 10 units of work associated with it, but they are distributed among multiple resources, then the quantity-based pricing does not apply.

- **Use Per-Employee Rates**
  When per-employee rates are enabled, you can use billing classes with projects. Billing classes lets you create different roles that resources play on a project, for example, Consultant, Analyst, or Project Manager. Billing classes can then be used to create different rates for each of those roles, dependant on what service or item is being offered.
  You can assign each employee a default class in the Classification section of the employee record. You can also assign a default billing class to vendors that serve as project resources on the Financial tab of the vendor record. When a resource with a billing class is assigned on a project task, the price for that resource is calculated from the billing class price.
  Billing classes can also be assigned to service items for sale and resale. When you assign a billing class to an item, you can define a different price structure that applies only to that service item. When a service item is also used on a project task, the price is calculated based on the service item billing class and will override the default resource billing class price.
If you use billing classes, you can also enable Billing Rate Cards to define different rates for a group of billing classes. You can then assign these rate cards to customers and use them as the basis for time-based charge rules on charge-based billing projects.

- **Customize Price on Project Task**

  Customize the default pricing that is sourced on the task line regardless of any other pricing provided.

When entering time against a project, if a project task is selected, then the billing rate is sourced from the rate on the project task. Since the basic pricing is the same for project tasks and regular billable time entry, this number is normally the same, unless the pricing on the project task has been customized manually.

### Forecasting Project Billings

When a project specifies a Time and Materials or Fixed Bid schedule, that billing schedule is applied to the associated estimate or sales order. After the billing schedule is identified on the sales order, you can use billing schedules to forecast billings for the project.

Billing forecasts determine when you expect currency to be billed based on the effort planned to be expended across the planned project billing interval.

Service items from project tasks are sourced to the sales order to provide a summary of quantity, cost, and revenue for the project. Then, this information is used to calculate the gross margin for the project.

Projected billings associated with a project are included in financial forecast reports. The forecast amounts adjust automatically based on actual work performed on the project and any changes made to the project schedule.

Use the following to view billing forecast data:

- **Forecast by Item Summary Report** - shows the projected and weighted forecasts for pending and closed business. Customize the report to show revenue for service items by time interval.
- **Sales Order by Item Report** - shows projected revenue for closed sales orders. Customize the report to show revenue for service items by time interval.
- **Schedule subtab of the History subtab of the sales order** - displays the revenue expected for the project or projects on the sales order for each billing.

### Projects and Time and Materials Billing

Use the Time and Materials billing type to bill customers for actual time worked on a project and material costs. Estimates and sales orders that include project service items can be billed on a Time and Materials basis. This enables you to use the Bill Next button, Bill Sales Orders link, or the bulk Bill Sales Orders page to process billing, and to view time and materials revenue forecasts.

Another possibility is to use Billable box. For information on Billable box, see the help topic Bill your costs to customers in one of the following ways:

---

**Note:** You must enable Project Management and Advanced Billing to use time and materials billing.

For Time and Materials schedules, billing dates are driven by the frequency selected in the billing schedule. The number of billing dates depends on the duration of the associated project. The expected
Projects and Time and Materials Billing

The amount billed on each billing date is determined by the expected percent-complete of each project item as of the bill date.

The Items subtab on the Sales Order shows the estimated billable service items from the project. This corresponds to the entered and approved time for project task and represents the full amount of project time expected to be billed for the billing period. On the invoice, the Billables subtab displays the billable service items.

Time and materials schedule lines that will not be carried over to the invoice have the Billable Estimate field checked on the sales order. Order lines for Time and Materials project items, as indicated by the Billable Estimate flag, are automatically linked to corresponding billable time when invoiced. The Invoiced column on the sales order reflects these billable time entries.

If you use a Time and Materials schedule, you cannot show an initial payment against the project because the order lines are removed when you convert the order to an invoice and there are no lines to create an initial bill against. You can, however, accept a customer deposit in this case.

There is no need to close out a sales order or the individual lines to avoid billing them inadvertently. NetSuite does not bill an item until time worked is entered against it and approved. Only then will billing include time for that item. If the only remaining open lines on a sales order are billable estimate lines, then the Next Bill button does not appear until the billable time has been entered and approved.

Sales order lines are considered billed after the customer has been invoiced for a quantity equal to or greater than the quantity specified on the order. In order to invoice fewer hours than the number originally specified on the order, the quantity on the order must be reduced.

**Important:** On a sales order, lines associated with a Time and Materials schedule are considered to be estimated lines and those lines are removed when the order is converted to an invoice. In these cases, you must apply billable time to the invoice to generate the appropriate bill.

Creating a Time and Materials Billing Schedule

Use the Billing Schedule page to create a Time and Materials billing schedule. You can access this page from the Financials subtab of a project or go to Lists > Accounting > Billing Schedules > New.

The Time and Materials billing schedule defines the billing frequency and payment terms and always bills in arrears. You can define a time and materials billing schedule and then use it for as many projects as you want. You do not have to create a separate time and materials billing schedule each time you create a time and materials project. If you want to create private time and materials billing schedule that can only be used for one project, then you must create the billing schedule from the project record.

**To create a Time and Materials billing schedule:**

1. From the Financial subtab of a project record, click the Add New icon next to the Billing Schedule field.
2. Enter a name for the billing schedule.
3. In the Recurrence Frequency field, select the frequency for bills to recur. select how often to create bills.
4. The In Arrears box is checked by default because all billing for time and materials projects occurs at the end of the recurrence period.
5. In the Recurrence Payment Terms field, select the payment terms to be used on all recurring invoices.
6. Clear the Public box if you want this billing schedule to be available only for the project it was created from.
7. If you do not want this schedule to be applied to new projects, then check the Inactive box.
8. Click Save.

Billing Customers Using Time and Materials Billing

Bill customers for time and materials projects using Advanced Billing. You can:
- Bill from the billing queue
- Bill manually

For information on how to use the billing process, see the help topic Billing Customers Using Billing Schedules.

Projects and Interval Billing

Fixed Bid, Interval Billing Schedules

Fixed Bid, Interval billing schedules allow you to invoice customers at predefined intervals. This schedule type bills in arrears only. You can specify an initial amount, recurrence frequency, payment terms, and the type of time entries to bill for these schedules.

Note: You must enable Project Management and Advanced Billing to use fixed bid, interval billing.

Billing with Fixed Bid, Interval schedules is similar to using a standard billing schedule with a regular frequency. However, NetSuite calculates the number of billing cycles based on the duration of the project and the billing recurrence frequency. The percent work complete as of the bill date for each project item determines the amount billed.

Use the Invoice Actual Time Only check box when creating the schedule to determine the type of time to bill. You have the option to invoice planned project time and actual time worked during the interval, or only invoice actual time worked. If you invoice actual time only, then you cannot specify an initial amount.

Because these schedules do not contain any project or order specific information, they are public by default and can be shared.

Creating a Fixed Bid, Interval Billing Schedule

To create a Fixed Bid, Interval billing schedule
1. From the Financial subtab of a project record, click the Add New icon next to the Billing Schedule field.
2. Enter a name for the billing schedule.
3. In the Initial Amount field, enter the amount to bill on the first invoice created from the sales order. You can enter the amount as a currency amount or a percentage.
4. In the Initial Payment Terms field, select the terms to be used on the first invoice to be created from the sales order.
   To add new payment terms, go to Setup > Accounting > Accounting Lists > New. Select Term.
5. In the Recurrence Frequency field, select how often to create bills.
6. Check **Invoice Actual Time Only** if you want to bill time worked and recorded but not planned time in each interval. You cannot specify an initial amount if you bill actual time only.

7. The **In Arrears** box is checked by default because all billing for fixed bid, interval projects occurs at the end of the recurrence period.

8. In the **Recurrence Payment Terms** field, select the payment terms to be used on all recurring invoices.

9. If you do not want this schedule to be applied to new projects, then check the **Inactive** box.

10. Click **Save**.

**Billing Customers Using Fixed Bid, Interval Billing**

Bill customers for fixed bid, interval projects using Advanced Billing. You can:

- Bill from the billing queue
- Bill manually

For information on how to use the billing process, see the help topic **Billing Customers Using Billing Schedules**.

**Projects and Milestone Billing**

You can bill customers for project work at milestone intervals. Instead of being based on the materials used and time worked on the project, billing amounts are based on reaching preset project goals, or billing milestones. To use milestone billing, select Fixed Bid, Milestone as the billing type on the project. Then, create a new billing schedule that is a Fixed Bid, Milestone type schedule. For more information, see **Creating a Milestone Billing Schedule**.

**Note:** You must enable Project Management and Advanced Billing to use milestone billing.

For details on consolidated projects and milestone billing, see **Fixed Bid, Milestone Project Billing with Consolidation**.

**Fixed Bid, Milestone Billing Schedules**

Milestone projects bill customers for amounts based on reaching preset goals, or billing milestones in the project. Milestones mark a point in time that must be reached to trigger the associated billing. Then, you invoice customers for a portion of the total project amount.

For example, you contract to sell a customer to sell widgets and to install them in their offices in three phases. When you complete Phase One of the installation, you want to bill the customer for the work completed in Phase One, but not yet bill for Phase Two. Using Milestone Billing, you can bill for each phase as the work is completed.

Billing with Fixed Bid, Milestones schedules is similar to using a standard billing schedule with custom billing dates. You can specify the bill date for a milestone or link it to the completion of a task within the project.

- When it is linked to a project task, the bill date automatically updates when the expected completion date of the linked project task changes.
- When the milestone is marked complete, the amount associated with the milestone is available for billing. If the milestone is linked to a project task, then the milestone is marked as complete when the task is complete. Otherwise, the milestone must be manually marked complete on the billing schedule.
Define milestones when you create the billing schedule and optionally link them to project tasks. Assign a percentage of the total amount to be billed when the milestone task is completed. A Fixed Bid, Milestone schedule selected on a project is always private and used only for the project it is associated with.

To create revenue recognition schedules for fixed bid milestone billing schedules, you must select revenue recognition templates whose term source is not based on a billing schedule. For information about revenue recognition term sources, see the help topic Understanding Revenue Recognition Template Terms.

**Monitoring Milestone Billing Using Saved Searches**

Create a saved search and publish the results to your dashboard to monitor billing milestones for your projects. This eliminates the need to open each billing schedule to check the status of project milestones and billing. For example, you can create a saved search to track uncompleted milestones and late milestones directly on your dashboard. Or you can display a list of milestones for all projects by expected completion date.

To create a search to filter projects by billing milestones, select the appropriate milestone billing fields when setting up an advanced search for projects. Billing milestone fields exposed as related record fields in the Project search criteria include:

- Actual Completion Date
- Amount
- Comments
- Estimated Completion Date
- Project Task
- Terms

Then publish the saved search to your dashboard. For information, see the help topics Defining an Advanced Search and Displaying Saved Search Results in Dashboard Portlets.

**Creating a Milestone Billing Schedule**

If you use both the Project Management and Advanced Billing features, you can use milestone billing to bill customers in increments when project milestones are reached. For more information, see Billing Customers Using Milestone Billing.

To enable the features required to use milestone billing, see Enabling Project Features.

To use milestone billing, you must create a milestone billing schedule from within the context of a project. The schedule identifies the amount to bill as milestones are completed. Each milestone billing project has its own Fixed Bid, Milestone billing schedule.

**Note:** Milestone billing schedules cannot be marked public.

**To create a milestone billing schedule:**

1. Go to Lists > Relationships > Projects. Click **Edit** next to the project you want to create a schedule for.
2. Click the **Financial** subtab.
3. On the **Financial** subtab, select **Fixed Bid, Milestone** in the **Billing Type** field.
4. Click **Add New** next to the **Billing Schedule** field to create a schedule for the project.
5. On the billing schedule form, enter a name for this billing schedule.

6. NetSuite fills in the Initial Amount and updates it automatically as you add billing milestones. If the total percentage amount for all milestones is less than 100%, then the remaining percentage is the initial amount to be billed.

7. In the Initial Payment Terms field, select the terms to be used on the first invoice to be created from the sales order.

   To add new payment terms, go to Setup > Accounting > Accounting Lists > New. Select Term.

8. Add a line for each milestone to be billed by this schedule.
   1. In the Amount field, enter the percentage of the total project amount to be billed when the milestone is reached.
   2. Optionally select payment terms to apply to this milestone.
   3. Optionally, in the Task field, select the task that must be completed for this milestone.
   4. In the Estimated Completion date, enter the date you expect this milestone to be reached. This is used for forecasting calculations.

   If you entered an estimated completion date when you created the project task, that date shows here.
5. If you don’t identify a project task for a milestone, then check the **Completed** box only when this milestone is completed and this milestone can be billed. If you specify a project task for a milestone, then NetSuite automatically marks the task complete here when the project task is marked complete.

**Important:** Milestones cannot be billed unless they are marked as complete. If you do not specify a project task for the milestone, then you must check the **Completed** box manually.

6. Optionally enter comments regarding this milestone.

7. Click **Add**.

9. Repeat step 8 for each milestone you want to add to this schedule.

10. Click **Save**.

Each milestone billing schedule you create is private, applies only to one project, and can be viewed only from the project record. Upon completion of each milestone task, that portion of the project becomes eligible for billing.

### Billing Customers Using Milestone Billing

Sales orders with milestone billing schedules are billed in portions as project milestones are reached. For more information on associating project tasks with milestones, read [Creating a Milestone Billing Schedule](#).

The billing process has two parts. First, the project milestone identified on the billing schedule must be marked **Completed**. Then, generate a bill for that portion of the project.
Important: Milestones cannot be billed unless they are marked as complete.

To mark a milestone with a project task as Completed:
1. Go to Lists > Relationships > Projects and open the project record.
2. On the Schedule subtab, click Edit next to the project task for the milestone.
3. In the Status field, select Completed.
4. Save the project task.
   NetSuite automatically marks the milestone on the billing schedule as Completed when you save the project task.

To mark a milestone not linked to project task as Completed:
1. Go to Lists > Relationships > Projects and click Edit next to the project.
2. Click the Financial subtab.
3. Click Open next to the Billing Schedule field.
4. Click Edit on the billing schedule.
5. Click the line showing the milestone you want to mark.
6. Check the Completed box only when this milestone is completed and this milestone can be billed.
7. Click Save.

To generate a bill using bulk billing:
Go to Transactions > Sales > Bill Sales Orders. For details about the bulk billing process, read the help topic Billing Customers Using Billing Schedules.
Projects and Milestone Billing

To generate an individual bill from the sales order

1. Go to Transactions > Sales > Enter Sales Orders > List. Click **View** next to the order you want to bill.
2. Click **Next Bill**.

   An invoice opens that autofills with the appropriate items and prices from the project record.

Charge-Based Project Billing

Charge-Based Billing lets you create charges that you can bill to your customers. When used with the Project Management feature, you can apply rules to generate charges that are included on project invoices.

On charge-based billing projects there is a new field available — Billing Rate Card. This provides the option to either select a customer specific rate card or a generally available rate card for billing your project. For more info on Billing Rate Cards, see **Using Billing Rate Cards**.

Charge rules offer flexibility in calculating the billable value of project activity. Charge rules can be based on:

- the completion of project milestones
- project progress
- time entered for projects
- expenses entered for projects
- fixed amount generated on fixed dates (for example, up front materials costs)
- purchase transactions entered for projects

Charge rules determine the amount and sometimes the date of the charges created. For more information, see **Understanding Charge Rules**.
Charge-Based Billing also gives you comprehensive oversight of the project billing process. The billing status of each project is summarized on the Financial subtab of the project record. From there you can view the pending charges and make them available for billing. For more information, see Approving Pending Charges.

You can also view the Project Billings Report to see a summary of billing for each customer and project.

To begin using Charge-Based Billing, see Setting Up Charge-Based Billing.

Setting Up Charge-Based Billing

To begin using Charge-Based Billing, first enable the feature at Setup > Company > Enable Features > Transactions under Billing. The Project Management and Advanced Billing features are required to enable Charge-Based Billing.

When you enable the feature:

- a new Charge-Based billing type is available on project records
- the Project Billings Report is available
- a Create Charges transaction is available at Transactions > Customers > Create Charges
- new tabs are added to the Financial subtab of the project record where you can set up charge rules, generate charges, and view charges that have been generated for a project
- a Rates subtab is added under the Human Resources subtab of employee and vendor records where you can set hourly rates for project resources
- a new expense item type is available at Lists > Accounting > Items > New
- an Expense Item field is added to expense category records to associate expense categories with items

You can set the default initial billing status for each charge rule type at Setup > Accounting > Accounting Preferences > Items/Transactions under Charge-Based Billing. For a charge to be billed, it must have the Ready stage.

To use expense-based charge rules, you must first create expense items and associate those items with expense categories. For more information, see the help topics Expense Items and Creating an Expense Category.

Creating Charge-Based Projects

Projects that generate charges as billable amounts use the billing type Charge-Based.

**To create a charge-based project:**

1. Create a new project record.
2. On the Financial subtab, under Billing Information, select Charge-Based in the Billing Type field.
3. Select a billing schedule.
   - This billing schedule is only used to calculate sales forecast amounts.

Projects
4. Enter other project information.

**Important:** On the Preferences subtab, NetSuite advises you to enable the **Create Planned Time Entries** preference. This preference populates the **Estimated Work** field. Estimated work is used to calculate estimated labor revenue. Estimated labor revenue is used to calculate remaining charges for your project. If you do not enable this preference, your Charges Summary may report inaccurate totals for remaining charges.

5. Click **Save**.

After you save the project, you can create charge rules to define how charges are calculated for the project.

**Understanding Charge Rules**

Charge rules determine the billing rate, the timing of charges, and the stage of a charge when it is generated.

Charge rules can be either fixed fee, time-based, expense-based, or purchase. Fixed fee rules can generate charges on fixed dates, when milestones are reached, and upon project progress. Time-based rules generate charges when time entries are entered. Expense-based rules generate charges when expenses are entered. Purchase rules generate charges when purchase transactions are entered.

Charge rates are determined by the charge rules. Fixed fee charge rules require that a rate be entered on the rule. When you have a charge-based project with a milestone rule, the milestone record does not include the price fields. Pricing is instead determined by the charge rule.

Time-based charge rules can calculate rate from the service item on the time entry, from the rates entered on the Rates subtab of the employee record of project resources, or from an employee billing class.

**Note:** If you use the **Override Rates on Time Records** accounting preference, time-based rules will override any rate changes made on time transactions.

Expense-based charge rules calculate rates from the expense report or vendor bill where the expense is entered. Expense-based rules can also include a discount or markup applied to all or some of the entered expenses.

Purchase charge rules calculate rates from items purchased on purchase orders or vendor bills. Purchase charge rules can also include a discount or markup applied to the generated charges.

**Tiered Charge Rules**

You can define multiple charge rules for a single project, allowing you to create complex billing criteria based on a variety of factors. For example, you might want to bill a project based on time and materials. You would create two charge rules: one fixed date rule for the up-front billable amount for materials and one time-based rule that creates charges for time entered.

If you create time-based or expense-based charge rules, when a time entry is created for completed work or an expense is entered, these rules are each applied in the order you set. You can set filters on a rule so that it only applies to the time or expense you want it to. For example, you might want a rule to only apply to time or expenses entered for a specific item.
You can also use caps with time-based charge rules for additional flexibility. For more information, see Using Caps with Charge Rules.

Creating Charge Rules

Charge rules can be created on the Financial subtab after you have saved the project. There are four main types of charge rules:

- **Fixed Fee Charge Rules** — rules based on a fixed fee determined by date, milestones, or project progress
- **Time-Based Charge Rules** — rules based on time tracked against the project
- **Expense-Based Charge Rules** — rules based on expenses tracked for the project
- **Purchase Charge Rules** — rules based on items purchased the project

Fixed Fee Charge Rules

Fixed fee rules can generate charges on fixed dates, when milestones are reached, and upon project progress.

**To create a fixed date charge rule:**

1. Click the Financial subtab.
2. Click the Fixed Fee Charge Rules subtab.
3. Click the New Fixed Date Rule button.
4. Enter a name for the rule.
5. In the Amount field, enter the charge amount for this rule.
6. In the Billing Item field, select the service item that you want to use to determine the income account for charge revenue and to associate the charge with the sales order.

   **Note:** The rate on this service item is not used as the rate for charges.

7. Choose whether charges created by this rule are created with the stage of Ready, Hold, or Non-Billable.
   Charges can be set to Hold if you have an approval process for charges prior to billing them.
   Charges can be set to Non-Billable when you do not want to use the charge for billing purposes.
8. In the Recurrence field, set the frequency that charges are generated.
9. In the Series Start Date field, enter the date you want this charge rule to begin.
10. If you want this rule to be used during a specified time, enter an end date for the rule. If you do not enter an end date, NetSuite uses the project’s calculated end date as the end date for this rule.
11. Click Save.

Repeat this procedure for each fixed date charge rule you want to use on the project.

**To create a milestone charge rule:**

1. Click the Financial subtab.
2. Click the Fixed Fee Charge Rules subtab.
3. Click the New Milestone Rule button.
4. Enter a name for the rule.
5. Select the milestone or project task that causes a charge to be generated upon its completion.
6. In the Amount field, enter the charge amount for this rule.
7. Select the service item that you want to use to determine the income account for charge revenue and to associate the charge with the sales order.

**Note:** The rate on this service item is not used as the rate for charges.

8. Choose whether charges created by this rule are created with the stage of Ready, Hold, or Non-Billable.

   Charges can be set to Hold if you have an approval process for charges prior to billing them.
   Charges can be set to Non-Billable when you do not want to use the charge for billing purposes.
9. Click Save.

Repeat this procedure for each milestone charge rule you want to use on the project.

**To create a project progress charge rule:**

1. Click the Financial subtab.
2. Click the Fixed Fee Charge Rules subtab.
3. Click the New Project Progress Rule button.
4. Enter a name for the rule.
5. In the Amount field, enter the charge amount for this rule.
   This amount is charged each time a charge is generated according to the recurrence you set below.
6. Select the service item that you want to use to determine the income account for charge revenue and to associate the charge with the sales order.

**Note:** The rate on this service item is not used as the rate for charges.

7. Choose whether charges created by this rule are created with the stage of Ready, Hold, or Non-Billable.

   Charges can be set to Hold if you have an approval process for charges prior to billing them.
   Charges can be set to Non-Billable when you do not want to use the charge for billing purposes.
8. In the Recurrence field, set the frequency that charges are generated based on the project's percent complete.
9. In the Series Start Date field, enter the date you want this rule to begin.
10. Click Save.

Repeat this procedure for each project progress charge rule you want to use on the project.

**Time-Based Charge Rules**

Time-based rules generate charges when time entries are entered.

**To create a time-based charge rule:**

1. Click the Financial subtab.
2. Click the Time-Based Rules subtab.
3. Click the New Time-Based Rule button.

4. Enter a name for the rule.

5. In the Rule Order field, enter where this rule should run relative to other time-based charge rules.

6. Choose whether charges created by this rule are created with the stage of Ready, Hold, or Non-Billable.

   Charges can be set to Hold if you have an approval process for charges prior to billing them.
   Charges can be set to Non-Billable when you do not want to use the charge for billing purposes.

7. On the Rates subtab, in the Rate Basis field, choose how rates are determined for charges created with this rule. Choose one of the following:
   - **Billing Classes** — displays a list of Rate Cards where this billing class is used. If you use the Per-Employee Billing Rates feature, you can calculate charge rates based on billing classes assigned to your project resources. If you also use billing rate cards, select a rate card for this charge rule.
   - **Resources** — This option lets you set rates for each resource. These rates are set on employee records under the Human Resource subtab on the Rates subtab and on vendor records under the Financial subtab on the Rates subtab. Rates set on the project task are not used for charge calculation.
   - **Service Items** — This option takes the rate from the service items selected on the time entries logged for this project.

8. In the Rate Multiplier field, enter a decimal number you want to multiply the calculated rate by to determine the billable amount for the charges created by this rule.

9. If you want to round the time logged for this project for the purpose of charge calculation, select a rounding method.

10. If you selected Resources as your rate basis and wish to use custom interval billing rates, you must select a units type and sale units. For more information, see Custom Interval Billing Rates.

11. If you want to set a cap for this rule, in the Cap Type field, select how you want to cap the charges generated by this rule.

    For more information on capping time-based rules, see Using Caps with Charge Rules.

12. Enter the number of hours or currency amount you want to serve as the cap.

13. Check the Do Not Bill Entries Exceeding Cap box if you do not want the value above the cap to be billed to the customer.

    You can use this option if you bill for time in advance for projects. For more information, see Billing for Time in Advance.

14. If you selected Billing Classes or Service Items as your rate basis, click the Filters subtab. Enter any criteria you want to use to determine which time entries are used to generate charges. For example, if you charge different rates for regular and overtime labor, you might filter a rule to apply only to a certain class.

15. If you selected Resources as your rate basis, in the Resources section, you can select resources in the Name field and enter rates in the Rate field. Alternatively, you can click the Copy Resources
from Tasks button to automatically copy each assigned or allocated resource and their defined rate. Each resource must have a rate defined in the project's currency to be copied. Enter any criteria you want to use to determine which time entries are used to generate charges.

16. Click Save.

Repeat this procedure for each time-based charge rule you want to use on the project.

**Note:** It is recommended that you enable the Asynchronous Project Plan Recalculation preference when using time-based charge rules. This preference allows project plans to be recalculated in the background when time is tracked against a project. To enable the preference, go to Setup > Company > Preferences > General Preferences. Check the Asynchronous Project Plan Recalculation box, and click Save.

### Custom Interval Billing Rates

You can create custom interval billing rates by selecting a units type and sale units on service items, billing classes, or time-based charge rules. For example, you can create a time-based charge rule to generate charges for a daily billing rate based on a specific billing class.

**Note:** The Multiple Units of Measure feature is required to use custom billing rates. For more information, see the help topic Multiple Units of Measure. To use custom billing rates with billing classes, you must also enable Per-Employee Billing Rates. For more information, see the help topic Using Billing Classes.

You define the units and rate by creating a new unit of measurement at Lists > Accounting > Units of Measure > New. For more information on creating a new unit of measure, see the help topic Setting Up Units of Measure. After you have created your new unit of measure, you can set up a custom interval billing rate.

Custom interval billing rates can be applied to service items, billing classes, or directly on time-based charge rules.

#### To set up a custom interval billing rate for a service item:

1. Create a new unit of measure for your custom interval. For more information on creating a new unit of measure, see the help topic Setting Up Units of Measure.
2. Go to . Click Edit next to the service item you want to use to charge your custom interval. For information on creating a new service item, see the help topic Creating Item Records.
3. In the Units Type field, select the name of the unit of measure you want to use for this service item.
4. In the Sale Units field, select the unit of measure you want this item to be sold in.
5. On the Sales/Pricing subtab, under Price Levels, enter a price in the Base Price field. This is the base price for the interval selected in the Sale Units field.
6. Click Save.

Repeat the process above for each service item you want to use a custom interval billing rate for. When you create a time-based charge rule, you can now select Service Items in the Rate Basis field to apply your custom interval billing rate.

#### To set up a custom interval billing rate for a billing class:

1. Create a new unit of measure for your custom interval. For more information on creating a new unit of measure, see the help topic Setting Up Units of Measure.
2. Go to Setup > Accounting > Billing Classes. Click Edit next to the billing class you want to use for custom interval billing. Click New to create a new billing class.

3. Enter a price in the Price field. This is the base price for the interval selected in the Sale Units field.

4. In the Units Type field, select the name of the unit of measure you want to use for this billing class.

   **Important:** The same units type is required on both the billing class and service item when using billing classes for custom interval billing rates. The sales units may differ but the units type must match for both records on each charge.

5. In the Sale Units field, select the unit of measure you want this class to be charged in.

6. Click Save.

Repeat the process above for each billing class you want to use a custom interval billing rate for. When you create a time-based charge rule, you can now select Billing Classes in the Rate Basis field to apply your custom interval billing rate.

In addition to billing classes and service items, you can create time-based charge rules with custom interval billing rates based on set resource rates. To do this, when creating the time-based charge rule, select Resources as the rate basis. You can then select a Units Type and Sale Units directly on the charge rule. When the rule generates charges, the resource rate is used to create charges for the selected interval.

After you have set up your custom interval billing rates and created a time-based charge rule for that rate, when time is entered on your charge-based project, charges are generated using the custom interval billing rate. For more information, see Understanding Charge Rules.

### Expense-Based Charge Rules

Expense-based rules generate charges when expenses are entered.

**To create an expense-based charge rule:**

1. Click the Financial subtab.
2. Click Expense-Based Rules.
4. In the Name field, enter a name for your charge rule.
5. Enter a description for this rule.
6. In the Discount / Markup field, you can enter a discount or markup for expenses charged through this rule. You must enter the portion of the expense you want charged. For example, if you want to offer a 25% discount on mileage expenses you would enter 0.75 in this field. If you wanted to offer a 25% markup, you would enter 1.25.
7. In the Initial Charge Stage field, choose whether charges created by this rule are created with the stage of Ready or Hold.
   Charges can be set to Hold if you have an approval process for charges prior to billing them.
8. Enter the rule order for this charge rule.
   Expense-based charge rules are run in order. Any expenses entered can only generate charges from a single charge rule. You may have multiple rules for each project but each expense will only generate charges from the first rule that applies to it.
9. Under Filters, enter any additional criteria you want to use to determine which expenses are used to generate charges.
For example, if you charge different mark ups and discounts for expenses, you might filter a rule to apply only to a certain expense item.

10. Click Save.

Repeat this procedure for each expense-based charge rule you want to use on the project.

**Important:** Prior to entering expenses for projects, you must create expense items and associate those items with expense categories. Without both an expense item and category you cannot mark entered expenses as billable. Expenses must be marked billable for expense-based rules to generate charges for those expenses. For more information, see the help topics Expense Items and Creating an Expense Category.

### Purchase Charge Rules

Purchase charge rules generate charges when purchase transactions are entered against the project. Purchase charge rules include non-inventory and service items. Purchase orders are used to generate forecast charges. Vendor bills are used to generate actual charges.

**To create a purchase charge rule:**

1. Click the Financial subtab.
2. Click Purchase Rules.
3. Click New Purchase Rule.
4. Enter a name for the rule.
5. In the Cap field, enter the maximum amount this rule can generate.
6. In the Rate Multiplier field, enter a decimal number you want to multiply the calculated rate by to determine the billable amount for the charges created by this rule. For example, to add a 10% markup, you would enter 1.1 to increase the rate by 10%.
7. In the Rule Order field, enter where this rule should run relative to other purchase charge rules.
8. Choose whether charges created by this rule are created with the stage of Ready, Hold, or Non-Billable. Charges can be set to Hold if you have an approval process for charges prior to billing them. Charges can be set to Non-Billable when you do not want to use the charge for billing purposes.
9. Under Filters, enter any additional criteria you want to use to determine which purchases are used to generate charges.
   For example, if you charge different mark ups and discounts for items, you might filter a rule to apply only to a certain noninventory item.
10. When you have finished, click Save.

Repeat this process for each purchase charge rule you want to generate charges. Any project with an existing purchase charge rule cannot bill vendor bill transactions directly. Any vendor bill charges must come from the purchase charge rule.

### Creating Charge Rules from Sales Orders

You can create project charge rules for charge-based billing projects directly from line items on sales orders. You must select a charge-based billing project in the Project field for the sales order. Project charge rules can be added to service items selected on sales orders for charge-based billing projects.
Creating charge rules on sales orders is not compatible with the Consolidate Projects on Sales Transaction preference located at Setup > Accounting > Accounting Preferences > Items/Transactions > Sales & Pricing. Any charge rule created on a sales order cannot be edited on the project record.

You must first customize your sales order form to add the Project Charge Rule field to the Items subtab. For more information, see the help topics Creating Custom Entry and Transaction Forms and Configuring Sublist Fields.

After you have added the field to your custom form, you can select or create a project charge rule from the Project Charge Rule field on sales orders. For more information on creating charge rules, see Creating Charge Rules.

Editing Charge Rules

In most cases, fixed fee and expense-based charge rules cannot be changed after actual charges have been generated. Time-based and purchase charge rules can be updated at any time. When you update a time-based or purchase rule, all forecast charges for that rule are recalculated to the beginning of the project. Charge rules must be edited from where they were created, either the project record or the sales order.

Using Billing Rate Cards

If you use billing classes, you can also enable billing rate cards to define different billing rates for groups of billing classes. These rate cards can then be used to set billing rates on charge-based projects using time-based charge rules. For example, you may negotiate different rates for various roles required to complete projects for your customers. Customer A is billed at 150 per hour for a project manager, 75 per hour for a consultant, and 50 per hour for an analyst. Customer B is billed 200 per hour for a project manager, 150 per hour for a consultant, and 75 per hour for an analyst. You can create two different rate cards using the same billing classes to define the different rates.

It is possible to define rate card specifically for a project and also assign a customer to this rate card. This new rate card is only applicable on projects associated with the defined customer. The Related Records subtab on the billing rate card record lists all projects related to the rate card. New customer records also include a Billing Rate Card field which defines the default rate card for each customer. Also displayed is a list of projects where Rate Card is used. Previously, the Billing Rate Card field was hidden by default and could only be exposed using form customization. Now this field is available for new charge-based billing projects and you can select a customer specific rate card or a generally available rate card for billing your project.

When a specific customer is defined on the rate card, the rate card is locked to that specific customer. Users are not able to change the customer on projects where customer-specific rate card is applied. For more info on changing customer, see Creating a Project Record.

When creating a new charge based project with a rate card, you can check the Create Charge Rule box to automatically create time-based charge rules based on the selected rate card.

⚠️ Important: Charge-Based Billing and Per-Employee Billing Rates are prerequisites for using Billing Rate Cards.

To enable billing rate cards, go to Setup > Company > Enable Features and click Employees. Under Time & Expenses, check the Billing Rate Cards box. Click Save.

After you have enabled the feature, you can go to Setup > Accounting > Billing Rate Cards > New to create your billing rate cards. Billing class records will no longer contain a field for defining rates. You must define rates for billing classes used for projects on billing rate cards. A default billing rate card is automatically created after the feature is enabled with your existing billing classes and default rates.
To create a billing rate card:

1. Go to Setup > Accounting > Billing Rate Cards > New.
2. Enter a name for your rate card.
3. If you use Multiple Units of Measure, select a unit type and sale unit for the first billing class listed.
4. Enter a price for the billing class.
   If you use Multiple Units of Measure and you enter a price before selecting a units type and sale unit other than the defined base unit, NetSuite will multiply the price as the base price for the selected sale unit.
5. Continue defining prices for each billing class.
6. When you have finished, click Save.

When billing class is selected as the basis for time-based charge rules, a required Billing Rate Card field is available to select the rate card for the new rule. It is possible to display rate cards on billing class and to display on Billing Rate Card record list of those projects where the Rate Card is used. Also Billing Class and Service Item can be associated on a Rate card.

You can copy an existing billing rate card by selected Make Copy from the Actions menu on the rate card you want to copy.

Each customer can have a default rate card defined on the customer record or directly on Projects. When you create a new charge-based project for that customer, the default billing rate card is used when creating new time-based charge rules. The Billing Rate Card field is hidden by default on the customer record and you can add this field by customizing your customer record. For new customer you can make this field on Customer record visible by default.

For more information, see the help topics Creating Custom Entry and Transaction Forms and Configuring Fields or Screens.

After you have created a billing rate card, you can add an effective date to change and apply new rates without creating a new rate card. For example, you have a contract to complete the first 30 days of labor on a project at a special discounted rate. You can create a billing rate card for your customer that begins at the negotiated special rate and changes to the regular rate on a specified date.

To create a new version of a billing rate card:

1. Go to Setup > Accounting > Billing Rate Cards.
2. Click View next to the rate card you want to add a version for.
3. Click Create New Version at the top of the page.
4. In the Effective Date field, select the date you want the new rates to go into effect.
5. In the Modify By (%) field, you can enter a percentage by which to increase or decrease all the rates on this rate card. For example, enter 5 to increase all the listed prices by five percent. You can enter a negative number to decrease all the rates.
6. You can also update individual rates by changing the values in the Currency field.
7. When you have finished, click Save.

The previous rate card remains in effect until the date selected on the new version of the rate card. Rate cards do not have expiration dates. The current rate card remains in effect until a new version is created.

When you have more than one version of a rate card, you can delete the last version from the Actions menu when viewing or editing the last version of the rate card. To delete the last version of a billing rate card, under Actions, click Delete Last Version. A window opens where you can enter a reason for deleting.
Using Caps with Charge Rules

With time-based charge rules, you can create caps that allow you to limit the amount of work a charge rule is applied to.

For example, you might apply a different rate to any time entered beyond your initial project estimate. You could create a time-based rule with a cap on the hours it is applied to. This cap would equal the hours of the project estimate. A second time-based rule would be applied only to hours beyond the estimate.

Time-based charge rules can split time transactions when fulfilling billing caps. Billing caps for time-based rules are honored and do not require an exact match from time transactions.

For example, you create a time-based charge rule with a billing cap of 10 hours. Your project resource tracks eight hours and six hours toward the project on two consecutive days. When you generate charges, the rule will generate charges for the eight hours plus two additional hours from the second day. The remaining four hours from the second day are listed on the time transaction as remaining time. If additional time-based rules are used to generate charges, the remaining four hours will be used to fulfill any new rules.

When a time transaction has time remaining or generates charges from multiple rules, the Charges subtab is displayed on the time transaction with a list of the corresponding charges.

Caps are applied for the life of the project. When using caps, it is essential that you set the order that time-based rules are applied in the Rule Order field. When an rule has reached its cap, it is no longer applied.

Billing for Time in Advance

If you bill for a portion of a project up front, you can use a charge rule cap to keep from billing for the time the customer pays for at the beginning of the project. For example, you create a project with an estimated 200 hours of work. You bill for the first 40 hours up front before work begins on the project.

In this example, the up front charge would be generated by a fixed date rule. You would then create a time-based rule for the up front charge. This rule would have a cap of 40 hours, have Rule Order set to 1, and a Rate Multiplier of 0 so that the customer is not billed again for the up front charge. Additional time-based rules would be created for the time beyond 40 hours.

Note: Caps are not available for fixed fee or expense-based charge rules.

Generating Charges

Actual charges are amounts calculated from charge rules and can be billed to customers. Actual charges are generated daily for updated projects that have a status of In Progress. For milestone and project progress rules, charges are generated when a milestone is marked completed.

Note: Automatic updates for charges and forecasts take into account the time zone of the company or subsidiary.

If you have made changes to a project and want to generate the charges manually, view the project record, click the Financials subtab on the project, and then click the Charge Run History subtab. Click the
Generate Charges button to generate actual charges. Click Generate Forecast to update the forecast charges.

When charges or forecasts are manually generated, a status bar appears at the top of the project with a time estimate for the availability of the updated charges or forecasts. This bar will remain visible and will update each time the project is refreshed until the charge run is complete.

**Note:** The Generate Charges and Generate Forecast buttons are not available when editing the project record.

You can also create charges manually at Transactions > Customers > Create Charges.

In NetSuite OneWorld, for time-based charges, when a charge is generated and the department, class, or location of the time transaction is not available in the project's subsidiary then the new charge will not have a department, class, or location set. For expense-based charge rules, when a charge is generated and department, class, or location of the expense report is not available in the project's subsidiary then the new charge has department, class, or location fields set to the default values for the project's subsidiary.

### Forecast Charges

Forecast charges are used to calculate sales forecast amounts on reports and in the cost, revenue, and profit estimate fields on the project record.

Forecast charges are automatically generated when a project plan or project task is saved, time is tracked, or a new charge rule is created. This keeps forecast charges up-to-date when a change is made.

**Note:** When using searches and reports for forecast charges, date filters may exclude active projects. For example, if you run a saved search filtering for the current quarter, projects without planned time during this quarter may not appear in your results even if the projects are still active. Search and report results for forecast charges may also change from day to day due to project and task changes, tracked time, new charge rules, or nightly forecast updates.

A project preference is available to limit the refreshing of forecasts when projects are updated. The Forecast Charge Run on Demand preference is disabled by default. When enabled, forecasts will only be updated when manually generated or with the regular nightly charge run. Enabling this preference can help alleviate any potential performance issues from forecast updates.

After a forecast charge has been generated for a charge rule, a new forecast is not created unless a change is made that impacts that forecast (such as an update to the charge rule or to the estimated work for a task.) When a forecast charge requires an update, the old forecast charge is deleted and a new one is generated.
You can initiate the generation of forecast and actual charges on the Charge Run History subtab on the project.

If your charge rules are based on service items, after a forecast has been generated, you can refresh items on sales transactions to include the service items from the forecast. The forecasted items are added to the sales transaction based on the rules you have created. The actual charges do not need to be created to add forecasted charges to a sales transaction. For more information on how to refresh project items, see Refreshing Project Items on Transactions.

**Items and Billing Schedules with Charge-Based Billing**

Charge-based billing uses service and expense items to associate charges with sales transactions and to set the income account for charge-based project revenue.

For time-based charge rules, service items are not always used to determine the billing rate for charges but are instead used to categorize charges on transactions. The pricing defined on service items is only used if you choose to use the service item price to determine the rate for time-based charge rules.

A billing schedule can be set for a charge-based project, but billing frequency is always determined by the charge rule. The billing schedule is only used to calculate and group items on sales forecasts.

**Approving Pending Charges**

The Charges Summary fields on a project record provides a quick view of the amount billed, the charges that are pending billing, and the remaining forecasted revenue of the project.

After charges are generated, you can click the Pending amount on the project to open the Manage Pending Charges page and manage any unbilled charges.

From the Manage Pending Charges page, you can change the charge stage or zero charge amounts out.

**Billing Charge-Based Projects**

Charges with the stage Ready for Billing can be included on a sales order entered for a project. When you create a project sales order, those charges are on the Items subtab grouped by service or expense item. The rates on these line items come from the charge record. Billing charge-based sales orders follows the standard invoicing process.

When using charge-based billing for a project, you must create at least one expense-based rule if you intend to include expenses automatically when charges are generated. If you create fixed fee or time-based rules and do not create any expense-based rules, any expenses entered and marked as billable will not appear in your customer invoices without manually creating charges for those expenses.

Billed charges are reflected in the Charges Summary fields on the project record.
**Important:** When creating a project record, on the Preferences subtab, NetSuite advises you to enable the *Create Planned Time Entries* preference. This preference populates the *Estimated Work* field. Estimated work is used to calculate estimated labor revenue. Estimated labor revenue is used to calculate remaining charges for your project. If you do not enable this preference, your Charges Summary may report inaccurate totals for remaining charges.

### Project Billings Report

The Project Billings Report presents the billed value of projects. This report includes the billings to date, pending charges, and the total current billing amount as well as the forecasted billing total for each project. You can filter the projects shown on this report by project status by changing the Customer Status field in the footer of the report. By default, this report is filter to show In Progress projects only.

Go to Reports > Time & Billables > Project Billing Report.

A message appears indicating that your report is loading. The status bar in the footer of the report indicates the progress as your report loads. You can click Cancel Report next to the status bar to stop the report from loading.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

### Project Revenue Recognition

The Project Revenue Recognition feature enables you to defer revenue for charge-based projects using advanced revenue management without generating sales orders. You can recognize the deferred revenue independently from customer billing across future periods according to rules you configure.

**Important:** Project Management, Charged-Based Billing, and Advanced Revenue Management are all required to use Project Revenue Recognition.

To use Project Revenue Recognition, create project revenue rules based on your existing charge rules for the project. You can create as charged, percent complete, fixed amount, and labor-based project revenue rules. These revenue rules determine how much and how often you recognize the revenue created by your project. After you have created your project revenue rules, revenue arrangements, elements, and plans are created automatically for your project revenue. For more information, see Charge-Based Project Billing and Advanced Revenue Management.

### Project Revenue Rules

Project revenue rules rely on charge rules to determine the amount of revenue to be distributed. The type of project revenue rule you create is determined by how you want the revenue to be recognized. Use as charged rules if you intend to recognize revenue as it is incurred, regardless of your invoicing schedule. As charged rules are particularly relevant for time & materials style projects which do not have fixed total amount and are billed in hourly or daily rates. As charged project revenue rules recognize revenue from actual project charge dates and revenue values.

Use as charged rules if you need to create an invoice for a long term project, and want to add more data for past charges. As charged rules are not a good option for adding the data regularly, for example, on a monthly basis. We recommend using as charged project revenue rules for the following project billing types:

- Standard Setup, Time and Materials
- Fixed Bid, Progress Billing
- Fixed Bid, Fixed Date
- Fixed Bid, Milestone Billing

The table below offers an overview of the different types of project revenue rules and charge rules and how they interact.

<table>
<thead>
<tr>
<th>Project revenue rule</th>
<th>Based on</th>
<th>Triggered by</th>
<th>Time-based charge rule</th>
<th>Fixed date charge rule</th>
<th>Milestone charge rule</th>
<th>Progress charge rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>As charged</td>
<td>Amounts as they are charged</td>
<td>Charges</td>
<td>Can be used if the billed amounts represent actual revenue value</td>
<td>Can be used as long as the billed amounts and charge dates represent actual revenue value</td>
<td>Can be used as long as the billed amounts and charge dates represent actual revenue value</td>
<td>Can be used</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Duration based project completeness or Percent complete override subtab</td>
<td>Duration/Time</td>
<td>Can be used if there is a fixed component or cap that needs to be incorporated</td>
<td>Can be used as long as the duration based percent complete represents the value or you want to utilize the Percent complete override subtab</td>
<td>Can be used as long as the duration based percent complete represents the value or you want to utilize the Percent complete override subtab</td>
<td>Use as charged if possible</td>
</tr>
<tr>
<td>Fixed amount</td>
<td>Defined schedule</td>
<td>Dates/Milestones</td>
<td>Can be used if you calculate amounts outside NetSuite</td>
<td>Can be used if you calculate amounts outside NetSuite</td>
<td>Can be used if you calculate amounts outside NetSuite</td>
<td>Can be used if you calculate amounts outside NetSuite</td>
</tr>
<tr>
<td>Labor-based</td>
<td>Amounts from tracked time</td>
<td>Time entries</td>
<td>Cannot be used under most circumstances, use as charged to align billing and revenue</td>
<td>Can be used if you need to incorporate different rates based on items or billing classes</td>
<td>Can be used if you need to incorporate different rates based on items or billing classes</td>
<td>Can be used if you need to incorporate different rates based on items or billing classes</td>
</tr>
</tbody>
</table>

**Note:** Expense-based charge rules are not available to use with Project Revenue Recognition.

Percent complete project revenue rules are best used for projects with a meaningful progress and in situations where you can define the completeness of your project. Use percent complete rules for an entire project, not for defining its individual parts. If you would like to use percent complete rules for more projects, create more items and apply the rules to each of them.

A percent complete project revenue rule recognizes revenue at a rate equivalent to the project’s progress. For example, you create a percent complete project revenue rule based on a charge rule with 300 in charges. In January, 10% of your project is completed, so 10% of 300 is recognized. In February, your project percent complete progresses to 15%, so an additional 5% of 300 is recognized bringing the total recognized revenue to 15%.

**Important:** Revenue is recognized during the accounting period in which the information is entered into NetSuite. Be aware that a delay in entering information may cause revenue to be recognized later than expected.

You can also use the Percent complete override subtab to define project revenue recognition, for more info, see the help topic Using the Percent Complete Override Subtab.
To create a percent complete project revenue rule:

1. Go to Lists > Relationships > Projects. Click View next to the charge-based project you want to create a project revenue rule for.
2. Under the Financial subtab, click Project Revenue Rules.
4. Enter a name for your rule.
5. Select a service item for your revenue rule.
   Only service items with both an income account and deferred revenue account selected on the item record will appear in the Service Item field.

   **Note:** The service item selected determines which accounts are used for the revenue element.

   Updates made to accounts on item records will not update previously created revenue elements.
6. In the Name column, select the name of the charge rule you want to use for this revenue rule.
7. Click Add.
   You can add multiple charge rules of the same type to each revenue rule. Time-based charge rules can be added to multiple revenue rules with differing service items.
8. When you have finished, click Save.

If you use Resource Allocations and the Use Allocated Time for Forecast project preference is enabled, allocated time versus actual time is used to calculate the project percent complete. If you do not use allocated time for forecasting, planned time versus actual time is used.

After your percent complete project revenue rule is saved, revenue elements, arrangements, and forecast plans are created with the next scheduled revenue recognition update. You can manually updated revenue arrangements and plans to create them immediately. When time is tracked on your project, your forecast revenue plans are converted to actual revenue plans. If you track time for a future date, that time is not considered a part of the actual revenue plan until that date is reached. For more information, see the help topics Updating Revenue Arrangements and Updating Revenue Recognition Plans.

An as charged project revenue rule recognizes the revenue from actual project charges as they are created rather than when they are billed.

To create an as charged project revenue rule:

1. Go to Lists > Relationships > Projects. Click View next to the charge-based project you want to create a project revenue rule for.
2. Under the Financial subtab, click Project Revenue Rules.
4. Enter a name for your rule.
5. In the Name column, select the name of the charge rule you want to use for this revenue rule.
6. Click Add.
   You can add multiple charge rules of differing types to an as charged project revenue rule as long as the charge rule has no charges in the billed state. An accounting preference is available to consider charges in the Hold state as revenue.
7. When you have finished, click Save.

After your as charged project revenue rule is saved, revenue elements, arrangements, and forecast plans are created with the next scheduled revenue recognition update. You can manually updated revenue
arrangements and plans to create them immediately. When charges are created for your project, your forecast revenue plans are converted to actual revenue plans. For more information, see the help topics Updating Revenue Arrangements and Updating Revenue Recognition Plans.

With fixed amount rules you can recognize fixed dates or milestones when they are reached. A fixed amount project revenue rule can recognize revenue based on a date, task, or milestone.

To create a fixed amount project revenue rule:

1. Go to Lists > Relationships > Projects. Click View next to the charge-based project you want to create a project revenue rule for.
2. Under the Financial subtab, click Project Revenue Rules.
4. Enter a name for your rule.
5. Select a service item for your revenue rule.
   Only service items with both an income account and deferred revenue account selected on the item record will appear in the Service Item field.
   
   **Note:** The service item selected determines which accounts are used for the revenue element.

   Updates made to accounts on item records will not update previously created revenue elements.
6. Under Charge Rules, in the Name field, select the name of the charge rule you want to use for this revenue rule.
7. Click Add.
   You can add multiple charge rules of the same type to each revenue rule. Time-based charge rules can be added to multiple revenue rules with differing service items.
8. On the Revenue Plan subtab, under Recognize Based On, select when you want this revenue recognized. You can select from the following:
   - **Date Recurring** – Under Date Recurring, define a recurring schedule to recognize the amount generated from the selected charge rules.
   - **Date Scheduled** – In the Recognize field, select to recognize an amount or a percentage of the total amount. Under Date Scheduled –, select a date and enter the amount or percentage. Click Add. Continue adding dates and amounts or percentages until all of the corresponding charges are scheduled to be recognized.
   - **Task Complete** – In the Recognize field, select to recognize an amount or a percentage of the total amount. Under Task Complete – Amount, select a project task and enter the amount or percentage. Click Add. Continue adding tasks and amounts or percentages until all of the corresponding charges are scheduled to be recognized.

   **Note:** Only tasks with resource assignments and planned time are available in the Task field. Tasks must be marked with a Complete status to generate actual revenue plans.

9. When you have finished, click Save.

After your fixed amount project revenue rule is saved, revenue elements, arrangements, and forecast plans are created with the next scheduled revenue recognition update. You can manually updated revenue arrangements and plans to create them immediately. When the event you defined on the Revenue Plan subtab occurs, your forecast revenue plans are converted to actual revenue plans. For more information, see the help topics Updating Revenue Arrangements and Updating Revenue Recognition Plans.
A labor-based project revenue rule recognizes the revenue created from time tracked on your project. We do not recommend using labor-based rules in most cases, use as charged rules to align billing and revenue.

**To create a labor-based project revenue rule:**

1. Go to Lists > Relationships > Projects. Click View next to the charge-based project you want to create a project revenue rule for.
2. Under the Financial subtab, click Project Revenue Rules.
4. Enter a name for your rule.
5. Select a service item for your revenue rule.
   Only service items with both an income account and deferred revenue account selected on the item record will appear in the Service Item field.
   
   **Note:** The service item selected determines which accounts are used for the revenue element. For labor-based rules, the service item also determines the charges that are considered revenue to be distributed. If you use multiple service items for your charges, you will need to create a labor-based project revenue rule for each service item.

   Updates made to accounts on item records will not update previously created revenue elements.

6. Under Charge Rules, in the Name field, select the name of your charge rule to determine how much revenue should be recognized.
   
   **Note:** Planned time entries are required for labor-based project revenue rules.

7. Click Add.
   You can add multiple charge rules of the same type to each revenue rule. Time-based charge rules can be added to multiple revenue rules with differing service items.

8. On the Rates subtab, in the Rate Basis field, choose how rates are determined for revenue recognized with this rule. Choose one of the following:
   
   - **Billing Classes** — If you use the Per-Employee Billing Rates feature, you can calculate revenue rates based on billing classes assigned to your project resources.
   - **Resources** — This option lets you set rates for each resource. These rates are set on employee records under the Human Resource subtab on the Rates subtab and on vendor records under the Financial subtab on the Rates subtab. Rates set on the project task are not used for revenue calculation.
   - **Service Items** — This option takes the rate from the service items selected on the time entries logged for this project.

9. In the Rate Multiplier field, enter a decimal number you want to multiply the calculated rate by to determine the recognized amount for the revenue created by this rule.

10. If you want to round the time logged for this project for the purpose of recognized revenue calculation, select a rounding method.

11. If you selected Resources as your rate basis you must select which resources you want to use for this revenue rule and define a rate for each resource.

12. Click the Filters subtab.

13. Enter any criteria you want to use to determine which time entries are used to generate revenue.

14. When you have finished, click Save.
After your labor-based project revenue rule is saved, revenue elements, arrangements, and forecast plans are automatically created. When time is tracked on your project, your forecast revenue plans are converted to actual revenue plans.

**Rev Rec Percent Complete Override subtab**

The Rev Rec Percent Complete Override subtab is used to override a project revenue plan. This subtab works with Advanced Revenue Management and percent complete project revenue rules.

For more information on Advanced Revenue Management, see the help topics Advanced Revenue Management for Projects and Using the Percent Complete Override Subtab.

To override a project revenue plan created from a percent complete project revenue rule, add lines to the Percent Complete Override subtab for the accounting periods you want in the plan. On each line, select an Accounting Period and enter a value for Cumulative Percent Complete. You can decrease the values entered on the Percent Complete Override subtab and plans are adjusted accordingly. Because the values are cumulative, you cannot skip periods.

If you also want to override forecasts, check the Use Percent Complete Override for Revenue Forecasting on the Financials subtab of each project record.

When the Use System Percentage of Completion for Schedules preference is enabled at Accounting Preferences > General > Revenue Recognition, NetSuite calculates the project progress percentage based on time tracked against the project. If values are entered manually on the Percent Complete Override subtab on the project record, these values are used instead of the automatically calculated ones. If there are missing periods not accounted for on the Percent Complete Override subtab, NetSuite uses the automatically calculated values for the missing periods.

When the Use System Percentage of Completion for Schedules preference disabled, the percentage of project completion must be entered manually on project records on the Percent Complete Override subtab.

**Project Revenue Reconciliation**

After you have completed your project and billed all associated charges, you must reconcile your revenue and your charges. When you create charges rules and project revenue rules, NetSuite uses forecast charges and plans to estimate your charges and revenue. It is possible to have actual charges that differ from these estimates. In order to reconcile your charges and revenue with actual numbers it is important to close out each project by marking it completely billed.

**To mark a project as completely billed:**

1. Go to Lists > Relationships > Projects. Click **Edit** next to the charge-based project you want to close.
2. In the **Status** field, select **Closed**.
3. Click **Save**.
4. On the project record, click **Billed Completely**.
   
   A warning pops up requiring you to confirm your choice. If you are sure all charges have been billed, click **OK**.

After you have marked the project as completely billed, recognized revenue is adjusted to be reconciled with actual charges. For example, if your actual charges were less than the forecasted charges resulting in more revenue than required, negative revenue will be applied to even out the discrepancy. The opposite would be true if your forecasted charges were underestimated.

After a project has been marked as completely billed, you will no longer be able to edit the status of the project. A completely billed flag is noted in the system information for the project and each reconciled project revenue rule.
You can reopen a project that has been marked as completely billed. A completely billed project includes an Open Project button. Clicking the Open Project button will reopen the project and create reversal journal entries for any reconciling entries made when the project was marked as completely billed. Any projects that have been reopened will need to be reconciled again once all charges have been billed.
Job Costing and Project Budgeting

**Important:** For information on the availability of Job Costing and Project Budgeting, please contact your account representative.

Job Costing and Project Budgeting help track project profitability and relate that profitability back to your general ledger.

**Job Costing**

Job Costing lets you calculate costs for labor based on tracked time, and account for those costs in your general ledger.

Job Costing utilizes a project expense type to determine which account project costs are attributed to when time is posted for that project. Project expense types can be set by the project or by the service item used when entering time. By default, Regular and Overhead project expense types are set up with direct and indirect labor accounts respectively. You can set up or edit project expense types at Setup > Accounting > Project Expense Types. For more information, see Creating Project Expense Types.

**Note:** When you enable Job Costing, each project is automatically assigned the Regular project expense type. You can change the associated project expense type by editing individual project records.

When an employee enters time worked on a project in NetSuite the cost of that time is calculated based on the employee's labor cost. After that time is approved, it can be posted. Posting time creates a journal entry debiting the account associated with the assigned project expense type and crediting the selected project cost variance account. For more information, see Posting Time Transactions.

If you use OneWorld, you can use Job Costing to transfer the associated cost of a resource from one subsidiary to another using the posting time function and intercompany time adjustments. When the time is posted, journal entries are created to account for the cost in your general ledger. The costs are reflected in real-time in on the project record P&L subtab and in the Project Profitability report. When closing an accounting period, intercompany journal entries are created to transfer the job cost from the employee's subsidiary back to the project's subsidiary. For more information, see Job Costing and OneWorld.

**Project Budgeting**

Project Budgeting lets you set cost and billing budgets for project labor and expenses at both the project and task level. When you enable the Job Costing and Project Budgeting feature, a Budget tab is added to set budgets on project and project task records. Budgets can be set up on a monthly basis. Budgets set at the project task level are rolled up to the project level.

Cost and billing categories that are available on the Budget tab are defined at Setup > Accounting > Accounting Preferences > Projects. From the project or task record, you can choose to define budgets manually by entering values on the Budget tab or you can have budget amounts set using calculated values. If you also use Resource Allocations, you can choose to automatically calculate labor budgets based on allocated resources. For more information see, Setting Up Project Budgeting.

**Profit and Loss Subtab**

When you enable Job Costing and Project Budgeting, a P&L subtab is added to project records. The P&L subtab displays the current revenue, cost, profit, and margin for your project. The information displayed
is in real time and enables you to gauge the current profitability status of your project. The following information is displayed for each category:

<table>
<thead>
<tr>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor</td>
<td>Invoice amounts created from employee time-based charges</td>
<td>Journal entries created from posting time tracked towards projects</td>
<td>Revenue — Cost</td>
</tr>
<tr>
<td></td>
<td>Invoice amounts created from fixed fee charge rules</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Billable time on customer invoices</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expense</td>
<td>Invoice amounts created from employee and vendor expense-based charges</td>
<td>Approved employee expense reports</td>
<td>Revenue — Cost</td>
</tr>
<tr>
<td></td>
<td>Billable expenses on customer invoices</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplier</td>
<td>Invoice amounts created from vendor time-based charges</td>
<td>Approved vendor bills, except for inventory items</td>
<td>Revenue — Cost</td>
</tr>
<tr>
<td></td>
<td>Billable items on customer invoices</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Items on customer invoices; including service items, non-inventory items, inventory items. Items from sales orders to invoices will display here.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Reporting**

The following reports are available for Job Costing and Project Budgeting:

- Project Cost Budget vs. Actual
- Project Billing Budget vs. Actual
- Project Task Cost Budget vs. Actual
- Project Task Billing Budget vs. Actual
- Project Profitability

Budget vs. Actual reports are available at the project and project task level for both cost and billing budgets. These reports enable you to analyze budgeted and actual project financials to determine how closely your costs and billings compare to those you originally budgeted. The categories that appear on project level reports match those that are set up to appear on project budgets. Project task level reports include labor only. Both summary and detail reports are available at the Project level.

The Project Profitability Summary and Detail reports compare actual project revenue and costs to show each project’s profitability. The report is organized by project and further broken down into categories.

Each of these reports are available to be customized with the NetSuite Report Builder. To view these reports, go to Reports > Projects. For more information, see Project Management Reports.

**Job Costing**

**Important:** For information on the availability of Job Costing and Project Budgeting, please contact your account representative.

You can use the feature Job costing to reflect the cost of project labor in your general ledger by using time tracked against projects. The Job Costing also requires Project Management and the ability to track time in NetSuite. For more information, see Enabling Project Features.
Job costing uses a project expense type to determine the account to debit when posting time transactions. Each time transaction has an associated project expense type assigned from the corresponding service item or project.

When time is posted, a journal entry is created debiting the assigned account and crediting your selected project cost variance account.

To pay employees for project work, you should use a manual journal entry to debit the selected project cost variance account when payroll is complete. For more information, see the help topic Making Journal Entries.

**Setting the Default Project Cost Variance Account**

Before you begin posting time transactions, you can create or update project expense types and select your default project cost variance account.

1. Go to Setup > Accounting > Accounting Preferences.
2. Click Items/Transactions.
   
   You can change this account when posting time transactions.
4. Click Save.

For more information on project expense types, see Creating Project Expense Types.

**Creating Project Expense Types**

**Important:** For information on the availability of Job Costing and Project Budgeting, please contact your account representative.

With Job Costing, each new and existing project must have a project expense type selected on the project record. The selected project expense type tells NetSuite which account to debit when posting time transactions for job costing. When you enable job costing, two default project expense types are created – Regular and Overhead:

- The Regular expense type is mapped to the Direct Labor account by default.
- The Overhead expense type is mapped to the Indirect Labor account.

You can update these project expense types or create new project expense types to reflect your company's current business processes.

**Note:** After you enable Job Costing, each existing project must have a project expense type selected. The Regular project expense type is automatically assigned to all existing projects. You can update this setting on the Financial subtab of individual project records.

**To create a project expense type:**

1. Go to Setup > Accounting > Project Expense Types > New.
2. Enter a name for this project expense type.
3. In the Description field, you can enter a description for the type of project this expense type should be used for.
4. In the Account field, select the account you want NetSuite to debit when users post time transactions with this project expense type.
5. When you have finished, click Save.
All new and existing project records must have a project expense type selected on the Financial tab under Costing. You can also choose to select a project expense type on service items.

**Adding Project Expense Types to Service Items**

**To add project expense types to service items:**

1. Go to Lists > Accounting > Items.
2. In the **Type** field at the bottom of the list, select **Service**.
3. Click **Edit** next to the item you want to update.
4. Click the **Accounting** subtab.
5. In the **Project Expense Type** field, select an expense type.
6. Click **Save**.

When a time transaction is posted with a service item, the expense type on the service item overrides the expense type on the project, unless **The Apply to All Time Entries** box is checked on the project record.

**Posting Time Transactions**

⚠️ **Important:** For information on the availability of Job Costing and Project Budgeting, please contact your account representative.

After you have defined and assigned your project expense types and set your default project cost variance account, you can begin posting time transactions. When a time transaction is saved and approved, it is available for posting.

**Setting Preferences for Job Costing and Project Budgeting:**

When you are posting time for Job Costing, the default preference for grouping the journal entries is by project. You can also set a company-wide preference for grouping journal entries by employee, class, department, or location. To set preferences for Job Costing and Project Budgeting, do any of the following:

1. Go to Setup > Accounting > Accounting Preferences.
2. Click the **Projects** subtab.
3. Under the **Post Time**, in the **Group by Field**, select how you want to group the job costing journal entries.

The selected task record determines the labor cost for posted time transactions. When creating a project task, you must assign each employee who works on the task with the labor cost. The employee labor cost can be overridden first at the project level and then the project task level, if desired.

**To post time transactions:**

1. Go to Transactions > Financial > Post Time.
2. If you want to update the **Project Cost Variance Account** list, select a different account from the list. By default, it is populated with the selected default project cost variance account. See “Setting the Default Project Cost Variance Account” for more.
3. In the **Posting Period** field, select an open accounting period.

   NetSuite dates each created journal entry with the date of posting. Depending on your company’s accounting settings, it may be possible to post time for transactions outside the selected period.
4. To filter the list of time transactions, do any of the following:
   - In the **Employee** field, select an employee.
   - In the **Date** field, enter or select a date.

5. To view any time transaction:
   - Click on the date of the time transaction.
   - To return to the Post Time page, click **Back**.

6. Check the box in the **Post** column for each time transaction you want to post.

   **Note:** You can select all time transactions on the current page by checking the **Mark All** box at the top of the column. If you have multiple pages you want to post, after checking **Mark All**, check the Select all time entries box to post all available time transactions.

7. When you have finished, click **Submit**. A status page appears.
8. Click **Refresh** to update the status.

After a time transaction has been posted, you can view the journal entry at Transactions > Financial > Make Journal Entries > List. Posted time is used to calculate labor cost when determining project profitability. For more information, see **Project Profitability Report**.

**Important:** Journal entries created from posting time are stamped with the date and time they are posted, not the date and time of the original time transaction entry.

### Searching for Time Transaction Journal Entries

**To search for time transaction journal entries:**

2. In the **Filter** field, select **Time**. A popup window appears.
3. In the **Time** field, select none of. Click the arrow button **Next** to the multiple select field.
4. Select **-None-** and click **Set**
5. Click **Submit** to run the search.
   - NetSuite displays a list of all journal entries created from time transactions.

### Manually Marking Time as Posted

On time transactions, a **Posted** field is available. You can mark this field manually or automatically by posting time. The **Posted** field is visible only to roles with the Post Time permission.

**Note:** Manually marking a time transaction as posted should be used only for time transactions that have been previously accounted for and then imported into NetSuite. Any new time transactions created in NetSuite should be posted through the Post Time page at Transactions > Financial > Post Time.

The **Posted** field is displayed on approved time entries in edit mode when the time is associated with a project. The field is available for customization, SuiteScript, searching, and SuiteFlow. If you check
the Posted field, the status of the time transaction changes to Posted. The transaction is no longer available for posting and it appears on the Void Time page. Manually checking the Posted box on a time transaction does not create a corresponding journal entry. Voiding a manually checked time transaction clears the Posted box.

When you use Charge-Based Billing, you can no longer edit the time transactions associated with charges. With Time Tracking, there is a new Mark as Posted button available in view mode to manually mark a time transaction with charges as posted. You can click the Void button on manually posted time transactions to clear the Posted box.

**Important:** The Mark as Posted and Void buttons are available only with Time Tracking.

**Voiding Time Transactions**

After you post the time transactions, you can no longer edit or delete them. To make changes or delete an already posted time transaction, you must void the time posting.

**Important:** If several time transactions were posted with a single journal entry, and you void that journal entry, all associated time transactions become voided.

**To void a time transaction posting:**

2. If your company uses reversing journals, select an accounting period in the **Posting Period** field.
   - Each reversing journal entry created is dated with the date of posting. Depending on your company's accounting settings, it may be possible to void time for transactions outside the selected period.
3. In the **Employee** field, you can filter the time transactions by selecting an employee.
4. Check the box in the **Void** column for each transaction you want to void.
5. Click **Submit**.
   - Netsuite displays a warning that all associated time entries will be voided.
6. Click **OK** to proceed.

After a posted time transaction has been voided, you can edit or delete the transaction if necessary. When the time transaction is approved again, it is available to be posted.

**Job Costing and OneWorld**

The Job Costing feature allows OneWorld users to transfer the cost of a resource from one subsidiary to another using the posting time function and intercompany time adjustments.

For example, your Canadian subsidiary requires project tasks to be completed by an employee of your Japanese subsidiary. When you create your project in the Canadian subsidiary you assign the Japanese subsidiary employee to the appropriate project tasks. As the employee completes the work and tracks time, after time is posted, the labor cost is recorded in the Japanese subsidiary's general ledger. When the accounting period is closed, advanced intercompany journal entries are created to transfer the Japanese subsidiary employee's labor cost back to the Canadian subsidiary.

Before you can use Intercompany Job Costing, you must have a OneWorld account and enable Projects, Project Management, Job Costing and Project Budgeting, and Intercompany Time and Expenses.
You can then assign employees from different subsidiaries to project tasks. After time has been tracked and approved for those tasks, they are available to be posted at Transactions > Financial > Post Time.

NetSuite roles with the Post Time permission can post time to any subsidiary selected in the Subsidiary field on the role record. If no subsidiaries are selected on the role record, only the user's assigned subsidiary is available for posting time.

For example, if your company posts time at the parent company level for all subsidiaries, you can create a custom accountant role with the Post Time permission and all subsidiaries selected in the Subsidiary field on the role record. You can then assign that custom role to your accountant. When your accountant logs in with the new custom role to post time, NetSuite displays time available for posting from all subsidiaries.

If the selected Job Cost Variance account is not available for one of the subsidiaries, NetSuite displays an error message and no time is posted for that subsidiary.

When the time is posted, journal entries are created to account for the cost in your general ledger. The costs are reflected in real-time on the project record P&L subtab and in the Project Profitability report. When closing an accounting period, go to Transactions > Financial > Create Intercompany Adjustments to create advanced intercompany journal entries transferring the job cost from the employee's subsidiary back to the project's subsidiary. For more information on closing an account period, see the help topic Using the Period Close Checklist.

---

## Project Budgeting

**Important:** For information on the availability of Job Costing and Project Budgeting, please contact your account representative.

Project Budgeting lets you establish cost and billing budgets at both the project and task level. You can choose to set up your budgets at the project task level and they automatically roll up to the project level. At the project level, you can choose to accept the rolled up values or manually override budgets.

NetSuite offers an option to automatically calculate labor budgets based on values entered for your project at both the project and project task level.

### Project Task Budgets

For project task budgets, labor is the only available category for automatic calculation. If you choose to automatically calculate labor budgets, the calculations are determined for cost budgets based on resource cost rate times planned hours. Billing budgets calculate labor based on the resource price times planned hours. If you also used charge-based billing, the billing budgets are calculated from charges.

**Note:** You must create planned time entries for NetSuite to automatically calculate budgets. When creating your project record, on the Preferences subtab, check the Create Planned Time Entries box.

Billing budgets can be manually entered or calculated based on resource prices and planned hours. If your project uses Charge-Based Billing, billing budgets are calculated from charges rather than planned time.
Budgets for expenses, suppliers, and other can be manually entered for both costs and billing.

**Project Budgets**

For project budgets, labor costs can be automatically calculated in one of two ways depending on your settings:

- Sum of project task labor costs, including any manual overrides
- If you use Resource Allocations, labor budgets can be calculated from allocated resources.

**Note:** Budgets calculated for resource allocations appear in Labor: Other. Resource allocations do not allow for a service item and cannot be split between categories.

Labor billing budgets can be automatically calculated at the project level based on:

- Sum of project task billing budgets, including any manual overrides
- If you use charge-based billing, billing budgets are calculated using projections generated by charged-based billing rules.

Both cost and billing budgets for expenses, suppliers, and other are manually entered. If you have entered budgets for these categories at the project task level, you can choose to roll up those values at the project level.

After you have finished entering your budgets, the Estimated Project Cost field, on the Financial subtab of your project record, is updated to display the total from your project cost budget. The Estimated Project Revenue field is updated to display information from your project billing budget.

**Setting Up Project Budgeting**

**Important:** For information on the availability of Job Costing and Project Budgeting, please contact your account representative.

Before you begin creating your project budgets, you must first decide how you want labor, expenses, and supplier items to appear in your budgets and on the P&L subtab of project records.

**Note:** Projects with budgets displaying more than 20 categories will experience slower performance. It is recommended that you add only the most commonly used budget categories when creating project budgets.

**To set project budgeting preferences:**

1. Go to Setup > Accounting > Accounting Preferences.
2. Click Projects.
3. Under Labor, select how you want labor categories to appear:
   - **Group all service items into one ‘Labor’ category** – Select this option to group all costs and charges for work performed on projects in a single category.
   - **Show all service items as individual categories** – Select this option to show each service item individually on project budgets. Each service item is shown on all project budgets regardless of value.
Show only selected service items as individual categories – Select this option to choose which service items you want shown as labor categories for project budgets. Hold down the Ctrl key while selecting items to select multiple service items. Any costs or charges for services items not selected are recorded in the Labor: Other category.

4. Under Expenses, select how you want expense categories to appear:
   - Group all expense categories into one ‘Expenses’ category – Select this option to group all costs and charges for expense on projects in a single category.
   - Show all expense categories as individual categories – Select this option to show each expense category individually on project budgets. Each expense category is shown on all project budgets regardless of value.
   - Show only selected expense categories as individual categories – Select this option to choose which expense categories you want shown as expenses for project budgets. Hold down the Ctrl key while selecting items to select multiple expense categories. Any costs or charges for expense categories not selected are recorded in the Expenses: Other category.

5. Under Supplier, select how you want supplier categories to appear:
   - Group all supplier items into one ‘Supplier’ category – Select this option to group all costs and charges for vendor supplied expenses on projects in a single category.
   - Show all supplier items as individual categories – Select this option to show each vendor supplied item individually on project budgets. Each supplier item is shown on all project budgets regardless of value.
   - Show only selected supplier items as individual categories – Select this option to choose which vendor supplied items you want shown as supplier categories for project budgets. Hold down the Ctrl key while selecting items to select multiple supplier items. Any costs or charges for supplier items not selected are recorded in the Supplier: Other category.

6. Click Save.

Labor is the only category available on cost and billing budgets at the project task level.

The selections you make here are also used to display the current revenue, cost, profit, and margin for your project on the P&L subtab of the project record. For more information, see Profit and Loss Subtab.

Creating Project Budgets

⚠️ Important: For information on the availability of Job Costing and Project Budgeting, please contact your account representative.

After you have finished setting up your project budget preferences, you are ready to create budgets for a project. If you plan to roll up budgets from projects tasks to the project record, you should create project task budgets first and then create your project budgets.

Creating Budgets for Project Tasks

You can create budgets for costs and billings at both the project and project task level. Budgets at the project task level will roll up to the project level and you can manually override amounts at the project level.

To create budgets for a project task:

2. Click **Edit** next to the project you want to update.

3. On the **Schedule** tab, click **Edit** next to the task you want to add a budget for.

   The task record opens in a new window.

4. Click **Budget**.

5. On the **Cost Budget** subtab, check the **Show Calculated Lines** box to show labor budgets calculated from the applied labor cost and estimated work.

6. If you want to use the calculated budgets for all cost categories check the **Use Calculated Values for all Labor Cost Budgets** box.

   A message appears warning you that any manual budget entries you have made will be lost, click **OK** to continue. Checking this box removes the ability to enter any manual budget amounts.

   Skip to step 11.

7. If you want to use the calculated values for selected categories, check the box in the **Select** column next to Labor categories you want to add values for and then click **Set to Calculated**.

   **Note:** Calculated lines are only available when planned time entries are created. To turn on planned time entries, go to the **Preferences** subtab of the project record and check the **Create Planned Time Entries** box, and click **Save**. The values are automatically populated in the corresponding line.

If you would like the total amount distributed over the life of the task, click **Distribute Total**.

8. If you do not want to use calculated values, enter the budgeted amounts for each month in the appropriate column.

   Or, enter the total amount budgeted for the entire task in the **Task Total** column, check the box in the **Select** column, and then click **Distribute Total**. You can select multiple lines and distribute the totals of all lines at one time.

   **Note:** Labor items are the only categories available for automatic calculations on project task budgets.

9. Enter any additional budgeted amounts for other categories on the cost budget.

10. Click **Billing Budget**.

11. Repeat steps 5–9 for billing budgets.

   **Note:** If you check the **Use Calculated Values for all Labor Billing Budgets** box, budgets will not be calculated for any non-billable tasks.

12. When you have finished, click **Save**.

After you have created your project task budgets, you can roll them up to your project budget.

### Creating Budgets for Project Records

You can create budgets for costs and billings for project records.

**To create budgets for a project:**

2. Click **Edit** next to the project you want to add a budget to.
3. Click **Budget**.
4. On the **Cost Budget** subtab, if you use Resource Allocations and want to calculate labor costs from allocated resources, check **Calculate Labor Budgets from Resource Allocations**.

   **Note:** Resource allocations do not allow for a service item to be selected. If you have set your budget categories as service items, all calculated labor budgets will appear in the Labor: Other category when calculated from resource allocations. For more information, see **Resource Allocations**.

5. Check the **Show Calculated Lines** box to show calculated budgets.

   For information on how budgets are calculated, see **Project Budgets**.

6. If you want to use calculated values for all cost budgets, check the **Use Calculated Values for all Cost Budgets** box.

   A message appears warning you that any manual budget entries you have made will be lost, click **OK** to continue. Checking this box removes the ability to enter any manual budget amounts.

   Skip to step 9.

7. If you want to use the calculated values for selected categories, check the box in the **Select** column next to each category you want to add values for and then click **Set to Calculated**.

   The values are automatically populated in the corresponding line.

   If you would like the total amount distributed over the life of the task, click **Distribute Total**.

8. If you do not want to use calculated values, enter the budgeted amounts for each month in the appropriate column.

   Or, enter the total amount budgeted for the entire project in the **Project Total** column, check the box in the **Select** column, and then click **Distribute Total**. You can select multiple lines and distribute the totals of all lines at one time.

9. Click **Billing Budget**.

10. Repeat steps 5–8 for billing budgets.

   **Note:** If you check the **Use Calculated Values for all Labor Billing Budgets** box, budgets will not be calculated for any non-billable tasks.

11. When you have finished, click **Save**.

When you have finished updating your project budgets, on the Financial tab, the Estimated Costs and Estimated Revenue fields automatically update with values from your project budgets.

### Advanced Project Budgeting

Advanced Project Budgets enable you to stay on track with cost and revenue for each project. A work breakdown structure (WBS) separates the work on a project into parts, called work items. You can assign values to every work item, revenue, and cost. When you fill an estimate to complete values for cost and revenue, you can save the work breakdown structure and convert it to a budget. The values from the budget appear in the **Budget vs. Actual Report**.

With Advanced Project Budgets, you can:

- Create a work breakdown structure on your project and assign estimated amounts to cost or revenue.
- Report across multiple projects or customers using activity codes.
- See actual amounts from real transactions, which are useful for budget evaluation.
- Structure the budgets with a hierarchy.
Advanced Project Budgets support auto-versioning. NetSuite automatically saves every generated budget as a new version and keeps the previous versions accessible in the system.

**Note:** You can display each budget version, but you can only compare the versions side-by-side.

### Activity Codes

You can use activity codes to classify project time entries and transactions for use with the Advanced Project Budgets feature. Activity codes enable the classification of transactional and non-transactional records and customized reporting with a hierarchy for budgeting and profitability. Activity codes enable cross-project and cross-customer reporting in a tree structure form.

With activity codes, you can:

- Categorize activities into logical groups.
- Create global activity codes to organize project activities.
- Enable classification of transactions related to projects.
- Enable classification of time entries.
- Enable matching of classified actuals to work breakdown structure or budget lines.

With the Advanced Project Budgets feature, activity codes provide correct actuals matching the given line with the same activity code in the budget in the work breakdown structure even if the project tasks are missing. Activity codes use Custom Segments as the background process. Custom segments can help you to make changes in activity codes.

### Enabling the Advanced Project Budgets feature

You need to enable the Advanced Project Budgets feature if you want to use the Activity Codes feature, Custom Segments, and Custom Records.

**To enable the Advanced Project Budgets feature:**

1. Go to Setup > Company > Enable Features.
2. Click the **Company** subtab.
3. Check the **Advanced Project Budgets** box on the **Projects** subtab.

### Creating Activity Codes

You can create activity codes at Setup > Accounting > Activity Codes.

**To create activity codes:**

1. Go to Setup > Company > Classifications > Activity Codes > New.
2. In the **Name** field, enter a name for this activity code.
3. Optionally, in the **Parent** field, select a parent activity code. You can use the Parent field to create a hierarchical parent-child relationship for your activity codes.
4. When you have finished, click **Save**.
Note: You can add activity codes to project records, including Bill, Invoice, Purchase Order, Sales Order, Time, Charge Rule, Other Charge Item, Project, or Project Task parts of Netsuite. You can review the chosen record in the enabled form and change it if necessary.

Applying Activity Codes to Project Records

After you create activity codes, you can apply them to project records.

To apply activity codes to project records:

1. Choose a record, and click Edit.
2. Click the Items subtab. In the relevant line item, from the Activity Code dropdown list, select the appropriate code.
3. Select your activity code.
4. Click Save.

Tip: You can point to the Recent Records icon to see a list of records you recently viewed or edited.

Project Work Breakdown Structure (WBS)

When you enable Advanced Project Budgets, a new Work Breakdown Structure (WBS) subtab is available on project records.

Creating a Work Breakdown Structure

You can create a work breakdown structure to separates work into mutually exclusive parts.

To create a work breakdown structure:

2. Click Edit next to the project you want to update.
3. Click Work Breakdown Structure and New WBS.
4. Select a timeline type. You can choose from a global or monthly timeline type based on your preference. The monthly timeline type breaks down your budget into months so that you can track your actuals against monthly estimations.

Note: If you do not select an end date, the WBS does not generate monthly timeline columns.

5. In the Name field, enter a name for your first work line.
6. In the Task field, select a project task to associate with this line.

Note: The main purpose of selecting a task is to capture actuals to a WBS line. If you have not created any tasks yet, you can add them later.

7. In the Activity Code field, select the activity code for this line. For more information, see Activity Codes.
8. Under **Estimate to Complete**, enter the cost and revenue estimates for this line.

**Note:** The ETC values represent the financial amounts which it takes to have the part of the project completed. If you use the calculation pop-up, the ETC can represent a quantity. For more details, see **Cost Calculation**.

9. Click **Add Row**.

10. Continue to add as many rows as necessary. You can click the arrow keys at the bottom of the list to set up the hierarchy of each row.

11. When you have finished, click **Save**.

**Tip:** You can calculate costs not only through the **Estimate to Complete** field, but also using the **Cost Calculation** icon.

**Warning:** If you also use Advanced Project Profitability, each item displays differently in the report, depending on the profitability configuration.

## Cost Calculation

Cost calculation helps you calculate the costs for the work breakdown structure and budget. You define the source and enter the rate and NetSuite calculates the cost.

**Note:** If NetSuite automatically decreases the estimate to complete (ETC), you can see the pre-filled ETC quantity. In this case, you can update the quantity for a given unit of measure to update the cost. This is helpful if the actual cost does not correspond to the actual project or task progress.

**To calculate costs:**

2. Click **Edit** next to the project you want to update.
3. On the **Work Breakdown Structure** subtab, click **Edit**.
4. On the **Lines** subtab, click the **Estimate to Complete** column in the row for which you want to perform the cost calculation.
5. Click the icon. The **Define Work Item** opens.
6. Choose **Items** or **Project Resources** as the source of the cost information.
7. Choose the item or resource from the **Input** field.
8. You can enter ETC quantity, or ETC cost.

**Note:** The rate is displayed and your ETC cost is converted to the ETC quantity.

9. Click **Submit**.

**Note:** NetSuite now updates your WBS with the calculated costs based on your defined source information.

## Editing Estimates in the Work Breakdown Structure

While updating the WBS, you can update the estimate at completion or estimate to complete calculations.
To define estimate to complete:

2. Click Edit next to the project you want to update.
3. Go to the Work Breakdown Structure subtab.
4. Click New WBS.
5. Go to the line that you want to edit, and click the field under update estimate to complete. Enter just the expected cost for finishing the given activity.
6. Click Save.

**Tip:** NetSuite automatically calculates the estimate at completion as a sum of actual cost and estimate to complete.

The system automatically calculates the margin and profit by rolling up estimate to complete values. For example, a project requires you to travel and you still need to pay for your transportation and accommodations. You can divide the cost of transportation by train, taxi, and public transportation.

NetSuite automatically calculates the total of the transportation cost as the sum of each individual line. You can divide the cost of accommodations to hotel room number 1 and hotel room number 2. The system automatically calculates the total of the accommodations cost as the sum of each individual line.

**Tip:** In this example, the final cost for travel is automatically calculated as the sum of transportation and accommodations. However, you can update the amount and enter the maximum amount allowed for travel.

### Budget Burn-up Chart

A budget burn-up chart provides an overview of the budget consumption for the baseline budget. You can visualize the cost burn of the project and the cost budget consumption over time. You can also display a global or a monthly chart. Both charts show all data for actuals and the sum of all defined data for a budget. The monthly chart displays actuals for timeline and unmatched actuals. The global chart displays matched and unmatched actuals summed as an actual cost.

### Mapping Actuals to the Work Breakdown Structure

The WBS supports two ways of matching actuals to individual lines. If you tag a transaction line or time with a task, you can display them on the WBS line with the selected task. You can also use activity codes in the same way. If matching actuals by the task field fails, NetSuite matches actuals by activity codes. You can only add one task or activity code to each line.

**Note:** If you do not define tasks or activity codes, all actuals display on the Unmatched Actuals line.

### Displaying Unmatched Actuals

Unmatched actuals show entries from cost or revenue transactions with a global impact, which do not match any line of the WBS. They also show actuals falling outside of the defined timeframe. You can move them to the correct line by adding the appropriate task or activity code on the WBS or transaction or time entry. You can find the details of unmatched accounting entries if you click the Show unmatched actuals for cost, or Show unmatched actuals for revenue button on the WBS. The buttons display information such as a date or amount. The pop-up window with details shows the value of activity codes and project tasks. You can also click the link to the transaction details to edit transaction information.
Creating a Budget from Work Breakdown Structure

A work breakdown structure displays a current view of how the project should finish. A budget limits your project and gives an overview of expenses over time.

To create a budget from work breakdown structure:

2. Click Edit next to the project you want to update.
3. Go to the Work Breakdown Structure subtab.
4. Click Set as Baseline Budget.

**Note:** The Set as Baseline Budget button copies all data from a work breakdown structure into a similar record called Budget.

Copying and Editing a Budget

When you create a budget, you can copy and edit it.

To copy and edit a budget:

2. Click Edit next to the project you want to update.
3. Go to the Work Breakdown Structure subtab.
4. Click Set as Baseline Budget.
5. Go to your budget record.
6. Go to Actions on the bottom of the page.
7. Click Make Copy.

**Tip:** Making copies of your budget allows auto-versioning of previous budgets.

To see your previous budgets, click Lists on the upper right corner of the page. The list shows the history of budgets for your project, the summed budget, and who and when the budget was created. If you click the previous version of the budget, you can see the history of previously mapped actuals.

Budgets in Reporting

The Budget vs. Actual Report are available at Reports > Projects > Project Profitability Reports by default, for both cost and billing budgets at the summary and detail level. These reports enable you to analyze budgeted and actual project financials to determine how closely your costs and billings compare to those you originally budgeted.

You can view budgets through budget lines, activity codes, or reporting on items. Reporting offers you a view of budgets in three options: by budget lines, with activity codes, or by adding items.

To view budgets through reporting on items:

1. Go to Reports > Projects > Project Profitability Reports.
2. Click one of the Budget vs. Actual reports.
3. Click Recalculate to make sure the data is up to date.
4. Click **Customize**.
5. Expand Project Profitability and click the **Item** section.
6. Drag the item to your report layout and make necessary adjustments.
7. Optionally, check the box to group the activity codes with the previous column.
8. When you finish with the comparison, click **Save** or **Save as**.
Project Management Reports

You can run the following reports to help assess and manage your projects. Some reports are available only if you use Project Management while others are available for CRM tasks and Project Tasks.

**Reports for Project Tasks:**
- Earned Value by Project Report
- Utilization by Resource Reports
- Utilization by Project Reports
- Time Entry Exceptions Report
- Current Backlog By Resource Report
- Estimated Profitability by Project Report

**Reports for Project Tasks and CRM Tasks:**
- Time by Employee/Item/Customer Reports
  - Time by Employee Summary Report
  - Time by Employee Detail Report
  - Time by Customer Summary Report
  - Time by Customer Detail Report
  - Time by Item Summary Report
  - Time by Item Detail Report
- Actual Time Workbook
- Unbilled Cost by Customer Reports
  - Unbilled Cost by Customer Summary Report
  - Unbilled Cost by Customer Detail Report
- Unbilled Time by Customer Reports
  - Unbilled Time by Customer Summary Report
  - Unbilled Time by Customer Detail Report

**Reports for Project Management and Charge-Based Billing**
- Project Charges Forecast Report

**Reports for Project Management and Resource Allocations**
- Allocated Utilization by Project
- Allocated Utilization by Resource
- Allocated vs. Actual Hours by Resource Report

**Reports for Job Costing and Project Budgeting:**
- Project Budget vs. Actual Reports
- Project Task Budget vs. Actual Reports
- Project Profitability Report
- Advanced Project Profitability
- Project Profitability by Month Report
Note: If your account has the SuiteAnalytics Connect feature enabled, you also can use external reporting tools such as Crystal Reports and Microsoft Excel to report on project tasks data. See SuiteAnalytics Connect Access to Project Tasks Data.

For quick access to project report information, add a snapshot for any Project Management reports to your dashboard. See the help topics Adding a Report Snapshot Portlet and Standard Report Snapshots Table.

Earned Value by Project Report

You can use the new Earned Value by Project report to analyze the cost and schedule of projects in progress.

For example, this report can help you do the following:

- Determine the accomplishment of planned work.
- Determine if resources are performing behind or ahead of schedule.
- Analyze cost performance within a budget.

With regular analysis, earned value assessment can help you head off performance problems. For example, if you see that costs are beginning to go over budget, you can make adjustments before costs are excessively overrun.

The Earned Value by Project report leverages Working with the Project Schedule for a cost-loaded schedule. Each task is scheduled over time and each task has labor resources associated with it. You can forecast expected cost outlay for the labor over time. By examining this total over time and looking at costs to-date while project is in process, you can calculate the costs and schedule variance.

This report is available only if you use Project Management.

This report displays the following for each project:

- Name
- Planned Value  
  Total cost of planned labor for each project.
- Earned Value  
  Total cost budgeted for completed labor.
- Actual Cost  
  Actual costs for completed labor.
- SV – Schedule Variance  
  Planned Value — Earned Value
- SV %  
  Scheduled Value / Earned Value * 100
- CV – Cost Variance  
  Earned Value — Actual Cost
- CV %  
  Cost Variance / Earned Value * 100

To view this report, go to Reports > Time & Billables & Earned Value by Project.

A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.
If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic Subsidiary Context for Reports.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

## Utilization by Resource Reports

You can use the Utilization by Resource reports to measure resource contributions to projects based on the percent of time they are contributing to project work. Utilization is calculated by determining how a resource’s allocated, planned, or actual time worked on projects relates to their available time. Available time is determined by a resource’s work calendar.

**Note:** The link for Utilization by Employee Summary (deprecated) and Utilization by Employee (deprecated) also remain under this heading, but these new reports are recommended.

The following reports are available:
- Allocated Utilization by Resource
- Planned Utilization by Resource
- Actual Utilization by Resource

### Allocated Utilization by Resource

**Important:** The Allocated Utilization by Resource report requires the Resource Allocations feature. For more information, see Resource Allocations.

This report displays the following for each resource:
- Customer:Project
- Allocated Time
  - Total number of hours allocated for each project.
- Available hours
  - Total expected working time as determined from the work calendar.
  - Calculated as \([\text{Working days} \times \text{Hours per working day}]\)
- Utilization
  - The percentage of allocated utilization for project resources
  - Calculated using Allocated Time and Available Time.

To view the Allocated Utilization by Resource report, go to Reports > Time & Billables > Allocated Utilization by Resource.

This report is available only if you use Project Management and Resource Allocations.

**Note:** The link for Utilization by Employee Summary (deprecated) and Utilization by Employee (deprecated) also remain under this heading, but these new reports are recommended.

When you click Allocated Utilization by Resource, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.
If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See Subsidiary Context for Reports.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

## Planned Utilization by Resource

This report displays the following for each resource:

- **Customer:Project**
- **Planned Time**
  - Total number of hours planned for each project.

**Note:** Planned time entries are generated when a project task is saved for a project with the Create Planned Time Entries box checked on the Preferences subtab. NetSuite creates planned time entries for resources based on estimated work on each project task.

- **Available hours**
  - Total expected working time as determined from the work calendar.
  - Calculated as \(\text{Working days} \times \text{Hours per working day}\).
- **Utilization**
  - The percentage of planned utilization for project resources
  - Calculated using Planned Time and Available Time.

To view the Planned Utilization by Resource report, go to Reports > Time & Billables > Planned Utilization by Resource.

This report is available only if you use Project Management.

**Note:** The link for Utilization by Employee Summary (deprecated) and Utilization by Employee also remain under this heading, but these new reports are recommended.

When you click Planned Utilization by Resource, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See Subsidiary Context for Reports. If you want to customize this report to add labor cost, OneWorld accounts must use the Project Resource > Labor Cost definition in order for the correct currency to display in the customized report.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

## Actual Utilization by Resource

This report displays the following for each resource:
Utilization by Resource Reports

- **Customer:Project**
- **Actual Time**
  
  Total number of hours posted for each project.
- **Available hours**
  
  Total expected working time as determined from the work calendar.
  
  Calculated as \([\text{Working days} \times \text{Hours per working day}]\).
- **Exempt hours**
  
  Time that should not be considered for utilization calculations in either the numerator or the denominator.
  
  Time included in this category can vary from company to company, but generally includes vacations and holidays.
- **Net hours**
  
  Time that can be utilized for productive activities.
  
  Calculated as: \([\text{Available time} - \text{Exempt time}]\).
- **Utilization**
  
  The percentage of actual utilization for project resources
  
  Calculated using Actual Time and Net Time.

To view the Actual Utilization by Resource report, go to Reports > Time & Billables > Actual Utilization by Resource.

This report is available only if you use Project Management.

**Note:** The link for Utilization by Employee Summary (deprecated) and Utilization by Employee also remain under this heading, but these new reports are recommended.

When you click Actual Utilization by Resource, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See **Subsidiary Context for Reports**.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

### Allocated vs. Actual Hours by Resource Report

**Important:** The Allocated vs. Actual Hours by Resource report requires the Resource Allocations feature. For more information, see **Resource Allocations**.

The Allocated vs. Actual Hours by Resource report allows you to quickly compare the number of hours your resources are allocated to projects and the number of hours each resource tracks toward each project.

This report displays the following for each resource:
Allocated vs. Actual Hours by Resource Report

- Resource / Customer / Project
- Allocated Time
  Total number of hours allocated for each resource.
- Actual Time
  Total number of hours tracked for each resource.

To view the Allocated vs. Actual Hours by Resource report, go to Reports > Time & Billables > Allocated vs. Actual Hours by Resource.

This report is available only if you use Project Management and Resource Allocations.

When you click Allocated vs. Actual Hours by Resource, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See Subsidiary Context for Reports.

Note: This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

Utilization by Project Reports

You can use the Utilization by Project reports to measure resource contributions to projects based on the percent of time they are contributing to project work. Utilization is calculated by determining how a resource's allocated, planned, or actual time worked on projects relates to their available time. Available time is determined by a resource's work calendar.

The following reports are available:
- Allocated Utilization by Project
- Planned Utilization by Project
- Actual Utilization by Project

Allocated Utilization by Project

Important: The Allocated Utilization by Project report requires the Resource Allocations feature. For more information, see Resource Allocations.

This report displays the following for each project:
- Customer / Project / Resource
- Allocated Time
  Total number of hours allocated for each resource.
- Available hours
  Total expected resource working time as determined from the work calendar.
  Calculated as [Working days * Hours per working day.]
Utilization by Project Reports

Note: Holidays do not impact available time. For example, adding a holiday to the work calendar does not reduce available time.

- **Utilization**
  - The percentage of allocated utilization for project resources
  - Calculated using Allocated Time and Available Time.

To view the Allocated Utilization by Project report, go to Reports > Time & Billables > Allocated Utilization by Project.

This report is available only if you use Project Management and Resource Allocations.

When you click Allocated Utilization by Project, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See Subsidiary Context for Reports.

Note: This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

**Planned Utilization by Project**

This report displays the following for each resource:

- **Customer / Project / Resource**
- **Planned Time**
  - Total number of hours planned for each resource.

Note: Planned time entries are generated when a project task is saved for a project with the Create Planned Time Entries box checked on the Preferences subtab. NetSuite creates planned time entries for resources based on estimated work on each project task.

- **Available hours**
  - Total expected resource working time as determined from the work calendar.
  - Calculated as [Working days * Hours per working day.]

Note: Holidays do not impact available time. For example, adding a holiday to the work calendar does not reduce available time.

- **Utilization**
  - The percentage of planned utilization for project resources
  - Calculated using Planned Time and Available Time.

To view the Planned Utilization by Project report, go to Reports > Time & Billables > Planned Utilization by Project.

This report is available only if you use Project Management.
When you click Planned Utilization by Project, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See Subsidiary Context for Reports.

Note: This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

Actual Utilization by Project

This report displays the following for each resource:

- Customer / Project / Resource
- Actual Time
  - Total number of hours posted for each resource.
- Available hours
  - Total expected resource working time as determined from the work calendar.
    Calculated as [Working days * Hours per working day.]

Note: Holidays do not impact available time. For example, adding a holiday to the work calendar does not reduce available time.

- Exempt hours
  - Time that should not be considered for utilization calculations in either the numerator or the denominator.
  - Time included in this category can vary from company to company, but generally includes vacations and holidays.
- Net hours
  - Time that can be utilized for productive activities.
    Calculated as: [Available time minus Exempt time.]
- Utilization
  - The percentage of actual utilization for project resources
    Calculated using Actual Time and Net Time.

To view the Actual Utilization by Project report, go to Reports > Time & Billables > Actual Utilization by Project.

This report is available only if you use Project Management.

When you click Actual Utilization by Project, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See Subsidiary Context for Reports.

Projects
**Time Entry Exceptions Report**

For employees that are assigned a work calendar, the Time Entry Exceptions report can be generated to show time exceptions, or "missing" time entries. Time is considered missing if the work calendar for the employee shows the time as available, but there is not time entered yet.

For example, if John's work calendar shows he has 40 hours available in a certain week, but he has entered only 30 hours, then there are 10 available hours yet to be entered. The Time Entry Exceptions report details which employees have time yet to be entered and how much time remains.

If you use Weekly Timesheets, the following additional fields are available:

- **Submitted Hours** – The total approved or pending approval hours for the selected period. The Submitted Hours column is only available when the Advanced Approvals on Time Records preference is enabled.
- **Work Calendar Timesheets** – The total expected timesheets during the selected time period based on the employee's work calendar.
- **Empty Timesheets** – The total number of timesheets without any time entries for the selected time period.
- **Filled Timesheets** – The total number of filled timesheets for the selected time period. Click the total filled timesheets to go to a list of current timesheets.

To view the Time Entry Exceptions report, go to Reports > Time & Billables > Time Entry Exceptions.

**Note:** At least one time entry must be entered for the report to provide employees who have available time on the project task.

This report is available only if you use Project Management.

A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic **Subsidiary Context for Reports**.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

**Time by Employee/Item/Customer Reports**

The Time by Employee, Time by Item, and Time by Customer reports include "soft-booked" time created by materializing the planned time for a project. These reports can be run for future dates to forecast resource demand by each of these dimensions. The forward-looking versions of these reports can be used by management to plan for project throughput and resource staffing decisions.
In addition, these reports are updated to give the option of including a time period dimension. For example, the user can see a comparison of values over a set of time periods, such as each of the first 6 months of the year. Because these reports include planned time, they can be run for future dates to see the demand for time by any number of dimensions.

**Note:** Because these reports include planned time by default, you must filter out planned time to report on actual time only.

For more details on these reports, read the following:

- Time by Employee Summary Report
- Time by Employee Detail Report
- Time by Customer Summary Report
- Time by Customer Detail Report
- Time by Item Summary Report
- Time by Item Detail Report

**Time by Employee Summary Report**

The Time by Employee Summary report shows the sum of all time entered for each employee during a specified time period.

**To see the Time by Employee Summary report:**

1. Go to Reports > Time & Billables > Time by Employee.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic *Subsidiary Context for Reports*.

**Note:** If you need to include an employee's address on a report, it is recommended that you customize the report and add Home Address fields from the employee record. For more information, see the help topic *Including an Employee's Address on a Report*.

**Time by Employee Detail Report**

The Time by Employee Detail report shows a list of individual time records entered for each employee, subtotaled by employee.

**To see the Time by Employee Detail report:**

1. Go to Reports > Time & Billables > Time by Employee > Detail.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic *Subsidiary Context for Reports*. 
Time by Customer Summary Report

The Time by Customer Summary report shows the time entered for service items for each customer during a specified time period.

To see the Time by Customer Summary report:

1. Go to Reports > Time & Billables > Time by Customer.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic Subsidiary Context for Reports.

Time by Customer Detail Report

The Time by Customer Detail report lists, by customer, the individual time records for each service item.

To see the Time by Customer Detail report:

1. Go to Reports > Time & Billables > Time by Customer > Detail.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic Subsidiary Context for Reports.

Time by Item Summary Report

The Time by Item Summary report shows a summary of all the time entered for each service item during a specified time period.

To see the Time by Item Summary report:

1. Go to Reports > Time & Billables > Time by Item.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic Subsidiary Context for Reports.

Time by Item Detail Report

The Time by Item Detail report lists the individual time records for each service item, subtotaled by customer or project.
To see the Time by Item Detail report:

1. Go to Reports > Time & Billables > Time by Item > Detail. 
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic Subsidiary Context for Reports.

Note: These reports do not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

Actual Time Workbook

SuiteAnalytics Workbook offers many workbook and dataset templates, each with predefined source data, criteria, pivot tables, and charts.

This section contains the information for the SuiteAnalytics Actual Time Workbook in NetSuite. For more information about standard SuiteAnalytics Workbooks, see the help topic Workbook and Dataset Templates.

- Actual Time Dataset Template
- Actual Time Workbook Template

Actual Time Dataset Template

This dataset combines fields from the Time Tracking record type and seven custom formulas enabling you to closer monitor how time is being utilized across your projects. It forms the source data for the Actual Time Workbook Template.

Prerequisites

The following features should be enabled for the workbook to appear in the list of standard workbooks.

1. Time Tracking
2. Project Management

Dataset Configuration

The Actual Time dataset combines fields from one record type, multiple custom formulas and criteria filters. To edit the dataset, see the help topic Defining a Dataset.

<table>
<thead>
<tr>
<th>Root Record Type</th>
<th>Joined Record Type</th>
<th>Custom Formula Fields</th>
<th>Data Grid</th>
<th>Criteria Filters</th>
</tr>
</thead>
</table>
| Time Tracking    | (none)            | The following custom formula fields are included in the dataset:  
|                  |                   | Billable Time         | The following fields are included in the dataset:  
|                  |                   | Exempt Time           | Time Tracking:  
|                  |                   | Non-billable Time     |   
|                  |                   |                       | - Class  

The following criteria is used to filter the dataset:

- Date on or after same day last year
### Actual Time Workbook Template

This workbook uses two examples of the Time and Billables reports, Time by Customer and Time by Item, to demonstrate how to build your own “time by” workbooks enabling you to closer monitor how time is being utilized across your projects. From within the workbook you can view pivot tables and charts which break down billable time across customers and items, as well as showing time usage and the proportion of billable to non-billable time.

The workbook contains two predefined pivot tables and charts. You can edit each of these components on the corresponding tab of the workbook user interface. For more information, see the help topic Defining a Dataset.

![Note:](image) If you do not have access to this workbook, contact your administrator.

#### To view the Actual Time workbook:

1. Go to Analytics.
2. Click Standard Workbooks.
3. From the list of workbooks, click Actual Time Analysis.

#### Prerequisites

The following features should be enabled for the workbook to appear in the list of standard workbooks.

1. Time Tracking
2. Project Management

#### Pivot Tables

- Time by Customer
- Time by Item

#### Charts

- Time Usage
- Billable/Non-billable time

### Current Backlog By Resource Report

The Current Backlog by Resource report lists employees who are assigned to open projects, the number of open projects per employee and the total hours remaining assigned.

![Note:](image) If you use NetSuite OneWorld, you must set your Restrict View preferences to a single subsidiary, at Home > Set Preferences, before you can run this report.

To view the Current Backlog by Resource report, go to Reports > Time & Billables > Current Backlog by Resource.
A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

---

**Estimated Profitability by Project Report**

The Estimated Profitability by Project report shows estimated cost, revenue, and profit for projects. The default report shows columns for the following:

- Estimated cost = [Estimated Work * Cost] for all project tasks
- Estimated revenue = [Estimated Work * Price] for all project tasks
- Estimated profit = [Estimated revenue - Estimated cost]
- Current time budget
- Actual time
- Project status

Projects which have all zero values for these columns do not show up in the report.

This report shows all projects, including project templates. If you wish to see only projects and not project templates, you must customize the report.

Estimated cost, revenue, and profit are based on the labor costs and prices entered for each project task. Click on information in any of the columns to open the associated project record. The Financial subtab on the project record has additional information on the figures listed on this report.

**Note:** If you use NetSuite OneWorld, you must set your Restrict View preferences to a single subsidiary, at Home > Set Preferences, before you can run this report.

To view this report, go to Reports > Time & Billables > Estimated Profitability by Job.

This report is available only if you use Project Management.

A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

---

**Unbilled Cost by Customer Reports**

**Unbilled Cost by Customer Summary Report**

The Unbilled Cost by Customer Summary report shows unbilled costs, sorted by customer or project. Costs appear on this report from unbilled items and expenses charged to a customer or project. After an invoice is issued for these costs, they no longer appear on this report.
To see the Unbilled Cost by Customer Summary report:

1. Go to Reports > Time & Billables > Unbilled Cost by Customer.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic Subsidiary Context for Reports.

Unbilled Cost by Customer Detail Report

The Unbilled Cost by Customer Detail report shows unbilled costs, sorted by customer or project. Costs appear on this report from unbilled items and expenses charged to a customer or project. After an invoice is issued for these costs, they no longer appear on this report.

The Detail report lists the individual transactions for each customer or project.

To see the Unbilled Cost by Customer Detail report:

1. Go to Reports > Time & Billables > Unbilled Cost by Customer > Detail.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic Subsidiary Context for Reports.

Unbilled Time by Customer Reports

Unbilled Time by Customer Summary Report

The Unbilled Time by Customer Summary report shows the hours for each employee that have not been billed.

To see the Unbilled Time by Customer Summary report:

1. Go to Reports > Time & Billables > Unbilled Time by Customer.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic Subsidiary Context for Reports.

Note: When an employee completes work for a customer from a different subsidiary, the unbilled time is displayed in the customer’s subsidiary.

Unbilled Time by Customer Detail Report

The Unbilled Time by Customer Detail report shows individual time transactions that haven’t been invoiced, sorted by customer or project.
To see the Unbilled Time by Customer Detail report:

1. Go to Reports > Time & Billables > Unbilled Time by Customer > Detail.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See the help topic Subsidiary Context for Reports.

**Note:** When an employee completes work for a customer from a different subsidiary, the unbilled time is displayed in the customer’s subsidiary.

**Note:** These reports do not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

---

Project Charges Forecast Report

The Project Charges Forecast report is available for charge-based projects. This report details the monthly forecasted charges per project based on the established charge rules for each project.

**Important:** The report is available when using the Project Management and Charge-Based Billing features.

To see the Project Charges Forecast report:

1. Go to Reports > Time & Billables > Unbilled Cost by Customer.
2. A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

**Note:** Expense-based rules are not included in charge forecasts.

---

Project Charges Forecast with Resource Allocations

If you also use Resource Allocations, you can choose to forecast time-based project charges using allocated time rather than planned time. Project Management, Charge-Based Billing, and Resource Allocations are all required features to use allocated time for project forecasts.

To use resource allocations for project forecasting:

1. Go to Setup > Accounting > Accounting Preferences.
2. Click Time & Expenses.
3. Under General, in the Service Item for Forecast Reports field, select a service item. The labor cost for the selected service item is used when forecast reports are based on allocated time.
4. Click Save.
5. Go to Lists > Relationships > Projects.
6. Click Edit next to the project you want to forecast with resource allocations.
Note: Only projects using charge-based billing are displayed on the Project Forecast report.

7. Click the Preferences subtab.
8. Check the Use Allocated Time for Forecast box.
9. Click Save.

The Project Charges Forecast report now displays forecast amounts based on resource allocations.

Note: This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

### Project Budget vs. Actual Reports

Project Budget vs. Actual reports are available for both cost and billing budgets at the summary and detail level. These reports allow you to analyze budgeted and actual project financials to determine how closely your costs and billings compare to those you originally budgeted. The categories that appear on the report match those that are set up to appear on project budgets. For more information on setting up budgets, see Setting Up Project Budgeting.

- Project Cost Budget vs. Actual
- Project Billing Budget vs. Actual

### Project Cost Budget vs. Actual

**Important:** The Project Cost Budget vs. Actual report requires the Job Costing and Budgeting feature. For more information, see Job Costing and Project Budgeting.

The information displayed on the Project Cost Budget vs. Actual report is a comparison of the budget and actual costs for each project. Budgets are entered on individual project records. This report is available in both summary or detail. To view the Project Cost Budget vs. Actual Summary report, go to Reports > Projects > Project Cost Budget vs. Actual. To view the Project Cost Budget vs. Actual Detail report, go to Reports > Projects > Project Cost Budget vs. Actual > Detail.

The summary report displays the following for each project by month:

- **Customer:** Project/Category
- **Budget**
  - Total amount budgeted for costs in each category.
- **Actual**
  - Total actual costs for each category.
  - Labor costs are calculated from posted time.
  - Expense costs are calculated from expense reports.
  - Supplier costs are calculated from vendor bills with item lines tied to the project. Inventory items are not accounted for in supplier costs.
- **Committed Cost**
  - Project costs that have been committed but have not yet been resolved.
Variance
The difference between the budgeted amount and the actual amount for each category.

The detail report is expanded to show the individual transactions that make up the totals for each category.

These reports are available only if you use Project Management and Job Costing and Project Budgeting.

When you click Project Cost Budget vs. Actual, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

Note: These reports do not display partial budgets. When selecting a time frame to display, if a partial month is chosen the report will not show a budget for that month. For example, if you select July 15 through August 31, the report will not display a budget for July.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See Subsidiary Context for Reports.

Important: When customizing this report, if you would like to add billing budget fields, you must remove the Is Cost=T filter from your custom report. If you do not remove the filter, the added billing budget fields will appear empty. Removing the filter will add empty lines to your report.

Note: This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

Project Billing Budget vs. Actual

Important: The Project Billing Budget vs. Actual report requires the Job Costing and Budgeting feature. For more information, see Job Costing and Project Budgeting.

The information displayed on the Project Billing Budget vs. Actual report is a comparison of the budget and actual charges billed to customers for each project. Budgets are entered on individual project records. This report is available in both summary or detail. To view the Project Billing Budget vs. Actual Summary report, go to Reports > Projects > Project Billing Budget vs. Actual. To view the Project Cost Budget vs. Actual Detail report, go to Reports > Projects > Project Billing Budget vs. Actual > Detail.

The summary report displays the following for each project by month:

- Customer:Project/Category
- Budget
  - Total amount budgeted for customer charges in each category.
- Actual
  - Total actual charges for each category.
  - Labor is calculated by invoiced billable time.
  - Expenses are calculated by invoiced billable expenses.
  - Supplier charges are calculated by invoiced billable items or expenses supplied by another vendor.
  - Inventory items are not accounted for in supplier charges.


- **Committed Revenue**
  Project revenue that has been committed but not yet received.

- **Recognized Revenue**
  Cumulative dollar amount of the revenue recognized with either invoices or revenue commitments.

- **Variance**
  The difference between the budgeted amount and the actual amount for each category.

The detail report is expanded to show the individual transactions that make up the totals for each category.

These reports are available only if you use Project Management and Job Costing and Project Budgeting.

When you click Project Billing Budget vs. Actual, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

**Note:** These reports do not display partial budgets. When selecting a time frame to display, if a partial month is chosen the report will not show a budget for that month. For example, if you select July 15 through August 31, the report will not display a budget for July.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See Subsidiary Context for Reports.

**Important:** When customizing this report, if you would like to add cost budget fields, you must remove the Is Cost=F filter from your custom report. If you do not remove the filter, the added cost budget fields will appear empty. Removing the filter will add empty lines to your report.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

---

### Project Task Budget vs. Actual Reports

Project Task Budget vs. Actual reports are available for both cost and billing labor budgets. These reports allow you to analyze budgeted and actual project financials to determine how closely your labor costs and billings compare to those you originally budgeted. The labor categories that appear on the report match those that are set up to appear on project budgets. For more information on setting up budgets, see Setting Up Project Budgeting.

- **Project Task Cost Budget vs. Actual**
- **Project Task Billing Budget vs. Actual**

### Project Task Cost Budget vs. Actual

**Important:** The Project Task Cost Budget vs. Actual report requires the Job Costing and Budgeting feature. For more information, see Job Costing and Project Budgeting.

The information displayed on the Project Task Cost Budget vs. Actual report is a comparison of the budget and actual costs for each project task. Budgets are entered on individual project task records.
This report displays the following for each project task by month:

- **Customer:**Project/Task/Category
- **Budget**
  Amount budgeted for labor costs in each category.
- **Actual**
  Actual labor costs for each category.
- **Variance**
  The difference between the budgeted amount and the actual amount for each category.

To view the Project Task Cost Budget vs. Actual report, go to Reports > Projects > Project Task Cost Budget vs. Actual.

This report is available only if you use Project Management and Job Costing and Project Budgeting.

When you click Project Task Cost Budget vs. Actual, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.

**Note:** This report does not display partial budgets. When selecting a time frame to display, if a partial month is chosen the report will not show a budget for that month. For example, if you select July 15 through August 31, the report will not display a budget for July.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See **Subsidiary Context for Reports**.

**Important:** When customizing this report, if you would like to add billing budget fields, you must remove the Is Cost=T filter from your custom report. If you do not remove the filter, the added billing budget fields will appear empty. Removing the filter will add empty lines to your report.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

### Project Task Billing Budget vs. Actual

**Important:** The Project Task Billing Budget vs. Actual report requires the Job Costing and Budgeting feature. For more information, see **Job Costing and Project Budgeting**.

The information displayed on the Project Task Billing Budget vs. Actual report is a comparison of the budget and actual charges billed to customers for each project task. Budgets are entered on individual project task records.

This report displays the following for each project task by month:

- **Customer:**Project/Task/Category
- **Budget**
  Amount budgeted for labor charges in each category.
Project Task Budget vs. Actual Reports

- **Actual**
  - Actual labor charges for each category.

- **Variance**
  - The difference between the budgeted amount and the actual amount for each category.

To view the Project Task Billing Budget vs. Actual report, go to Reports > Projects > Project Task Billing Budget vs. Actual.

This report is available only if you use Project Management and Job Costing and Project Budgeting.

When you click Project Task Billing Budget vs. Actual, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.

**Note:** This report does not display partial budgets. When selecting a time frame to display, if a partial month is chosen the report will not show a budget for that month. For example, if you select July 15 through August 31, the report will not display a budget for July.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See **Subsidiary Context for Reports**.

**Important:** When customizing this report, if you would like to add cost budget fields, you must remove the Is Cost=F filter from your custom report. If you do not remove the filter, the added cost budget fields will appear empty. Removing the filter will add empty lines to your report.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

---

Project Profitability Report

The Project Profitability report compares actual project revenue and costs to show each project's total profitability.

**Important:** The Project Profitability report requires the Job Costing and Budgeting feature. For more information, see **Job Costing and Project Budgeting**.

**Note:** If you use Advanced Project Profitability, see **Advanced Project Profitability**.

The total report displays the following for each project:

- **Customer:Project/Category**

- **Total Cost**
  - The total costs incurred for each category. This figure is consistent with the actual amounts from the Project Cost Budget vs. Actual report.

- **Committed Cost**
  - The committed costs for each category.

- **Total Income**
Income is the net profit after costs for each category.

- **Income/Cost margin**
  \[ \text{Total Income} / \text{Total Cost} \times 100 - 100 = \text{Margin} \]

- **Committed Revenue**
  Revenue commitments for each category.

- **Recognized Revenue**
  Revenue that has been recognized for each category.

- **Revenue/Cost margin**
  \[ \text{Recognized Revenue} / \text{Total Cost} \times 100 - 100 = \text{Margin} \]

The Project Profitability Report shows the profitability of all active projects for the entire life of the project. This report is available only if you use Project Management and Job Costing and Project Budgeting.

When you click Project Profitability, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click **Cancel Report** to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See **Subsidiary Context for Reports**.

### Project Profitability Category Matrix

The following table details the sources for each category included on the Project Profitability report.

<table>
<thead>
<tr>
<th>Category</th>
<th>Total Cost</th>
<th>Committed Cost</th>
<th>Total Income</th>
<th>Committed Revenue</th>
<th>Recognized Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor</td>
<td>Journal entries</td>
<td>N/A</td>
<td>Invoice amounts created from employee time-based charges</td>
<td>Revenue commitments created from service items</td>
<td>Invoices with GL impact to revenue for service items and billable time</td>
</tr>
<tr>
<td></td>
<td>created from posting</td>
<td></td>
<td>Invoice amounts created from fixed fee charge rules</td>
<td>Note: Journal entries created from revenue recognition schedules reduces the Committed amount</td>
<td>Journal entries created from revenue recognition schedules for service items</td>
</tr>
<tr>
<td></td>
<td>time tracked towards projects</td>
<td></td>
<td>Billable time on customer invoices</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expense</td>
<td>Approved employee expense reports</td>
<td>N/A</td>
<td>Invoice amounts created from employee and vendor expense-based charges</td>
<td>N/A</td>
<td>Invoices with GL impact to revenue for expense items and billable expenses</td>
</tr>
<tr>
<td>Supplier</td>
<td>Approved vendor bills Item fulfillments</td>
<td>Unfulfilled purchase orders for non-inventory items and service items</td>
<td>Invoice amounts created from vendor time-based charges</td>
<td>Revenue commitments created from inventory items, non-inventory</td>
<td>Invoices with GL impact to revenue for non-inventory items, inventory</td>
</tr>
</tbody>
</table>

---

**Note:** Journal entries created from revenue recognition schedules reduces the Committed amount.
Project Profitability by Month Report

The Project Profitability by Month report compares actual project revenue and costs to show each project's profitability.

The Project Profitability by Month report is available in both summary or detail. To view the Project Profitability by Month Summary report, go to Reports > Projects > Project Profitability by Month. To view the Project Profitability Detail report, go to Reports > Projects > Project Profitability by Month > Detail.

**Important:** The Project Profitability by Month report requires the Job Costing and Budgeting feature. For more information, see Job Costing and Project Budgeting.

**Note:** If you use Advanced Project Profitability, see Advanced Project Profitability.

The summary report displays the following for each project by month:

- Customer:Project/Category
- Total Income

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.
Income is the net profit after costs for each category.

- Total Cost
  The total costs incurred for each category. This figure is consistent with the actual amounts from the Project Cost Budget vs. Actual report.

- Committed Cost
  The committed costs for each category.

- Committed Revenue
  Revenue commitments for each category.

- Recognized Revenue
  Revenue that has been recognized for each category.

For a detailed breakdown of the types of transactions displayed for each category, see Project Profitability Category Matrix.

The detail report is expanded to show the individual transactions that make up the totals for each category.

This report is available only if you use Project Management and Job Costing and Project Budgeting.

When you click Project Profitability by Month, a message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

If you use NetSuite OneWorld, you can choose the subsidiary data to be displayed in this report by selecting from the Subsidiary Context dropdown in the results page footer. See Subsidiary Context for Reports.

**Note:** This report does not support reporting by period even when the Report by Period preference is set to All Reports. The Report by Period preference can be configured at Home > Set Preferences, the Analytics subtab.

### Advanced Project Profitability

The Advanced Project Profitability feature gives you access to create customized, enhanced project profitability reports based on items and accounts. Advanced Project Profitability also enables you to define both the account and item mapping for your reports. You can create custom mappings to determine where both committed and actual costs and revenue appear in your custom reports. The Project Management feature is required to enable Advanced Project Profitability. To enable Advanced Project Profitability, go to Setup > Company > Enable Features. Under Projects, check the Advanced Project Profitability box. Click Save.

**Note:** When you enable the Advanced Project profitability feature, the default configuration for the project profitability report is copied as the standard configuration. This configuration can be edited or copied at any time by creating a new configuration.

### Creating Custom Project Profitability Reports

Advanced Project Profitability uses filters to map accounts and items to specific columns and rows within a custom project profitability report. The feature comes with a standard configuration of account and item
mappings. You can edit and customize the standard configuration and create custom profitability reports to fit your business needs. You can create multiple configurations. All of your project profitability reports are located at Reports > Projects > Project Profitability Reports.

The standard account types that define report columns include Actual Cost, Actual Revenue, Committed Cost, Committed Revenue, Cost, Revenue, and Unbilled Receivable.

The standard item types that define report rows include Asset, Expense, Other, and Service.

**Project Profitability Rules**

When setting up Advanced Project Profitability, you can create custom configurations for your custom profitability reports.

Custom configurations are based on rules you create to filter items and accounts into the selected rows and columns of your reports.

When you define rules for your rows and columns, NetSuite applies different logic to these rules based on whether they are including or excluding information. Rules that include information use OR logic, while rules that exclude information use AND logic.

You can define multiple rules and they are applied in order. Sorting on reports is dependent on rule configuration. On the P&L subtab the categories in rows and columns are sorted as defined in the configuration.

For example, you create a rule to include a few specific items, expenses, and a specific item type on your custom project profitability report. You also create a rule to exclude a few specific item types. To be included in your custom project profitability report, a transaction has to satisfy at least one of the include rules and also all of the exclude rules.

**To create a new project profitability configuration:**

1. Go to Setup > Accounting > Project Profitability.
2. Click **New**.
3. On the **Enter Basic Information** page, enter a name and an optional description for your configuration.
4. Click **Next**.
5. On the **Define Rows** page, the standard configuration automatically populates the row fields. You can enter new rows and delete or edit the standard configuration to define which items to include in the rows of your report. In the **Name** field, enter a name for your item group.
6. Click the **Edit** icon next to the Name field to open the **Row** popup window.
7. In the **Type** field, select an item filter and, if applicable, define the filter in the popup window.
   - Items – include or exclude specific items from your report. In the **Condition** field, select **is** to include the selected items or **is not** to exclude the selected items. In the **Items** field, select the items for this row.
   - Item Types – include all items of a specific type (e.g. non-inventory items). In the **Item Types** field, select the item types you want included in this row.
   - Individual Expense Categories – include all expenses of a specific category. In the **Individual Expense Categories** field, select the expense categories you want to include in this row.
   - All Expense Categories – includes all project expense categories.
   - Uncategorized Expenses – include any expenses that do not have items or expense categories.
Click **Set** to return to Step 2. Click **Add** to save your defined row.

**Note:** Each row can have only one defined type. You may add multiple row definitions to each configuration.

8. Repeat the previous step to add rows to your profitability report. When you are finished, click **Next**.

9. On the **Define Columns** page, the standard configuration automatically populates the column fields. You can enter new columns and delete or edit the standard configuration to define which accounts to include in the columns of your report. In the **Name** field, enter a name for your account group.

10. Click the Edit icon next to the **Name** field to open the **Column** popup window.

11. In the **Transaction Subfilter** field, select what kind of transactions to include with this filter—Actual + Committed, Actual, or Committed.

   Actual transactions are completed transactions and have GL impact. Committed transactions are planned transactions and do not yet have GL impact.

12. In the **Type** field, select an account filter and, if applicable, define the filter in the popup window.

   - Account – include or exclude specific accounts from your report. In the **Condition** field, select **is** to include the selected accounts or **is not** to exclude the selected accounts. In the **Accounts** field, select the accounts for this column.
   - Account Types – include all accounts of a specific type (e.g. expense). In the **Account Types** field, select the account types you want included in this column.
   - Time Entry – include all project time entries.

   Click **Set** to return to Step 3. Click **Add** to save your defined column.

**Note:** Each defined column can have multiple account categories. You may add multiple column definitions to each configuration.

13. Repeat the previous step to add columns to your profitability report. When you are finished, click **Next**.

14. On the **Define Profitability Calculation** page, you select which columns are used to calculate your profitability margin. Select the custom columns to use for your costs and revenue. The information in these columns is used to calculate your profitability for each project.

15. Click **Next**.

16. On the **Reports** page, a list of custom reports to be added is populated. In the **Summary** field, you can update the default names of your custom summary project profitability reports. In the **Detail** field, you can update the default names of your custom detail project profitability reports.

17. In the **Action** field, you can choose **Create** or **Do Not Create** for each custom report.

18. You can click **Finish** if you want to stop your configuration without any additional settings or localizations. Click **Next** to set additional settings or add localizations.

19. On the **Settings** page, check the box next to any additional transactions you want included in your profitability calculations. Click **Finish** or **Next** to add localization information.

**Important:** If you use the Planned Work feature, checking the Planned Time box can result in duplicate calculation of your committed costs. For more information, see Planned Work.

20. On the **Localization** page, if you use multiple language, you can enter translations for your terms in your selected language.

21. When you are finished, click **Finish**.
In addition to creating new configurations, you can also edit and copy existing custom configurations.

Your project profitability reports are available at Reports > Projects > Project Profitability Reports. You can return to the Project Profitability Setup page directly from the standard or custom reports by clicking the Profitability Setup button at the bottom of the page.

**Note:** You can select which report configuration populates the P&L subtab of project records. Go to Setup > Accounting > Project Profitability. In the P&L Default field, select the configuration you want to use for the P&L subtab on projects. Click **Submit**.

Project profitability reports are calculated at set times during the day. When viewing a report, you can see the time and date of the last data calculation at the bottom of the page. To initiate a recalculation manually click the Recalculate button at the bottom of the page.

**To copy or edit an existing configuration:**

1. Go to Setup > Accounting > Project Profitability.
2. Click **Copy** or **Edit** next to the configuration you want to change.
3. If you are copying an existing configuration, in the **Name** field, enter a new name for your copied configuration.
   
   You can use the sidebar to skip to the page you want to change, or click **Next** to advance to the next page.
4. When you have finished making your changes, click **Reports** in the sidebar under Steps.
5. Under Existing, in the **Summary** and **Detail** fields, you can update the names of your existing reports.
6. In the **Action** field, select **Keep** or **Delete** for each report. In the **Links** column, you can click the links to view either the Summary or Detail report. In the **Impact** column, click **Display Changes** to see the difference your updates will make to your existing reports.
7. Under To Be Added, in the **Summary** and **Detail** fields, you can update the names of any new reports to be created.
8. In the **Action** field, select **Create** or **Do Not Create** for each new report.
9. When you have finished, click **Finish**.

Any updated or new custom reports can be found at Reports > Projects > Project Profitability Reports.

**Displaying Approved Time as Actual Costs**

When creating project profitability configurations, the **Treat Tracked & Approved Time as Actual Cost** preference enables you to select approved time as actual costs without posting time. You can also display tracked and approved time as actual costs on the P&L subtab. Displaying approved time as actual costs ensures the estimate at completion and estimate to complete calculations are more accurate.

**Include Forecast and Actual Charges**

When creating project profitability configurations, the **Charges** preference enables you to include forecast and actual charges in project profitability configurations. All forecast and actual charges appear as committed revenue. If you have already invoiced the actual charge, NetSuite ignores the charge. If you use a project charge on a sales order, the calculation of the remaining billable amount follows the charges and not the unbilled quantity on the sales order.
SuiteAnalytics Connect Access to Project Tasks Data

Data that can be accessed through an ODBC, JDBC, or ADO.NET driver can help meet your complex and specialized reporting needs for project tasks data. In order to access this data: you must have purchased SuiteAnalytics Connect, this feature must be enabled in your account, and you must download one of NetSuite’s ODBC, JDBC, or ADO.NET drivers. Then you can use external reporting tools such as Crystal Reports and Microsoft Excel to create project tasks reports.

The following enterprise views are available for project tasks data:

- **Project Tasks** – Fields tracking baseline and actual dates, work, and costs for project tasks.
- **Project Task Assignments** – Fields tracking estimated work, assigned resources, and resource costs and charge rates.
- **Project Task Dependencies** – Fields tracking timing relationships among tasks.

For information about setting up and using enterprise views, see the help topic SuiteAnalytics Connect.
Basic Projects

- Basic Projects Overview
- Creating a Basic Project Record
- Attach Contacts to Basic Projects

Basic Projects Overview

Use the Projects feature to track information about projects you are working on for customers, including time, contacts, and transactions.

On the project record, you can track time associated with the project. You can also create transaction associated with the project, as well as CRM information such as activities and communication.

To create a project record with Projects, go to Lists > Customers and click View next to the customer the project is for. When the customer record opens, click Project in the Create New menu. For detailed instructions, see Creating a Basic Project Record.

You can also import basic projects using CSV import. For more information, see the help topic Projects (Jobs) Import.

After you have entered project records, you can associate a project with a transaction by selecting the project in the Project field on the transaction form or by creating a new transaction directly from the project record from the Create New menu.

Note: Auto-generated numbering creates a single sequence for all projects.

If you use the basic Projects feature (Project Management and Advanced Project Tracking are not enabled), be aware of how the system determines the tax code to apply to an invoice for a project.

Prior to NetSuite Version 2015 Release 2, when a project is selected on an invoice, the tax code is determined by the following:

- The tax schedule on the item
- The shipping address of the project or customer, depending on which is available first in the hierarchy

As of NetSuite Version 2015 Release 2:

- If the customer to which the project belongs has a default tax code on its record, the system uses that tax code for the invoice.
- If the customer to which the project belongs does not have a default tax code on its record, the tax code is determined by the tax schedule on the item and on the shipping address of the project or customer.

Note: The NetSuite tax lookup based on shipping address varies depending on the country.

Creating a Basic Project Record

Create project records to track projects for your customers.
To create a basic project record:

1. Go to Lists > Relationships > Customers and click View next to the customer this project pertains to.
2. Click the Create New icon, select Project.
3. Under Primary Information:
   a. In the Custom Form field, select the form you want to use to enter this record. Select Standard Project Form, a custom form you have already created, or click Customize to create a custom project form.
   b. The Project ID field displays either the ID that has been entered in the Project Name field or an auto-generated ID.
      - Clear the Auto box next to Project ID to manually enter a name for this record in the Project ID field.
      - If you leave this box checked, NetSuite assigns a name or number for this record based on your settings at Setup > Company > Auto-Generated Numbers.
   c. In the Project Name field, enter the name of the project. This name fills in the Project ID field unless you use auto-numbering. Enter a unique project name. If you use Auto-Generated Numbering, it is important that you enter the project name here because the Project ID does not include the project name.
   d. The Customer field shows the associated customer.

   Note: After a project record is created, you cannot change the customer associated with that project record.

   e. In the Status field, select a status that indicates the progress of this project. You can create new project statuses at Setup > Accounting > Accounting Lists > New. Select Project Status.
4. Under Project Dates, in the Start Date field, enter the estimated date work will start on the project. If you have a contract for this project, this is the start date of the contract. You can change this date at any time during the life of the project.
5. Under Email | Phone | Address, enter the email address, phone and fax numbers for this project. The Address field shows the default billing address from the Address subtab.
6. On the Financial subtab:
   a. If you use the Multiple Currencies feature, select the currency for this customer.
   b. If you use the Revenue Recognition feature, select a revenue recognition forecast template. The template is used only to forecast the expected revenue to be recognized for the project according to the schedule.
7. On the Relationships subtab, under Contacts, associate contacts with this project.
8. Click the Communication subtab to enter phone calls, CRM tasks, events, attach files, and create user notes for this record. For more information, see Communication.
9. On the Address subtab, enter the billing and shipping addresses for this project.
10. When you have entered information on these subtabs, click Save. After the project is saved, additional subtabs are available.

   Note: You can add any custom fields by creating a custom form. For more information, see the help topic Creating Custom Entry and Transaction Forms.

After a project has been saved, you can enter any time for this project on the Resources subtab by clicking New Time or New Weekly Time.
Additional Basic Project Fields

You can customize the standard basic project entry form to include several additional fields on your project record. The fields listed below are organized by the default section they would appear in when customizing a project record entry form.

For information on how to customize forms, read the help topic Creating Custom Entry and Transaction Forms.

Primary Information

- **Project Type** – Project types are user-defined values to classify projects in a way meaningful to your company. You can define project types at Setup > Accounting > Accounting Lists > New > Project Type.
- **Category** – Select a customer category for the project. You can define customer categories at Setup > Accounting > Accounting Lists > New > Customer Category.
- **Comments** – Add additional information about the project.
- **Image** – Add an image for the project. You can select an image from the File Cabinet or upload a new image.

Project Dates

- **Projected End Date** – Enter the projected date all tasks will be complete for this project. You can update this date at anytime.

  **Note:** This field is never calculated for you.

- **Actual End Date** field, enter the date the project is actually finished.

Financial

- **Account** – If you assign account numbers to projects, you can enter it here.
- **Percent Complete** – You can enter an estimate of how much of the total project work is complete. This percentage is not calculated or updated by NetSuite.
- **Estimated Cost** – Enter the projected cost to complete the project.
- **Estimated Revenue** – Enter the projected revenue to be billed for work performed on this project.

Attach Contacts to Basic Projects

When you create a basic project record, the contacts on the customer are not copied to the new project record.

**To attach a contact to a saved project record:**

1. Go to Lists > Relationships > Customers.
2. Click **Edit** next to the project you want to attach contacts to.
3. Click the **Relationships** subtab.
4. In the **Contact** field, select a contact.

   You can also click **New Contact** to create a new contact record.
5. In the **Role** field, select what responsibility this contact has in relation to this project.
6. Click **Attach**.
7. When you have finished adding contacts, click **Save**.
Integrating NetSuite Project Data with OpenAir

Using OpenAir project management functionality with NetSuite enables you to leverage the project management, billing, and enterprise reporting capabilities of both applications on an integrated, server-to-server platform. With OpenAir/NetSuite Integration, you can allocate resources, create detailed work breakdown structures, track performance metrics, process expense reports, bill clients, and record project related financial information in your general ledger.

If you use OneWorld, you can integrate project data for multiple subsidiaries.

For detailed information on setting up both NetSuite and OpenAir to integrate successfully, contact NetSuite Professional Services and refer to the OpenAir NetSuite Connector Guide.